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Warranty Information

Thank you for purchasing the GCMS-QP2010.
Shimadzu provides the following warranty for this instrument.

1. Period One year from the date of first use (limited to domestic use) or 6 months after repair 
or overhaul of the rotary pump or turbo molecular pump.

2. Terms The manufacturer will provide free replacement parts for, or repair free of charge, any 
instrument that fails during the warranty period, if the cause can be attributed to a 
defect in manufacturing.

3. Items Not Covered by the Warranty
The warranty does not cover malfunctions that result from:

a) misuse;
b) repairs or modifications made by any company other than an authorized 

Shimadzu representative;
c) external factors;
d) operation under severe conditions, such as: environments with high temperature, 

high humidity, corrosive gas, vibration, etc.;
e) fire, earthquake or other forces of nature;
f) moving or transporting the instrument after its initial installation.
g) The warranty does not cover replacement of consumable items or parts that can 

be regarded as consumable.

© 2001-2008 Shimadzu Corporation.

   Note

Floppy disks, CD-ROMs and other recording media are considered consumable 
parts.

Preface
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Replacement Parts Availability

Replacement parts for this instrument will be available for a period of seven (7) years after the 
discontinuation of the product. Thereafter, such parts may cease to be available.
Please note that Shimadzu does not manufacture some parts of the instrument. For such parts, we will 
estimate the volume of part use within the aforementioned period after receiving notification of product 
discontinuation, and we will stock the part. However, due to incorrect estimates or circumstances under the 
control of the parts manufacturer, parts not manufactured by Shimadzu may not be available during the 
7-year period after discontinuation of the product.
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Precautions for Safe Operation

The gas chromatograph mass spectrometer is an analytical instrument used for qualitative and quantitative 
analyses.

Please note the following points to facilitate safe operation of this instrument.

1. Use this instrument only for the specified types of analyses.

2. Follow the procedures as written in this manual.

3. Observe all warnings and precautions.

4. Do not disassemble or modify the instrument without the express approval of an authorized Shimadzu 
representative.

5. For service or repair, contact your Shimadzu representative.

   Note

Warnings, precautions and other items of interest are indicated by the following conventions:

  Warning
Indicates a potentially hazardous situation which, if not avoided, could 
result in serious injury or possibly death.

  Caution
Indicates a potentially hazardous situation which, if not avoided, may 
result in minor to moderate injury or equipment damage.

  Note
Emphasizes additional information that is provided to ensure the proper 
use of this product.
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   Note
In this manual and on the instrument, the following 
symbols are used as indicated below.

Indicates danger from high voltage.

Indicates danger from high temperature components.

Refer to the user manual for details about handling or 
operation.

   Warning

Internal repair of the instrument is dangerous. Contact specially trained 
Shimadzu representatives for service or repair. 

   Warning

Do not disassemble or modify the instrument without authorization, as this 
will compromise safety.

   Warning

Read this user manual to learn how to safely maintain and operate the 
instrument, and follow all procedures as described. Operating the instrument 
other than as described is potentially hazardous. 
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Installation Site Precautions

   Warning

The solvents used with the gas chromatograph mass spectrometer are 
flammable and toxic. Install the instrument in a well-ventilated room. 
Otherwise, solvent vapors could cause poisoning, or ignite and cause a fire.
Do not use this instrument in an area that contains combustible gases, as the 
instrument may ignite them and cause a fire.

   Warning

Do not place flammable materials near the column oven exhaust at the back 
of the instrument, as they could ignite and cause a fire.

   Warning

The lab table or other surface on which this instrument is installed should be 
level, stable, and sufficiently strong to support the instrument's weight. 
Otherwise, the unit could tip over or fall off the surface.

   Warning

Avoid installing the instrument where there is corrosive gas or excessive 
dust. The instrument performance could be affected and its service life 
shortened.
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Installation Precautions

Power Supply
Power Requirements

For 100 V - 115 V Type
AC Single Phase, Frequency 50 - 60 Hz

For 220 V - 240 V Type
AC Single Phase, Frequency 50 - 60 Hz

   Warning

A Shimadzu engineer must perform instrument installation and configuration. 
To prevent potential injuries, contact a Shimadzu representative if the 
instrument must be moved after installation.

GC: 1800 VA
MS: 1000 VA
PC (including CRT): See PC manual.
Printer: See printer manual.

GC: 2600 VA
MS: 1000 VA
PC (including CRT): See PC manual.
Printer: See printer manual.

   Warning

Use a power supply with a circuit breaker that is dedicated to this instrument. 
Avoid sharing a power supply with other instruments. Do not use power cords 
other than those supplied with the instrument, as this may cause fire or 
electric shock.
• Please note that additional options will increase the required current 

capacity.
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Ambient Environment
Temperature: 18 - 28 °C and should be held constant (Specification warranty range); 15 - 35 °C 
(Running warranty range)
Humidity: 40 - 70 % (avoid condensation)

   Warning

Ground the instrument. Grounding is necessary to prevent electric shock in 
the event of an accident or electrical short. Ground should be 100 Ω or less.

   Warning

Do not place heavy objects on the power cable, and avoid placing hot items 
near the cable. Do not excessively bend or pull on the power cable. It could 
be damaged, resulting in fire or electric shock. If the cable becomes 
damaged, contact your Shimadzu representative.

   Note

Choose an installation site with minimal detrimental factors such as dust, 
vibration, ambient noise, corrosive gas, and magnetic fields. To maintain 
good performance, note the following directions.
1. Minimize temperature fluctuation during use.
2. Avoid exposure to hot or cold air.
3. Avoid exposure to direct sunlight.

Although this instrument can operate within the running warranty range, 
extensive operation beyond the specification warranty range may result in 
problems such as shortening the service life of the instrument.



viii GCMS-QP2010

Gases
Carrier gas: Helium
Supply pressure: 300 - 980 kPa
Purity: 99.995 % or greater
• The pressure and flow rate setting range on the GC varies according to the supply pressure. Normally a 

supply pressure of 700 - 800 kPa is necessary.
• Some optional accessories may require a gas other than the one specified above. Consult the user 

manual accompanying the accessory for more information.
• Some applications, such as agrochemical analysis, may require helium of a higher purity 

(99.999 - 99.9999 %).

   Note

Helium of at least the purity indicated above must be supplied as the 
carrier gas through the supplied tubing. If a carrier gas of lesser purity is 
used, performance may be compromised. Refer to Section 2.3 "Gas 
Requirements", page 13 for more information.
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High-Pressure Gas Precautions

   Warning

A high-pressure gas cylinder will be used to supply the carrier gas. When 
handling the gas cylinders, observe the following suggestions.
1. Keep gas cylinders in a well-ventilated area outside of the instrument 

installation site. Avoid exposure to direct sunlight. Use lines to 
transport the gas from the cylinders to the instrument. For flammable 
gases, this precaution is required by law.

2. Ensure that gas cylinder temperature never exceeds 40 °C. No open 
flame permitted within 2 m of the cylinder.

3. Choose an instrument installation site with sufficient ventilation, and 
include checking for gas leaks with leak detection solution in your 
daily inspection procedure. Do not smoke or use open flames within 
5 m of the instrument when using highly combustible gases, such as 
acetylene and hydrogen, or potentially combustible gases, such as 
oxygen and nitrous oxide. Install and maintain effective fire 
extinguishers.

4. Secure cylinders with clamps or by some other method to prevent 
them from falling over.

5. When finished using the gas, immediately close the main cylinder 
valve.

6. Verify that the pressure gauges are functional at least once every 
three months.

7. Warning signs (adhesive aluminum plates) are available to indicate 
hydrogen gas use. Ask your Shimadzu representative for more 
details. Signs are supplied free of charge to sites in which they are 
mandatory.

Legal authorization is required to use cylinders with a capacity of 300 m3 or 
greater.

Please refer to high-pressure gas control laws, liquid petroleum gas safety 
regulations, general high-pressure gas safety regulations, and fire safety 
laws for more information.
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For Safety Use of Hydrogen Carrier Gas

   Warning

Hydrogen gas, which is used as the carrier gas in gas chromatographs, is a 
dangerous gas that explodes easily. Read safety precautions in "GCMS-
QP2010 Series Hydrogen Carrier Gas Safety" thoroughly before using the 
GCMS-QP2010, and use the product correctly. Be sure to observe the 
precautions described there. They are important for ensuring safety. Cautions 
related to hydrogen gas are also listed in the gas chromatograph user 
manual. Please read these as well.

Hydrogen Gas Properties
Hydrogen is a dangerous gas which can easily explode if handled improperly. 
When hydrogen is to be used as the carrier gas, be sure to understand the 
characteristics and proper handling of this gas.
• Colorless, odorless gas
• Wide combustion range, combustible within range of 4 vol% to 75 vol% 

when mixed with air.
• Ignites with extremely low energy.
• Easily accumulates near the ceiling, as it is lighter than air.
• Quickly mixes with air due to its high diffusion rate.
• Automatically ignites when rapidly expanding.
• The hydrogen flame is invisible, and easily carried by the wind.
• When mixed with a halogen gas such as chlorine, it explodes on direct 

exposure to sunlight.
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Operation Precautions

   Warning

Always wear safety glasses or goggles when handling solvents. If solvent 
gets into the eyes, blindness could result. Should solvent get into the eyes, 
immediately flush with large amounts of water and seek medical attention.

   Warning

Safety glasses should be worn during sample injection to prevent the 
dangers associated with mechanical injury from the syringe or solvents 
splashing into the eyes. The injection port is typically under a pressure of a 
few hundred kPa to enable carrier gas to flow into the column. As a result, 
when a liquid sample is injected with a syringe, the plunger may be 
discharged from the syringe barrel, or the flow may be reversed and the 
sample ejected. Furthermore, when a large sample volumes are injected, the 
septum deteriorates more quickly and the sample may be ejected from the 
injection port.

   Warning

Do not place solvents near PCs, printers or other instruments, as fire or 
instrument damage could result.

   Warning

Do not use flammable sprays (hair sprays, insecticide sprays, etc.) near this 
instrument, as they could ignite and cause a fire.

   Warning

To prevent injuries and instrument damage, do not disassemble or modify this 
instrument, or perform internal repairs. 

   Warning

If the power cable becomes dusty, remove the plug from the outlet and wipe 
away the dust with a dry cloth. Fire may result if dust is allowed to 
accumulate.
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   Note

To clean the surface of the instrument, use a soft cloth and water or 
neutral detergent. Wipe dry with a clean cloth.

   Note

Periodic maintenance of the rotary pump and turbo molecular pump are 
recommended. Refer to respective manual for the interval.

Precautions for Inspection, Maintenance, Adjustment, and Care of the InstrumentPrecautions for Inspection, Maintenance, Adjustment, and Care of the Instrument
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Warning Labels

   Caution

DO NOT BLOCK VENTS
Do not place anything on top of the instrument which might block vent holes 
and cause overheating.

   Warning

DO NOT TOUCH
High Temperature injection ports, detectors and upper cover.

   Warning

DO NOT TOUCH
The rear panel may be hot and can cause burn.

Warning 
Label

Warning Label
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   Warning

PRECAUTIONS IN USING HYDROGEN GAS
Shut off hydrogen and cap unused column fittings to prevent accumulation of 
hydrogen in oven and possible explosion.

   Warning

PRECAUTIONS IN USING HYDROGEN GAS
If hydrogen gas accumulates inside the vacuum chamber, it could potentially 
ignite.
When hydrogen carrier gas is used, keep the knob on the front door 
completely loosened except when starting up the vacuum pump.

Warning 
Label

Warning Label
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   Warning

HOT AIR EXHAUST
Keep temperature sensitive materials away from opening.

   Warning

HIGH VOLTAGE
Disconnect power cable before removing cover. Refer servicing to qualified 
service personnel.

Warning 
Label

Warning 
Label
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   Warning

WARNINGS IN USING HYDROGEN GAS
When hydrogen gas is in use, care should be exercised in order to prevent 
accident.
1. Connect gas lines correctly. Do not connect the hydrogen line to the 

air inlet, or hydrogen will leak excessively.
2. When the device is not in use, the main valve of the hydrogen gas 

cylinder must be closed. Also make sure there is no gas leakage 
from the main valve of the supply.

3. The flow line for hydrogen gas should be checked leakage whenever 
it is used.

4. To prevent buildup of explosive concentration in case the hydrogen 
gas leaks, the room in which the device is used should be ventilated.

5. When analyses are completed, close the main valve of the hydrogen 
gas container immediately before performing other procedures.

   Caution

CAUTION IN GAS PLUMBING
The pressure regulators will be damaged when subjected to pressure beyond 
their specification.
Do not exceed maximum source pressure of 800 kPa or the maximum 
specified pressure given in the instruction manual.

Warning 
Label
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   Warning

HIGH VOLTAGE
Do not open the cover. Danger! High voltage may cause electric shock.

Warning Label



Handling Emergencies

xviii GCMS-QP2010

Handling Emergencies

The following measures should be taken in the event of an emergency such as a malfunction of the gas 
chromatograph mass spectrometer.
Take adequate precautions and contact your Shimadzu representative as necessary before resuming use of 
the instrument.
In the event of an emergency...
1. Turn off the gas chromatograph and mass spectrometer.
2. Turn off all accessories.
3. Close the valves in all carrier gas and air lines.
4. Turn off the power supply.

• If the power cable is attached to a power board, turn off the power board.
• If the power cable is plugged into an outlet, unplug the cable.
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Measures during Power Outage

For power outages of 10 minutes or less, normally no particular procedure is required as long as the 
"Vacuum Restart Mode" checkbox is selected in the "Vacuum Control" window. The instrument will 
automatically restart when the power comes back on.

For long-time power outages, perform the following procedure.

For power outages while using hydrogen carrier gas, perform the following procedure.

Shutdown Operation for Long-Time Power Outages
1. Turn off the gas chromatograph and mass spectrometer.
2. Turn off all accessories.
3. Close the valves in all carrier gas and air lines.
4. Loosen the nut fastening the column on the interface to release the vacuum of the vacuum system.
5. Turn off the power supply.

• If the power cable is attached to a power board, turn off the power board.
• If the power cable is plugged into an outlet, unplug the cable.

Power Outage Operation While Using Hydrogen Carrier Gas
1. Immediately stop the supply of hydrogen gas.
2. Switch OFF power to the GC and the MS.
3. Open the windows and doors of the room where the instrument is installed to thoroughly ventilate.
4. Confirm that there is no ignition source in the room that could ignite the hydrogen gas.
5. Wait until the temperature of all GCMS-QP2010 components has fallen to the ambient temperature 

(approximately 1 hour).
6. Open the front door of the GC and loosen the nut of the interface to return the interior of the MS to 

atmospheric pressure.
7. Confirm that the knob on the front door of the MS is completely loose.
8. Wait until all hydrogen gas is completely expelled (approximately 30 minutes).
9. After confirming the items in "Precautions in Installation" and "Precautions in Operation and 

Running of the Instrument", use the standard startup procedure to start the GC and MS.



Action for Environment (WEEE)

xx GCMS-QP2010

Action for Environment (WEEE)

To all users of Shimadzu equipment in the European Union:
Equipment marked with this symbol indicates that it was sold on or after 13th August 
2005, which means it should not be disposed of with general household waste. Note that 
our equipment is for industrial/professional use only.
Contact Shimadzu service representative when the equipment has reached the end 
of its life. They will advise you regarding the equipment take-back.

With your co-operation we are aiming to reduce contamination from waste electronic and electrical 
equipment and preserve natural resource through and recycling.
Do not hesitate to ask Shimadzu service representative, if you require further information.

To all users of Shimadzu equipment in the European Union:
This equipment can only be connected to a supply with the impedance 0.1 ohm or lower. If necessary, 
determine the impedance in consultation with the supply authority.

  Note

If the actual system impedance Zact exceeds 0.1 ohm at the point of interface point on the user's 
premises, the supply authority may impose restrictions to connection on the use of the equipment.

 Note

If the actual system impedance Zact has been declared to, or measured by the user, the user can use 
the information to assess the equipment's suitability without reference to the supply authority.

WEEE Mark

Voltage FluctuationVoltage Fluctuation



Introduction

xxiGCMS-QP2010

Introduction

Thank you for purchasing a GCMS-QP2010 instrument. Read this user manual carefully before using the 
instrument for optimal performance and to make full use of its capabilities.

This manual assumes that the user has a working knowledge of Windows. There are numerous references 
to functions and terminology specific to Windows; refer to a Windows user manual as necessary. Users who 
have never worked with Windows should read a Windows user manual before using this document.

Using this Manual
Read and understand this manual before operation. Keep this manual in a readily accessible location.
Window and dialog box names are italicized.
Menu names and commands, as well as Assistant Bar icon names are shown in bold.
A menu sequence is represented by the menu name (or item name) followed by a ">" followed by the item 
name (or sub-menu name) as in the following examples:

Main Menu Item > Sub-Menu Item > Selected Menu Item
Start > Settings > Control Panel
File > Print

When a menu sequence leads to a tabbed dialog box, the tab to select is shown in the same manner:
Method > Set Parameters > General tab

PDF versions of this guide and the operation guide, etc. should have been placed in the folder 
"GCMSsolution\Manual" on your computer.  Please refer to them as necessary.
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1  Overview

1.1 GCMS-QP2010

This section presents an overview of the GCMS-QP2010.
The GCMS-QP2010 instrument is a bench-top type gas chromatograph/mass spectrometer 
intended for high-precision GC/MS analysis. The instrument enables mass spectrum 
measurement for qualitative analysis or identification of unknowns and Selected Ion 
Monitoring (SIM) measurement for quantitation of trace constituents.

Figure 1.1  GCMS-QP2010

The standard model includes the following components:
• GC-2010 high-performance gas chromatograph
• Vacuum differential pumping* by the turbo molecular pump with the rotary backing pump
• Vacuum gauge for chamber pressure monitoring*
• Direct-coupled GC/MS interface
• Electron Impact (EI) ion source with independent temperature control
• Electron energy/current variable dual filament ion source
• Quadrupole mass filter with pre-rods
• Electron multiplier detector with conversion dynode
• Power source and instrument control circuit

* For Single TMP models, the vacuum differential pumping becomes a single 
pumping, and the ion gauge is not included.

GCMSsolution Ver. 2 software is used to control the GCMS-QP2010 and perform data 
acquisition and post run analysis. The software includes the following functions:
• Control of GCMS-QP2010 and peripherals such as the autosampler, and automatic 

adjustment of the instrument by autotuning
• QA/QC functions support data precision and quality management.
• Creation of analysis methods
• Scan and SIM data acquisition
• Qualitative processing which includes the display and processing of mass spectrum as 

well as library searches
• Quantitative processing which includes the creation of compound tables, calibration 

curves and concentration calculations
• Customizable reports
• Sequential data acquisition/analysis by batch processing

MS
GC
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1.2 Features

This section describes the functions and performance features of the GCMS-QP2010.

High Sensitivity
Quadrupole ion focusing GC/MS systems provide the highest sensitivity in their class, 
significantly broadening the range of applications for GC/MS. 

High Mass Range
The instrument achieves a high mass range analysis up to m/z 1024 (for Single TMP 
models, the analysis can be performed up to m/z 900), significantly broadening the range of 
applications for GC/MS.

Compact
The GCMS-QP2010 requires minimal space, even with the optional autosampler installed.

Intuitive Operation
Because the GCMSsolution software is intuitive, novices to GC/MS can acquire and 
analyze data, as well as generate reports in the familiar Windows environment. QA/QC 
functions provide instrument status and data precision management.

Multi-Compound Analysis
The high sensitivity of the GCMS-QP2010 enables SIM measurements for more 
compounds. Ions can be monitored simultaneously on a maximum of 64 channels. High 
sensitivity analysis can be performed on a larger number of compounds because time-
division settings may be assigned for up to 128 groups, each with up to 64 channels.
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1.3 Component Names

This instrument is composed of a gas chromatograph (GC), mass spectrometer (MS), rotary 
pump, personal computer system (PC) including monitor and printer, and other options. For 
the GC-2010 gas chromatography, refer to the separate GC-2010 user manual.

1.3.1 GC/MS Analytical System

Figure 1.2  GCMS-QP2010 (Front View)

Figure 1.3  GCMS-QP2010 (Rear View)
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(Dual TMP model)

(Single TMP model)

Figure 1.4  Mass Spectrometer
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1.3.2 GCMS-QP2010 Ion Source

Figure 1.5  Ion Source

Filament

Interface

FilamentIon Box
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1.3.3 Rotary Pump

Figure 1.6  Rotary Pump

Vacuum Port
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Exhaust Port

Oil Gauge

Drain Plug

Motor
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1.4 Standard Accessories

This section describes the standard accessories that accompany the instrument. Refer to 
the GC-2010 user manual for the accessories included with the GC-2010 gas 
chromatograph.

* This part is not included with the Single TMP model.

In the case of a Single TMP model, the following parts are also attached.

Part Name Part Number Qty
Nut, SSNE16 / 012 (5 pcs) 670-11009 1

Ferrule, GVF-004 (10 pcs) 670-15003-03 1

Ferrule, GVF-005 (10 pcs)* 670-15003-04 1

Tweezers, AA 086-16101 1

Screwdriver, Phillips #2 086-11002 1

Ion source attachment jig 225-10194-91 1

Septum (10 pcs) 221-35507-01 1

Wrench (5/16 -1/4) 086-03410 1

Wrench, Hex 3 086-03804 1

Wrench, Hex 5 086-03806 1

Screwdriver, Minus 100 086-10403 1

Screwdriver, #4 086-12011 1

Column mounting jig (to interface) 225-11657-08 1

Column mounting jig (to injector) 225-11657-09 1

Parallel pin 026-11007-02 1

Cable, IEEE1394 225-19050 1

Cable, RS232C 225-19051 1

Gasket 221-48990 1

Case 670-12546 1

Interface cover 225-11674 1

Vinyl tube 016-31331 1

Hose clamp 037-61019 2

Part Name Part Number Qty
G-type blank nut (2 pcs) 221-35566-92 1

O-ring, 4D P5, 5/PKT, for glass insert 
attachment

036-11203-84 1

Gasket, AI, column packing (100 pcs) 201-35183 1

Deactivated silica wool, 2 g 221-48600 1

Glass insert, SPL 221-41444-01 1

Glass insert, SLESS 221-48335-01 1

Wrench for glass insert nut 221-46977 1

Injection port cover 221-43597 1

Spanner 10 × 12 086-03011 2

Spanner 6 × 8 086-03003 1
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1.5 Software Overview

This section presents an overview of GCMSsolution.

GCMSsolution is Windows software that is used to controls the GCMS-QP2010, 
autosampler and all other peripheral units. It provides data acquisition, qualitative analyses, 
quantitative analyses and report creation.

Figure 1.7  Software Functions

The program uses commands that are common to the Windows 2000 and Windows NT 4.0 
operating systems. Prior to use, carefully read the user manual of the appropriate operating 
system. This manual should be read after gaining a basic understanding of Windows 
operations, such as opening and saving files.

Sample

Qualitative 
Analysis

Report

Quantitative 
Analysis
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1.6 Software Operation Flow Chart

This flow chart presents the basic order of GCMSsolution operations. The chapters in which 
the respective procedures are described are listed where appropriate.

Figure 1.8  Software Operation Flow Chart (Part 1)
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Figure 1.9  Software Operation Flowchart (Part 2)
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2  Basic Operation

2.1 Introduction

This section describes the following basic operational procedures of GCMSsolution:
• GC Basics
• Gas Requirements
• Instrument Startup and Shutdown
• Daily Startup and Shutdown
• Column Replacement
• System Configuration
• System Check and Tuning
• Common Operations

An understanding of these topics is crucial for operating the GCMS-QP2010 instrument and 
GCMSsolution software.
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2.2 GC Basics

For specific information about the GC-2010 gas chromatograph, consult its accompanying 
user manual (P/N 221-40406). Note that the standard procedures for operating the GC-
2010 may differ from those described below.

2.2.1 Instrument Parameters

The GCMS-QP2010 instrument parameters, including GC temperature and pressure 
parameters, may be set from the PC. The parameters are saved in a file referred to as the 
"method file." Method files may be stored on the hard drive and the saved parameters 
loaded into the software. For more information about method files, refer to Section 2.9.1 
"Managing Files", page 60.

GC-2010 parameters may be set directly from the keypad or from a method file on the PC.

2.2.2 Injection Port Description

With a GC/MS system, air must be prevented from leaking into the carrier gas.
Ensuring carrier gas purity will:

1. Prevent capillary column deterioration.

2. Prolong the life of the MS filament and ion source.

3. Minimize the background noise in the analyzer.

To prevent air from leaking into the carrier gas, the GCMS-QP2010 seals the standard 
injection port with a gold (Au) gasket, as shown in the diagram below.

Figure 2.1  Injection Port

Septum Retaining Nut

Septum
Spacer

Needle Guide

O-ring

Capillary 
Adapter
(INJ side)

Gold (Au) Gasket

Ferrule

Capillary Nut
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2.3 Gas Requirements

This section describes the carrier gas used by this system. The specifications presented 
below must be followed to promote safety and maintain instrument performance.

Carrier gas: Helium

Supply Pressure: 300 - 980 kPa

Purity: 99.995 % or greater

• The pressure and flow rate setting range on the GC varies according to the supply 
pressure. Normally a supply pressure of 700 - 800 kPa is necessary.

• Some optional accessories may require a gas other than the one specified above. 
Consult the user manual accompanying the accessory for more information.

• Some applications, such as agrochemical analysis, may require helium of a higher 
purity (99.999 - 99.9999 %).

   Note

Any air leakage into the gas supply lines will degrade the purity of the gas and may 
affect system performance. The helium supplied to the GC must meet or exceed 
the given purity specification. Using a gas of lesser purity may deteriorate system 
performance.
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2.4 Instrument Startup and Shutdown

This section explains how to start up and shut down an installed instrument.

2.4.1 Starting the Instrument

1. Turn on the carrier gas.
(1) After verifying that the carrier gas is helium with a purity of at least 99.995 %, make 

sure that the carrier gas lines are connected as shown in the diagram below.
(2) Open the main valve of the carrier gas cylinder.
(3) Ensure that the supply pressure, or the pressure at GC carrier gas inlet, is 

300 - 980 kPa (about 3 - 9.8 kgf/cm2).

Figure 2.2  Carrier Gas Inlet

   Note

When changing gas cylinders, make sure that there are no leaks from the 
connection at the gas cylinder.

Carrier 
Gas Port
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2. Inspect the injection port glass insert using the following procedure to determine 
whether the glass insert is appropriate for the application.

(1) Hold the septum nut and remove the glass insert nut of the injection port. Lift the 
septum nut straight up and remove it.

Figure 2.3  Injection Port Nut Assembly

   Caution

It is important to hold the septum nut while removing the glass insert nut. If you remove 
the glass insert nut without holding the septum nut, it is pulled by the tube. The septum 
nut will hit the glass insert and break it.

Septum Nut

Glass Insert Nut

Injection Port
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(2) Remove the glass insert with forceps, and verify that it is appropriate for the 
application. Refer to the figure below. Check the silica wool to make sure that it is 
clean and positioned properly.

Figure 2.4  Packing Glass Inserts

(3) If the silica wool is contaminated, remove the wool, and clean or replace it. Pack an 
appropriate amount of clean silica wool at the specified location. For split injection 
this is about 10 mg and for splitless about 2 mg.

25 mm

Glass Wool

Split

5 mm

Splitless
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(4) Install the glass insert and graphite ferrule as described below. Refer to the figure of 
the upper injection port assembly as necessary.
a) Temporarily slide the O-ring onto the glass insert so that it is about 4 mm from the 

top, as shown in the diagram below. Guide the glass insert into the injection port 
until it touches the bottom. The O-ring will be about 3 mm from the top of the 
insert when properly positioned.

b) Position the injection port nut assembly on top of the glass insert.
c) Securely tighten the nut with the provided hex wrench.

Figure 2.5  Placing the O-ring

O-ring

4 mm

SplitlessSplit
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3. Install the column holder and capillary column.
Attaching the Column Hanger
Attach the column hanger to the connecting holes as follows:
(1) Squeeze the tabs at the top of the hanger so the ends of the hanger can be inserted 

into the connecting holes. The standard column mounting position is on the back side 
of the hanger. When connecting two columns, mount one in front and the other in 
back.

Figure 2.6  Connecting the Column to the Column Hanger

Connecting the Capillary Column to the Injection Port
(1) Push the capillary column through the Vespel ferrule and nut. Refer to Figure 2.7 

"Using the Column Fitting Jig".
(2) Insert the end of the capillary column into the column fitting jig (P/N 225-11657-09), 

so that the capillary column protrudes about 1 cm from the end of the jig as indicated 
in Figure 2.7 "Using the Column Fitting Jig" Secure it by tightening the nut. Cut the 
protruding end of capillary column.

Column Hanger
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(3) Mark the capillary column beneath the tightened nut with tape as shown in Figure 2.8 
"Marking the Column with Tape".

(4) Remove the capillary column from the jig without moving the tape, and wipe the 
capillary column with acetone. Insert the column into the injection port and secure it 
by hand tightening the nut. If the ferrule is new, use the wrench to turn the nut an 
additional full turn. If the ferrule has been previously used, use the wrench to tighten 
the nut by turning it 20 to 40 degrees.

(5) Remove the tape used to mark the column.

Figure 2.7  Using the Column Fitting Jig

Part Name Part Number

Vespel ferrule 670-15003-03 (for 0.25 mm column)

670-15003-04 (for 0.32 mm column)

670-15003-07 (for 0.53 mm column)

Column mounting jig 225-11657-09

Nut 670-11009

Capillary column cutter 221-50595-91 (option)

(21 mm for 0.53 mm 
column)

Cut Column 
Flush With 
End of Jig

Column 
Mounting Jig 
(for INJ)

Ferrule

Nut

Capillary Column

40 mm
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Figure 2.8  Marking the Column with Tape

Connecting the capillary column to the MS 
(1) Push the capillary column through the Vespel ferrule and nut. Refer to Figure 2.9 

"Using the Column Mounting Jig". 
(2) Insert the end of the capillary column into the column fitting jig (P/N 225-11657-08), 

so that the capillary column protrudes about 1 cm from the end of the jig as indicated 
in Figure 2.10 "Connecting the Capillary Column to the MS". Secure it by tightening 
the nut. Cut the protruding end of capillary column.

(3) Mark the capillary column beneath the tightened nut with tape as shown in Figure 2.8 
"Marking the Column with Tape".

(4) Remove the capillary column from the jig without moving the tape, and wipe the 
capillary column with acetone. Insert the column into the MS interface and secure it 
by hand tightening the nut. If the ferrule is new, use the wrench to turn the nut an 
additional full turn. If the ferrule has been previously used, use the wrench to tighten 
the nut by turning it 20 to 40 degrees.

(5) Remove the tape used to mark the column.

   Note

A graphite ferrule is crimped by the jig, so that it is attached to the column, whereas 
a Vespel ferrule is not crimped and will slide on the column. To ensure proper 
positioning of the column, mark the column beneath the Vespel ferrule and nut with 
tape. Ensure that the tape is removed after installation.

Jig

Nut

Tape

Column
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Figure 2.9  Using the Column Mounting Jig

Figure 2.10   Connecting the Capillary Column to the MS

Nut

Column Mounting Jig

Vespel Ferrule

Capillary Column
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Figure 2.11  Marking the Column with Tape

4. Turn on the instrument.
(1) Ensure that breaker controlling the instrument power supply is on, and turn on the 

GC.
(2) Turn on the computer, monitor and printer, and start Windows.
(3) Turn on the MS. The power LED in the upper left corner of the MS will illuminate.

Figure 2.12  Starting the MS

   Note

To prevent background noise, always use a Vespel ferrule to connect the column to 
the MS. A graphite ferrule is crimped by the jig, so that it is attached to the column, 
whereas the Vespel ferrule is not crimped and will slide on the column. To ensure 
proper positioning of the column, mark the column beneath the Vespel ferrule and 
nut with tape. Ensure that the tape is removed after installation.

Jig

Nut

Tape

Column

Power LED
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5. Start GCMSsolution.
(1) Double-click the GCMS Real Time Analysis icon. The "Login" dialog box 

is displayed. 

Figure 2.13   "Login" dialog box

(2) Enter your user name and password. The first time that the software is accessed, 
use the default user name "Admin" and leave the password blank.
After entering the necessary information, click the OK button.
The GCMSsolution software starts up, and the "GCMS Real Time Analysis" window 
is displayed.

Figure 2.14  "GCMS Real Time Analysis" Window

Title Bar Menu Bar Toolbar Instrument Monitor

Assistant Bar Output Window
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6. Start the vacuum system.

   Caution

If the instrument has been shut down for an extended period of time and the ambient 
temperature is low, the rotary pump oil may become very viscous. When the oil viscosity 
is too high and the rotary pump is operated, an excessive load is placed on the rotary 
pump motor. The breaker for the main power supply (on back of the instrument, see 
Section 1.3.1 "GC/MS Analytical System", page 3) may trip, shutting down the 
instrument. 

When the instrument has been turned off and maintained in a cold environment, 
increase the ambient temperature and start up the instrument after the rotary pump 
temperature is at least as high as the minimum temperature specification (18 °C).

   Caution

Verify that the knob on the MS front panel door is tight before starting the vacuum 
system.

   Caution

Do not tighten the knob on the MS front panel door after starting the vacuum system. 
Otherwise, it may be impossible to loosen the knob after the instrument is shut down.
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(1) Click the Vacuum Control icon in the Assistant Bar. The "Vacuum Control" 
dialog box is displayed.

Figure 2.15  "Vacuum Control" Dialog Box

(2) Click the Auto Startup button.
The Startup indicator flashes, the progress bar is displayed, and the vacuum system 
startup sequence initiates. The various components start up in sequence, as noted in 
the progress bar, and when the vacuum system is ready for operation, "Completed." 
is displayed.

Figure 2.16  Vacuum Startup Completed

(3) Close the "Vacuum Control" dialog box.
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2.4.2 Shutting Down the Instrument

1. Shut down the vacuum system.
(1) Click the Assistant Bar Vacuum Control icon to open the "Vacuum Control" 

dialog box.

(2) Click the Auto Shutdown button.
The Shutdown indicator flashes, the progress bar is displayed, and the vacuum 
system shutdown sequence initiates. The various components shut down in 
sequence, as noted in the progress bar, and when the vacuum system shutdown is 
completed, "Completed." is displayed.

Figure 2.17  Vacuum System Shutdown Completed

(3) Close the "Vacuum Control" dialog box.

2. Exit GCMSsolution.
(1) Select Exit from the File menu. A confirmation message is displayed to verify exiting 

the program.

Figure 2.18  Exit GCMSsolution Confirmation

(2) Click the OK button to exit GCMSsolution.

3. Turn off the power supply and carrier gas.
(1) Turn off the computer, monitor and printer.
(2) Turn off the GC. 
(3) Turn off the MS.
(4) Close the main valve of the carrier gas cylinder.
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2.5 Daily Startup and Shutdown

When a GC/MS system is used daily, the GC and MS components, including the vacuum 
system, are not shut down and remain in operation. Usually, the software is exited and the 
computer shut down. This section describes how to shut down and start up the computer 
and software while the rest of the system remains running.

2.5.1 Daily Shutdown

When the instrument is used daily, the vacuum system should be left running after each use 
rather than shutting down and restarting it so that the proper analysis conditions can be met 
more quickly. This section outlines the daily shutdown procedure when the vacuum system 
is left running.

1. Select Daily Shutdown from the Tools menu to open the "Daily Shutdown" dialog box.

Figure 2.19  "Daily Shutdown" Dialog Box

2. Enter the desired settings for the equipment in use on the Line 1 and General tab, 
etc.

3. Click the Shutdown button. The "Daily Shutdown" dialog box closes. The instrument 
will remain running according to the parameters entered in this window.

4. Exit Windows.

5. Turn off the computer, monitor and printer.
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2.5.2 Daily Startup

Follow the procedure below when the vacuum system is already running, as when the daily 
shutdown procedure has been performed.

1. Turn on the computer, monitor and printer, and start Windows.

2. Double-click the GCMS Real Time Analysis icon. The "Login" dialog box 
is displayed.

Figure 2.20  "Login" Dialog Box

   Note

Do not turn off the GC or MS.
Do not turn off the main power supply.
Do not change the GC column inlet pressure to 0.
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3. Enter your user name and password, and click OK. The GCMSsolution software 
starts up, and the "GCMS Real Time Analysis" window is displayed.

Figure 2.21  "GCMS Real Time Analysis" Window

Title Bar Menu Bar Toolbar Instrument Monitor

Assistant Bar Output Window
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2.6 Column Replacement

This section explains column replacement when column performance has deteriorated or 
with a column more appropriate for the application. If the column is not replaced correctly, a 
vacuum leak may result.

2.6.1 Shutting Down the Vacuum System

1. Click the Assistant Bar Vacuum Control icon to open the "Vacuum Control" 
dialog box.

2. Click the Auto Shutdown button.
The Shutdown indicator flashes, the progress bar is displayed, and the vacuum 
system shutdown sequence initiates. The various components shut down in 
sequence, as noted in the progress bar, and when the vacuum system shutdown is 
completed, "Completed." is displayed.

Figure 2.22  Vacuum System Shutdown Completed

3. Close the "Vacuum Control" dialog box.

   Caution

If the front door of the vacuum housing will be opened after the vacuum system is shut 
down, loosen the knob on the front door with one turn to the left.
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2.6.2 Changing the Column

1. Remove the column that is currently installed.
Loosen the nuts at the injector and MS connections, and remove the capillary 
column. If the Vespel ferrule and nut from the MS end are still on the capillary 
column, the column may be stored with the ferrule and nut attached.

The Vespel ferrules and nuts required to install the capillary column are considered 
consumable parts and should be stocked in sufficient quantities. Refer to 
Section D.1 "Consumable Parts List", page 333.

2. Install the new column.

Connecting the Capillary Column to the Injection Port
(1) Push the capillary column through the Vespel ferrule and nut. Refer to Figure 2.23 

"Using the Column Fitting Jig". 
(2) Insert the end of the capillary column into the column fitting jig (P/N 225-11657-09), 

so that the capillary column protrudes about 1 cm from the end of the jig as indicated 
in Figure 2.23 "Using the Column Fitting Jig" Secure it by tightening the nut. Cut the 
protruding end of capillary column.

(3) Mark the capillary column beneath the tightened nut with tape as shown in Figure 
2.24 "Marking the Column with Tape".

(4) Remove the capillary column from the jig without moving the tape, and wipe the 
capillary column with acetone. Insert the column into the injection port and secure it 
by hand tightening the nut. If the ferrule is new, use the wrench to turn the nut an 
additional full turn. If the ferrule has been previously used, use the wrench to tighten 
the nut by turning it 20 to 40 degrees.

(5) Remove the tape used to mark the column.

Part Name Part Number

Vespel ferrule 670-15003-03 (for 0.25 mm column)

670-15003-04 (for 0.32 mm column)

670-15003-07 (for 0.53 mm column)

Column mounting jig 225-11657-09

Nut 670-11009

Capillary column cutter 221-50595-91 (option)
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Figure 2.23  Using the Column Fitting Jig

Figure 2.24  Marking the Column with Tape

(21 mm for 0.53 mm 
column)

Cut Column 
Flush With 
End of Jig

Column 
Mounting Jig 
(for INJ)

Ferrule

Nut

Capillary Column

40 mm

   Note

A graphite ferrule is crimped by the jig, so that it is attached to the column, whereas 
a Vespel ferrule is not crimped and will slide on the column. To ensure proper 
positioning of the column, mark the column beneath the Vespel ferrule and nut with 
tape.

Jig

Nut

Tape

Column
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Connecting the capillary column to the MS 
(1) Push the capillary column through the Vespel ferrule and nut. Refer to Figure 2.25 

"Using the Column Mounting Jig". 
(2) Insert the end of the capillary column into the column fitting jig (P/N 225-11657-08), 

so that the capillary column protrudes about 1 cm from the end of the jig as indicated 
in Figure 2.26 "Connecting the Capillary Column to the MS". Secure it by tightening 
the nut. Cut the protruding end of capillary column.

(3) Mark the capillary column beneath the tightened nut with tape as shown in Figure 
2.24 "Marking the Column with Tape".

(4) Remove the capillary column from the jig without moving the tape, and wipe the 
capillary column with acetone. Insert the column into the MS interface and secure it 
by hand tightening the nut. If the ferrule is new, use the wrench to turn the nut an 
additional full turn. If the ferrule has been previously used, use the wrench to tighten 
the nut by turning 20 to 40 degrees.

(5) Remove the tape used to mark the column.

Figure 2.25  Using the Column Mounting Jig

Nut

Column Mounting Jig

Vespel Ferrule

Capillary Column
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Figure 2.26   Connecting the Capillary Column to the MS

Figure 2.27  Marking the Column with Tape

   Note

To prevent background noise, always use a Vespel ferrule to connect the column to 
the MS. A graphite ferrule is crimped by the jig, so that it is attached to the column, 
whereas the Vespel ferrule is not crimped and will slide on the column. To ensure 
proper positioning of the column, mark the column beneath the Vespel ferrule and 
nut with tape.

Jig

Nut

Tape

Column
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Figure 2.28  Using the Driftpin to Remove Ferrule

3. Turn on the instrument.
(1) Ensure that the breaker controlling the instrument power supply is on, and turn on 

the GC. 
(2) Turn on the computer, monitor and printer, and start Windows.
(3) Turn on the MS. The power LED in the upper left corner of the MS will light.

Figure 2.29  Starting the Instrument

   Note

A driftpin is provided to remove the ferrule lodged inside the mounting nut (SSNE 
16/012) when the nut is re-used. In order to reduce wear on the interface screw, 
only reuse it two or three times.

Tap with a Hammer

Nut SSNE 16/012

Driftpin

Power LED



2  Basic Operation
2.6 Column Replacement

36 GCMS-QP2010

4. Start GCMSsolution.
(1) Double-click the GCMS Real Time Analysis icon. The "Login" dialog box 

is displayed.

Figure 2.30  "Login" Dialog Box

(2) Enter your user name and password. The first time that the software is accessed, 
use the default user name "Admin" and leave the password blank.
Click the OK button.
The GCMSsolutions2 software starts up, and the "GCMS Real Time Analysis" 
window is displayed.

Figure 2.31  "GCMS Real Time Analysis" Window

Title Bar Menu Bar Toolbar Instrument Monitor

Assistant Bar Output Window
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5. Start the vacuum system.

   Caution

If the instrument has been shut down for an extended period of time and the ambient 
temperature is low, the rotary pump oil may become very viscous. When the oil viscosity 
is too high and the rotary pump is operated, an excessive load is placed on the rotary 
pump motor. The breaker for the main power supply (on the back of the instrument, 
Section 1.3.1 "GC/MS Analytical System", page 3) may trip and shut down the 
instrument. 
When the instrument has been turned off and kept in a cold environment, increase the 
ambient temperature and start up the instrument after the rotary pump temperature is at 
least as high as the minimum temperature specification (18 °C).

   Caution

Before starting up the vacuum system, confirm that the knob of the front door is tight.

   Caution

Do not tighten the knob on the MS front panel door after starting the vacuum system. 
Otherwise, it may be impossible to loosen the knob after the instrument is shut down.

   Caution

When replacing a column with one of a larger internal diameter, a large volume of carrier 
gas may flow into the MS and prevent the vacuum system from starting.  Before starting 
the vacuum system, adjust the pressure for the carrier gas and make sure that the flow 
into the column is less than 15 mL/min for Dual TMP model or less than 2 mL/min for 
Single TMP model, respectively.
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(1) Click the Vacuum Control icon in the Assistant Bar. The "Vacuum Control" 
dialog box is displayed.

Figure 2.32  "Vacuum Control" Dialog Box

(2) Click the Auto Startup button.
The Startup indicator flashes, the progress bar is displayed, and the vacuum system 
startup sequence initiates. The various components start up in sequence, as noted in 
the progress bar, and when the vacuum system is ready for operation, "Completed." 
is displayed.

Figure 2.33  Vacuum System Startup Completed

(3) Close the "Vacuum Control" dialog box.
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2.7 System Configuration

This section explains system configuration. Procedures are described for entering the 
properties for the autosampler, injection port, column, detector, additional temperature 
control, additional flow, and other installed components.

2.7.1 System Configuration

1. Click the Assistant Bar System Configuration icon to open the "System 
Configuration" dialog box.

Figure 2.34  "System Configuration" Dialog Box

The components that can be included in the configuration are listed in the Available 
Modules box on the left. The tree structure includes the various GC, autosampler, 
injection port, detector, and additional options. To view the options that are available 
for a particular component, click the plus symbol (+) to the left of the respective icon.

2. To include a component in the configuration, select its icon in the Available Modules 
box and click the right arrow button. Alternatively, double-click the icon, or drag the 
icon from the left window and drop it in the right.
The current system configuration is displayed in the Modules Used for Analysis box 
on the right.
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Available GCMS Modules

3. Double-click each component listed in the Modules Used for Analysis box to open 
the "Properties" dialog box and enter the necessary parameters. Default settings 
may be used for most parameters. For column properties, selecting the type of 
column in use automatically enters its specifications. Ensure that the MS ion source 
is correctly selected. Change any other parameters according to the application and 
configuration. For more information about the parameters for each GC/MS system 
component, consult the online GCMS Help.

To print the configuration and properties, click the Print button in the "System 
Configuration" dialog box.

4. After all of the components included in the configuration are listed in the Modules 
Used for Analysis box and their properties are entered, click the Set button and exit 
the "System Configuration" dialog box.

Module Options

GC GC-2010

Autosamplers AOC-20i

AOC-20i+s

AOC-20d(M)

AOC-20d(S)

Injection Ports SPL

OCI

WBI

PTV

Column Column

Detectors FID

FPD

FTD

ECD

TCD

MS

Other Units Other Units

Additional Heater*

Additional Flow*

* Units connected to the main unit are displayed automatically.
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2.8 System Check and Tuning

This section explains how to perform a system check and tune the GC/MS system. The 
system check is a diagnostic check that should be run before analysis to verify proper 
instrument operation. The system is tuned by selecting the appropriate items within the 
"Tuning" window.

2.8.1 System Check

Overview

Parameter Description Action if System Check fails

Maintenance
Verifies how long and how many 
times a GC/MS consumable part 
has been used.

Replace the part and reset its 
amount of use.

GC Check Verifies system status of GC.

If adjustment or repairs are 
recommended, discuss them with 
your Shimadzu representative.
If a part replacement is necessary, 
replace the part as recommended.

MS Check Verifies various values related to 
MS analysis precision.

If adjustment or repairs are 
recommended, discuss them with 
your Shimadzu representative.
If a part replacement or tuning is 
necessary, replace the part or 
tune as recommended.

Run Autotuning 
as Needed

Performs autotuning, when 
System Check fails.

OR

Run Autotuning Performs autotuning regardless of 
System Check results.

Report Out Prints the System Check results.
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1. Click the Assistant Bar System Check icon to open the "System Check" 
dialog box.

Figure 2.35  "System Check" Dialog Box

"System Check" Dialog Box
The following items are displayed in the "System Check" dialog box.

System Check
The system check is performed according to the items selected in the "System Check" 
dialog box.

To display the detailed settings for each item, click the Advanced>> button.

   Note

The standards entered in System Check are the criteria used for the test, and do 
not reflect the manufacturer's specifications.
When autotuning is performed, the current tuning file is overwritten. Depending on 
the items being tuned, some previously obtained calibration curves can no longer 
be used.

Item Description

Last Run Date Displays the date on which the last system check was performed.

Result messages Displays Pass, Fail and other messages.

Elapsed Time Displays the time elapsed during the system check.

Item Description

Maintenance Verifies how long and how many times a GC/MS consumable or 
maintenance part has been used.

GC Check Verifies system status of GC.

MS Check Verifies various values related to MS analysis precision. 

Run Autotuning As 
Needed

If the "Signal intensity fluctuation," "Mass axis misalignment," or 
"Spectrum peak half-width fail" message is displayed, run autotuning.

Run Autotuning Performs autotuning regardless of System Check results.

Report Out Prints the System Check results.
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Buttons
The following buttons are displayed in the "System Check" dialog box.

   Note

Some checks may only be performed with an EI ion source. There are also some 
checks that may only be performed after the MS has completed operation. Checks 
that cannot be performed are disabled. For more information, please refer to GCMS 
Help.

Autotuning should usually be performed with the default parameters:
• "Resolution adjustment" selected
• "Spectrum peak half-width" = "0.6"
• "Sensitivity adjustment" selected
• "Mass Calibration" selected

Autotuning parameters may be changed by clicking the Tuning icon in the 
Assistant Bar. Select the Tuning file to be used in the advanced MS parameters tab.

The system is tuned according to the parameters entered in the Tuning file. Note 
that depending on the items being tuned, some previously obtained calibration 
curves can no longer be used.

Button Description

Run Starts the system check.

Stop Stops the system check. Only enabled while System Check is 
performed.

Close Closes the "System Check" dialog box.

View result Displays the results of the System Check. The results may be printed 
from the "System Check Result" dialog box.

Help Opens the help file.

Advanced Displays the advanced parameters. Only users authorized for 
"Changing System Check settings" can access these parameters.
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The system check is initiated when Run is clicked. The time elapsed during the 
system check is displayed, and the progress bar tracks the system check progress.

Figure 2.36  "System Check" Dialog Box

If the system check is completed without detecting any problems, "Pass" is displayed 
above the progress bar. If problems are detected, "Fail" is displayed.

2. Click the Advanced>> button to display the GC and MS advanced tabs. Select the 
GC tab to select the maintenance items and consumable parts to be checked during 
system check.

Figure 2.37  System Check GC Advanced Parameters Tab
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GC Maintenance Items

3. Select the MS tab to select the maintenance items and consumable parts to be 
checked during system check.

Figure 2.38  System Check MS Advanced Parameters Tab

Item Description

LCD Back Light Checks how long the back light has been active.

Fan Motor Checks how long the fan motor has operated.

CRG Coolant Checks the counter for CRG refrigerant depletion.

Septum Checks how many times the currently installed septum has been 
used. For more information, refer to GCMS Help.

Insert Checks how many times the currently installed glass insert has been 
used. For more information, refer to GCMS Help.
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MS Maintenance Items

The Reset button opens a dialog box to allow the use time or number of uses of a 
part to be reset. Click the Clear button to reset the length of time or number of times 
that a maintenance part has been used back to zero.

4. When the Reset button is clicked, the "Reset Consumables" dialog box is displayed. 
Reset the use time or number of uses any time a consumable part is replaced.

Figure 2.39  "Reset Consumables" Dialog Box

Item Description

Filament Checks how long the filament has been used. For more information, 
refer to GCMS Help.

Ion Source Checks how long the ion source has been used. For more 
information, refer to GCMS Help.

Detector Checks how long the detector has been on and in use. For more 
information, refer to GCMS Help.

Turbo Molecular Pump Checks how long the turbomolecular pump has been running and in 
use. For more information, refer to GCMS Help.

Rotary Pump Checks how long the rotary pump has been running and in use. For 
more information, refer to GCMS Help.

Rotary Pump Oil Checks how long the rotary pump oil has been used. For more 
information, refer to GCMS Help.

Reset Opens the dialog box to set the use time or number of uses for 
maintenance parts.

   Note

Only a Shimadzu representative can reset the turbomolecular pump 
use time.
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Reset Items

   Note

Only users authorized for "Changing System Check Settings" can reset the time or 
number of uses. 
• "0" is entered when the Clear button is clicked.
• If the part was changed earlier, enter the appropriate value.
• The value is changed when OK is clicked.
• The value displayed is the same value as when the "Reset Consumables" dialog box 

was last displayed. The values do not update automatically.

Item Description

GC Septum Reset the number of uses to 0 by clicking the 
Clear button. The number is not user 
definable.

Glass Insert

CRG Refrigerant (Column Oven)

CRG Refrigerant (INJ#2)

MS Filament #1 Enter the appropriate time.

Filament #2

Ion Source

Rotary pump 1 Oil Enter the appropriate time.

Rotary pump 2 Oil This is only displayed if a second rotary pump 
is installed. Enter the appropriate time.
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5. Click the GC tab and select the desired GC Check items.

Figure 2.40   System Check Advanced GC Tab

GC Check Items

Item Description

Heat Sensor Checks how long the temperature sensor is used at 300 °C or above. 
Refer to GCMS Help for more information.

DC Voltage Measures the DC voltage and checks if the error is within the 
standard range. Refer to GCMS Help for more information.

Environment Measures the room temperature and air pressure, and checks if they 
are within the warranted operating conditions. Refer to GCMS Help 
for more information.

Primary Pressure Measures the primary pressure of the carrier gas and checks if it is 
above the value of the environment setting. Refer to GCMS Help for 
more information.

CPU Checks the CPU Register and Real-time Clock. Refer to GCMS Help 
for more information.

Detector ROM Checks the detector ROM for each detector. Refer to GCMS Help for 
more information.

Detector ADC Checks the detector ADC for each detector. Refer to GCMS Help for 
more information.
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6. Click the MS tab and select the desired MS Check items.

Figure 2.41  System Check MS Advanced Parameters Tab

Detector High Voltage Checks the high voltage of detectors respectively. Performed only 
when FID, FTD, or FPD is mounted. Refer to GCMS Help for more 
information.

Detector Ignite Checks the Ignition Pulse and ignition procedure of each detector. 
Performed only when FID, FTD, or FPD is mounted. Refer to GCMS 
Help for more information.

ECD Cell Frequency Measures the pulse voltage band for each detector ECD and 
compares dirtiness of cells with the threshold. Refer to GCMS Help 
for more information.

Flow Unit Board ROM Checks ROM for each Flow Control Circuit (SLOT). Refer to GCMS 
Help for more information.

Flow Unit Board ADC Checks ADC for each Flow Control Circuit (SLOT). Refer to GCMS 
Help for more information.

Flow Control Checks if the flow is controlled properly for each Flow Port. Refer to 
GCMS Help for more information.

Item Description
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MS Check Items

   Note

The parameters entered into the MS tab serve as the system check criteria, and do 
not reflect the manufacturer's specifications.

Item Description

Base Line Determines the baseline fluctuation value (RMS). Refer to GCMS 
Help for more information.

Intensity Ratio of 28/69 Evaluates the ratio obtained from measuring m/z=28 (nitrogen) and 
m/z=69 (PFTBA). The ratio is used in determining if there is a leak. 
Refer to GCMS Help for more information.

RF Power Supply Confirms that the high-frequency power is operating normally. Refer 
to GCMS Help for more information.

Signal Intensity Ratio Compares the PFTBA signal intensity with the previous autotuning 
results. To apply the Adjust Sensitivity parameter entered in the 
Autotuning Conditions, "Mass Calibration" in the "Tuning Condition" 
dialog box must be selected. Refer to GCMS Help for more 
information.

Maximum Mass Shift Determines if the mass axis has shifted. For this parameter to be 
corrected during autotuning, "Calibrate Mass" must be selected in the 
Autotuning Conditions. Refer to GCMS Help for more information.

FWHM Determines the spectrum peak width at half-height shift from the 
mass peak width at half-height values entered for m/z = 69, 219, and 
512. For this parameter to be corrected during autotuning, "Adjust 
Resolution" must be selected in the Autotuning Conditions. Refer to 
GCMS Help for more information.
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7. Select the desired items to be checked during autotuning in the "Check at 
Autotuning" section of the MS tab.

Figure 2.42  System Check MS Advanced Parameters Tab

When "Run Autotuning as Needed" or "Run Autotuning" are selected, these items 
are checked after autotuning is performed.

Checks after Autotuning

Item Description

Detector Gain of Tuning 
Result

Determines the detector voltage setting that resulted from 
autotuning. Refer to GCMS Help for more information.

Maximum Mass Shift Determines the mass axis shift. Note that "Calibrate Mass" must be 
selected in the Autotuning Conditions. Refer to GCMS Help for more 
information.
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8. Select the tuning file to use for autotuning during the system check.

Tuning File

9. Click the Run button to run the system check.

10. Select View Result... to display the "System Check Result" dialog box. This displays 
the results of the last system check.

Figure 2.43  "System Check Result" Dialog Box

Item Description

Tuning The file displayed in Tuning is used to autotune the instrument 
during the system check. To select or change the file, either enter 
the full file path directly or open the "Select Tuning File" dialog box 
by clicking the browse button to the right. From the "Select Tuning 
File" dialog box, select the appropriate file and click OK. The file 
name is now displayed in Tuning.

   Note

After performing a check, the results are displayed automatically. Current and 
previous system check results can be printed. It is not necessary to run the system 
check to display or print previous results.
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System Check Table

Buttons in the "System Check Result" Dialog Box

11. Click the Print button to print the currently displayed system check results.
The maintenance, GS, MS and post-tuning check items and their results are printed, 
followed by specific GC and MS information.

Text Printed with System Check Results

Columns Descriptions

Item The check item that was performed.

Judge Whether the item passed or failed the test, and suggested actions.

Ratio The ratio of the measured value to the standard value. Allows quick 
examination of system condition.

Actual/Standard Measured and standard values for the item.

Button Description

Load Open past results that were saved in the log folder. The files are 
saved and named automatically. A 14-character name is assigned. 
The first character is the system number. The second is an 
underscore (_). The third through sixth are the year. The seventh and 
eighth are the month. The ninth and tenth are the day. Characters 11 
and 12 are the hour time, and 13 and 14 are the minutes. Thus, if a 
system check is performed on System 1 on January 1, 2000, at 
13:00, the name is 1_200001011300.qgc.

Print Print the currently displayed results.

Text Description

Header Prints the user name, date and time of system check, and time of 
printing.

Footer Prints the page number and number of pages in the center.
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2.8.2 Tuning

In the "Tuning" window, the parameters controlling the MS can be adjusted so that the 
desired mass spectrum peaks are obtained.

There are two tuning methods: autotuning and manual tuning. Autotuning automatically 
adjusts the various instrument control parameters as specified in the Autotuning Conditions. 
In manual tuning, various control parameters are used to manually adjust the mass peaks. 
When the "Tuning" window is opened, the tuning file that was last saved or used for data 
acquisition is displayed. Unless otherwise specified, the file that opens automatically in the 
"Tuning" window is used during system checks or data acquisition.

Operations associated with creating or accessing a tuning file are described below.

1. Click the Assistant Bar Tuning icon in the "GCMS Real Time Analysis" 
window. The "Tuning" window is displayed.

To create a new tuning file, select New Tuning File from the File menu. 
Proceed to Step 2.

To perform tuning with an existing file, select File > Open Tuning File to display the 
"Open Tuning File" dialog box. Select the appropriate tuning file, and click Open. 
Proceed to Step 3.

2. Click the Assistant Bar Autotuning Condition icon, or select Tuning > 
Condition of Autotuning, to open the "Tuning Information" dialog box.

Figure 2.44  "Tuning Information" Dialog Box
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Tuning Condition
Select which parameters to apply during autotuning, and enter those parameters. The 
parameters include Adjust Resolution, Adjust Sensitivity, Calibrate Mass, and Adjust Mass 
Pattern. Select the parameters to include during autotuning. When the tuning conditions are 
changed, the MS system check or autotuning results may vary.

After selecting the appropriate parameters and entering values as necessary, click the OK 
button and close the "Tuning Information" dialog box.

Instrument Parameter Description

Adjust Resolution
Adjust the resolution so that the peak width at half-height value 
obtained with the standard (PFTBA) is near the value entered 
for Spectrum peak width at half-height (FWHM).

FWHM of Peak Profile
0.3 - 2.0 u (where "u" denotes atomic mass unit) 
Note: Although resolution increases as the width at half-height 
value decreases, the signal intensity tends to decrease.

Adjust Sensitivity Adjust the lens system to the maximum sensitivity for a 
specific ion with the Target Ion adjustment.

Calibrate Mass A spectrum produced from a standard (PFTBA) is used to 
correct for mass axis misalignment.

Adjust Mass Pattern

Adjust the lens system to maximize the m/z 502 peak, and 
correct the intensity to equalize the intensity pattern between 
the spectrum of the standard measured by MS in the magnetic 
field type and the spectrum in the main instrument. Pattern 
calibration sets the intensity correction parameter to 
correspond to the specified intensity ratio.



2  Basic Operation
2.8 System Check and Tuning

56 GCMS-QP2010

3. Click the Assistant Bar Start Autotuning icon or the Start Tuning button on 
the toolbar to tune the instrument automatically. Autotuning can also be 
started with the Tuning > Start Autotuning command.

Figure 2.45  "Autotuning" Dialog Box

After autotuning is completed, save the file. Select File > Save Tuning File As the 
first time the file is saved or to save the file with a new name. Select File > Save 
Tuning File to overwrite the existing tuning file.

4. Click the Assistant Bar Tuning Result View icon to view the tuning results.
The peak profile corresponding to each m/z is displayed.

Figure 2.46  Tuning Results - Peak Profiles
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5. Click the  button in the toolbar to print the tuning results.

Figure 2.47  Printed Tuning Report

   Note

The "Peak Monitor" screen displayed by clicking the Assistant Bar Peak 
Monitor View icon is the same as the screen displayed during the 
Vacuum Leak Check and other operations.
For more information about checking for vacuum leaks, refer to Section 10.6 
"Checking for Leaks", page 228.
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2.8.3 Adjustment for High Masses

This instrument incorporates an auto-tuning function that conducts mass calibration for 
molecular weight up to m/z 614. Mass displacement is rare in the normal range of operation 
(up to approximately m/z 700.)
However, displacement from the calibration for the m/z is possible in the high mass range 
above m/z 700. 
To ensure accurate calibration in the range above m/z 700 requires manual calibration by 
the following procedure.

Analysis Conditions (Column: DB-5 ms, Inner diameter 0.25 mm, Length 30 m, Thickness 
0.25 µm)

Sample : Tris (perfluoroheptyl)-S-triazine 1 % solution (acetone)
GC : INJ 250 °C, Column head pressure 100 kPa, Total flow rate 30 mL/min, 

Splitless injection (1 min. sampling)
COL 50 °C (1 min) _ 5 °C /min_100 °C (1 min)_30 °C /min_250 °C 
(10 min)

MS : I/F 250 °C , Ion source 200 °C 

1. Execute the autotuning command.
After it has been completed, open the Peak Monitor window, and turn the filament off.

2. Inject the 1 µL triazine sample, and start the GC.

3. In the mass calibration window opened from the Peak Monitor window, align the 
cursor with the highest cell for m/z 866.

4. When 8 minutes have elapsed since the sample injection, turn the filament on.

5. After 10 minutes have elapsed, a 3-minute segment of peaks can be calibrated. Click 
the Centering button to calibrate the peak.

6. Click the Supplement button, then click OK.

7. Save the tuning file. For the message of "Do you acquire and save peak profile/
spectrum data?", click the No button.
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   Note

Traces of the injected triazine may remain in the INJ, column, etc. and hinder 
subsequent analysis after calibration. In that case, set the column temperature to 
250 °C and proceed with aging. Although a sample of about 1 ppm can be 
analyzed for about 1 hour by aging, changing the insert or aging for several hours 
are recommended to conduct ultra-microanalysis. 
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2.9 Common Operations

2.9.1 Managing Files

1. File types

Type Description Ext.

Data file Saves raw acquired data, such as chromatograms and spectra, 
including:
• Results of peak integration and concentration calculations
• The oven temperature status and errors generated during 

data acquisition
• The contents of the method file used in analysis, including 

parameter settings
• The contents of the report format file when reports are 

generated
• The contents of the batch file when batch processing is 

performed
• The contents of the tuning file used in analysis

.qgd

Method file Saves parameters related to the instrument, data acquisition, 
qualitative, quantitative, data view, and QA/QC. System 
configuration is saved so that it can be checked when the method 
file is opened. Calibration curves used in the method are also saved.

.qgm

Report format 
file

Saves which information to include in the report and how to lay out 
the information, along with other report format information such as 
headers and footers.

.qgr

Batch file Saves the batch tables used for automating data acquisition and 
analysis. GCMS Real Time Analysis and GCMS Postrun Analysis 
can access the same file.

.qgb

Tuning file Saves the tuning parameters, used to adjust the instrument, and the 
results of tuning using these parameters.

.qgt

Library file Saves spectra and compound information for similarity searches. 
Library files include the optional NIST commercial database and 
private libraries created from the spectra and compound information 
of target compounds. The spectra and information in library files is 
searched for matches with a spectrum.

.lib*1

Browsing file Saves the layout information such as loaded method/data file 
names, order of files, and presence of statistic calculation settings.

*.qgq

Layout file Saves the layout, the data loaded to each cell, and the display-
related information.

*.lyt

*1 The library is actually composed of multiple files. The constitutive files are somewhat 
different for commercial and private libraries. When copying library files, ensure that all 
associated files are copied.
Commercial library: .lib, .c2s, .fom, .nam, .ncv, .spc, .str
Private library: .lib, .com, .flg, .fom, .nam, .spc
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2. File management
The "Data Explorer" window displays the various files by type for easier 
management. The five tabs of the Data Explorer are Data, Method, Report Format, 
Batch, and All Files. Any file can be moved, copied or deleted from the "Data 
Explorer" window without returning to the Windows desktop.

(1) Opening the "Data Explorer" Window
Select File > Data Explorer to open the "Data Explorer" window. When the Data 
Explorer is displayed, a check appears to the left of Data Explorer in the File menu to 
show that it is visible. Selecting File > Data Explorer when it is checked closes the 
"Data Explorer" window.

(2) Displaying a File Type
Click the tab that corresponds to the appropriate file type. The 
tabs, located beneath the Data Explorer list box, are Data, 
Method, Report Format, Batch, and All Files. The files of the 
selected type are displayed.

(3) Changing how Files are Displayed
Change the way files are displayed by right-clicking 
the list box and selecting File View. From the File 
View submenu, select how files are displayed from 
Large Icon, Small Icon, List, and Detail. The way 
files are displayed can also be changed with the 
View > File View command when the "Data 
Explorer" window is active.

(4) Confirm the data.
The data preview is displayed below the list box 
by right-clicking the list box and selecting Data 
Preview. Chromatogram and sample information 
are displayed when the Data Tab is selected. File 
comments are displayed if other tabs are 
selected.

   Note

The check mark to the left of the File View submenu indicates the current display 
mode.
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(5) Changing the Project
To change the directory in which the files are located, or the project, click the 
Select Project button to the far right of the Project in combo box. The 
"Project (Folder) Selection" dialog box is displayed.

Figure 2.48  "Project (Folder) Selection" Dialog Box

When the "Project (Folder) Selection" dialog box is displayed, the open folder is the 
project currently selected. The levels are arranged as in Windows Explorer. Select 
the desired folder, and click the OK button. The "Project (Folder) Selection" dialog 
box is closed, and the files in the newly selected project are displayed in the list box.

(6) Creating New Projects
Click the Create New Project button, located to the left of Select Project 
button, to open the "Create New Project (Folder)" dialog box.

Figure 2.49  "Create New Project (Folder)" Dialog Box

Enter a name for the project. To copy method, batch and/or report format files from 
the project that is currently open, select the appropriate check boxes.
After entering the name and selecting the files to copy, click the OK button. The 
"Create New Project (Folder)" dialog box is closed, and the files that were copied (if 
any) are displayed in the list box.
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2.9.2 Opening and Saving Files

This section describes how to open and save files, such as data or method files. The Open 
and Save commands are similar to those used in Windows. Refer to the Windows manual 
for more information.

1. Opening a File
Although the procedure below describes opening a method file, it applies to all files.

(1) Select File > Open or File > Open Method File, or click the toolbar Open button. 
The "Open Method File" dialog box is displayed.

Figure 2.50   "Open Method" File Dialog Box

(2) Click the "Look in" combo box button, and scroll up and 
down to change directories or drives. Click the Up One 
Level button to open the directory containing the 
currently opened folder. To open a lower directory, select 
a folder from the list box and click the Open button, or 
double-click the folder. Change and expand directories 
until the folder in which the desired file has been saved is 
displayed in the combo box.

(3) Select the desired file from the list box, and confirm that the correct file name is 
displayed in the File Name text box. Click the Open button to open the selected file.
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2. Saving a New File
Although the procedure below describes saving a newly created data file, it applies to 
all files.

(1) Select File > Save Data File As to open the "Save Data File As" dialog box.

Figure 2.51  "Save Data File As" Dialog Box

(2) Click the "Save in" combo box button, and scroll up and 
down to change directories or drives. Click the Up One 
Level button to open the directory containing the 
currently opened folder. To open a lower directory, select 
a folder from the list box and click the Open button, or 
double-click the folder. Change and expand directories 
until the folder in which the desired file has been saved is 
displayed in the Save in combo box. If necessary, create a new folder by clicking the 
Create New Folder button.

(3) Enter a file name in the File Name text box, and click the Save button to save the file 
using that name.
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2.9.3 Using Help

1. Opening help files to a specific topic
To access information about the active window or dialog box, press the F1 key on the 
keyboard. If available, the GCMS Help window will open to the topic that corresponds 
to the active window or dialog box.

Figure 2.52  GCMS Help Window

Additionally, some windows and dialog boxes include a help button that, when 
clicked, links directly to the appropriate help topic.
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2. Opening help files by keyword
Select Help > Contents to open the GCMS Help window.

Figure 2.53  GCMS Help Contents Window

Click the Index tab to the left of GCMS Help window. An index of keywords is 
displayed in the list box.
Scroll the list box to search for the desired topic. Select the keyword, and click the 
Display button to open the help topic.

   Note

When the same keyword appears in more than one topic, the list of Topics Found is 
displayed. The list is displayed in the right side of the GCMS Help window. Scroll to 
search for the desired topic. Select the topic from the list, and click the Display 
button.

Figure 2.54  List of Topics Found
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   Note

The GCMS Help window can be moved and resized as desired. To change 
locations, drag the window using the title bar. To change the size, either drag the 
frame or square corner on the lower right of the window.
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2.9.4 Concepts of System Administration

In the GCMS-QP2010, system security revolves around the idea of user management. The 
GCMSsolution software allows an administrator to select an authorization level for each 
user. The authorization level determines the amount of access the user has to the 
instrument, data and methods. This prevents users who should not change methods from 
inadvertently doing so, and protects against the system being shut down by a user who 
does not have the authority to make such a decision.

1. Users and Groups
System administration involves users, groups, and an authorization system. The 
diagram below illustrates the user, group and authorization system. Each user 
belongs to one or more groups. Each group is assigned certain levels of 
authorization. Each authorization level is composed of a defined set of assigned 
rights.

Figure 2.55  Users, Groups and Authorization Levels

• User 1 belongs only to Group 1, and can operate under Authorization 1 and 
Authorization 2 held by Group 1.

• Like User 1, User 2 belongs only to group 1, and can also operate under 
Authorizations 1 and 2.

• User 3 belongs to Group 2 and Group 3, and can operate under Authorizations 
3 - 6, which are all of the authorizations held by the two groups.

• User 4 does not belong to any group, and thus does not have any authority.

A1 A2 A3 A4 A5 A6

Group 1 Group 2 Group 3

User 1 User 2 User 3 User 4

Authorization 
Level

Groups have 
Authorization 
Levels.

Users belong 
to Groups.
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Authorization 
Level

Description
Default groups

H/W 
Administrator

Method 
Developer

Operator

User 
Administration

Authority to add or delete users, set policy, 
and perform functions described in 
Section 2.9.5 "System Administration", page 
71.

Edit System 
Configuration

Authority to change system configuration and 
perform functions described in Section 2.7 
"System Configuration", page 39.

× ×

Edit Method 
(Instrument 
Parameter)

Authority to edit the instrument parameters 
entered in the method file, and perform 
functions described in Chapter 2 "Basic 
Operation" on page 11.

×

Edit Method 
(Acquisition 
Display Settings)

Authority to edit the Data View Parameters in 
the method file, or the parameters accessed 
with the View > Data View Parameters.

×

Edit Method 
(Data Processing 
Parameters)

Authority to edit the Qualitative and 
Quantitative analysis parameters in the 
method file, or the parameters described in 
Chapter 4 "Qualitative Analysis" on page 111 
and Chapter 5 "Quantitative Analysis" on page 
137.

×

Edit Report 
Format

Authority to edit report format files and 
perform functions described in Chapter 6 
"Generating Custom Reports" on page 165.

×

Edit Batch Table Authority to edit batch tables and perform 
functions described in Chapter 7 "Continuous 
Analysis" on page 175.

× ×

Create Template Authority to create templates for method, 
batch and report format files, and perform 
functions described in Section 2.9.6 
"Templates", page 81.

×

Modify 
Autotuning 
Settings

Authority to change tuning conditions and 
perform functions described in Section 2.8.2 
"Tuning", page 54.

×

Modify System 
Check Settings

Authority to change system check parameters 
and perform functions described in 
Section 2.8.1 "System Check", page 41.

×

ON OFF Vacuum 
System

Authority to start up and shut down 
instruments, and perform functions described 
in Section 2.4 "Instrument Startup and 
Shutdown", page 14.

×

Run System 
Check and 
Autotuning

Authority to perform system checks and 
autotuning as described in Section 2.8 
"System Check and Tuning", page 41.

× × ×

Run Peak Monitor Authority to perform peak monitoring. ×
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2. Administrators
Administrators are users that have full authority to perform all functions included in 
the GCMSsolution software. When the software is installed, a default user with the 
user ID "Admin" and Administrator privileges enables the system administrator to 
access and setup the software.

3. Using Shimadzu User Authentication Tool
If you use the CLASS-Agent software (optional), you can manage user information 
using Shimadzu User Authentication Tool. Shimadzu User Authentication Tool allows 
you to share the information of users with other software also using Shimadzu User 
Authentication Tools, such as CLASS-Agent and GCsolution. To utilize Shimadzu 
User Authentication Tool, set "Shimadzu User Authentication Tool" in the "User 
Authentication Mode Select" window at the installation of the GCMSsolution. For 
details of the installation and environmental setting of Shimadzu User Authentication 
Tool, refer to the instruction manual that comes with Shimadzu User Authentication 
Tool.

Run Batch Data 
Acquisition

Authority to perform automated data 
acquisition and analysis as described in 
Section 7.2 "Automated Data Acquisition and 
Data Analysis", page 177.

× ×

Run Single Data 
Acquisition

Authority to acquire data for a single sample 
and perform functions described in 
Section 3.3 "Single Run Setup", page 104.

×

Run Postrun 
Analysis

Authority to analyze data in GCMS Postrun 
Analysis and perform functions described in 
Chapter 4 "Qualitative Analysis" on page 111 
and Chapter 5 "Quantitative Analysis" on page 
137.

× ×

Authorization 
Level

Description
Default groups

H/W 
Administrator

Method 
Developer

Operator

   Note

To manage user information using the Shimadzu User Authentication Tool, be sure 
to install the Shimadzu User Authentication Tool in Version 1.08 or later versions.

   Note

If you select to use the Shimadzu User Authentication Tool when the GCMSsolution 
is already in actual operation, current user information will be replaced with that 
registered in the Shimadzu User Authentication Tool. Note therefore that if users 
are registered in the GCMSsolution but not in the User Shimadzu Authentication 
Tool, it is necessary to newly register them to the Shimadzu User Authentication 
Tool. By referring to Section "2.9.5 System Administration", "Users" dialog box, 
reregister the users. Note too that if user IDs or user names are identical between 
the User Databases of the GCMSsolution and the Shimadzu User Authentication 
Tool, the user information (e.g. password) specified with the Shimadzu User 
Authentication Tool becomes effective. Be sure to review the relevant user 
information by referring to Section "2.9.5 System Administration".
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2.9.5 System Administration

The "System Administration" dialog box enables the administrator to perform a number of 
functions. New users are added and their user names, passwords, and access rights 
assigned. Groups are added or edited. Parameters controlling user log-in are set. 
Whenever changes are made or users added, an event log records the modification.

1. Select File > User Administration to open the "System Administration" dialog box.

Figure 2.56  "System Administration" Dialog Box

2. The Password tab allows the password for a user registered in the system to be 
changed. If a user does not have a password assigned, all of the fields on the tab are 
disabled.

Parameter Description

User Name Displays the name of the user that is currently logged in.

Old Password Enter the password that is currently in use.

New Password Enter a new password.

Confirm New Password Enter the new password exactly as it was entered in New 
Password to confirm that it was entered correctly.

   Note

If a user logs in without a password, the User tab is used to enter a password. For 
more information, see the next paragraph, which describes the User tab.



2  Basic Operation
2.9 Common Operations

72 GCMS-QP2010

3. The User tab displays a list of all users that have been registered in the system. 
Select a user name to display the groups to which the user belongs in the Assigned 
Groups box. To add a user, click the Add button. The "Add User" dialog box is 
displayed.

Figure 2.57  "Add User" Dialog Box

Enter the following information for each user.

Property Description

User ID Type the user ID for the new user. This is used for login.

User Name Enter a user name for the new user. 

Description Enter the descriptions of the user, e.g. full name.

Use Password Check here to have the user enter a password at login. When 
checked, the Password and Confirm Password fields are 
enabled.

Password If Use Password is checked, enter a password for the user to 
enter at login.

Confirm Password Enter the password a second time to confirm that it was 
entered correctly.

Administrator Check here to make the user an administrator.

Group List Select the group(s) to which the user will belong and click the 
Add button, or double-click the group. The group is moved to 
the Selected Groups box.

Selected Groups Displays the groups to which the user belongs. To remove 
the user from a group, select the group and click the 
Remove button, or double-click the group. 
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Figure 2.58  "User Property" Dialog Box

   Note

Set the minimum length for a password in the Policy 1 tab, if passwords are used.

Click the OK button after setting up the new user, and the "Add User" dialog box is 
closed.

To delete a user, select the appropriate user in the Users tab and click the Remove 
button.

To display the properties for a user, select the appropriate user in the Users tab and 
click the Properties button. The "User Property" dialog box is displayed.
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The following properties are displayed for each user.

Property Description

User ID Displays the user ID of the selected user. This cannot be 
changed.

User Name Displays the user name of the selected user.

Description Displays the descriptions of the selected user.

Use Password Check here to have the user enter a password at login. When 
checked, the Password and Confirm Password fields are 
enabled. If it was already checked, the entered password is 
currently in use.

Password If Use Password is checked, enter a password for the user to 
enter at login.

Confirm Password Enter the password a second time to confirm that it was 
entered correctly.

Administrator Check here to make the user an administrator. If it was 
already checked, the user currently has Administrator 
privileges.

Group List Select the group(s) to which the user will belong and click the 
Add button, or double-click the group. The group is moved to 
the Selected Groups box.

Selected Groups Displays the groups to which the user belongs. To remove 
the user from a group, select the group and click the 
Remove button, or double-click the group. 

   Note

Set the minimum length for a password in the Policy 1 tab, if passwords are used.
Click the OK button after editing the user properties, and the "User Property" dialog 
box is closed.



2  Basic Operation
2.9 Common Operations

75GCMS-QP2010

4. The Groups tab displays a list of all entered groups. Select a group to display the 
rights authorized for that group. To create a new group, click the Add button. The 
"Add Group" dialog box is displayed.

Figure 2.59  "Add Group" Dialog Box

Enter the following information for each new group.

Click the OK button after setting up the group, and the "Add Group" dialog box is closed.

To delete a group, select the appropriate group in the Groups tab and click the Remove 
button.

To display the properties for a group, select the appropriate group in the Groups tab and 
click the Properties button. The "Group Properties" dialog box is displayed.

Property Description

Group Name Enter a name for the new group.

Description Enter a brief description of the new group.

Right List Select the Right(s) to which the group will have authorization 
and click the Add button, or double-click the Right. The Right 
is moved to the Selected Rights box.

Selected Rights Displays the Rights to which the group has authorization. To 
remove a Right, select it and click the Remove button, or 
double-click the Right. 
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Figure 2.60  "Group Properties" Dialog Box

The following properties are displayed for each group.

Click the OK button after editing the group properties, and the "Group Property" dialog box 
is closed.

Property Description

Group Name Displays the name of the selected group.

Description Displays a brief description of the selected group.

Right List Select the Right(s) to which the group will have authorization 
and click the Add button, or double-click the Right. The Right 
is moved to the Selected Rights box.

Selected Rights Displays the Rights to which the group has authorization. To 
remove a Right, select it and click the Remove button, or 
double-click the Right. 
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5. The Event Log tab displays the history of all changes and actions made in User 
Administration. To use the log with other applications or GCMSsolution function, save 
it as a text file by clicking the Save As Text button. The "Convert Event Log" dialog 
box is displayed.

Figure 2.61  "Convert Event Log" Dialog Box

Select a directory, enter a file name, and click the Save button to save the file. Refer 
to Section 2.9.2 "Opening and Saving Files", page 63 for more information.

To delete the Event Log, click the Clear All Events button. A confirmation message 
is displayed. Click the Yes button to clear the log.

6. Enter general User Administration parameters using the Policy1 tab.
Settings on this page can be performed only by users with rights assigned by the 
system administrator. 

Figure 2.62  System Administration Policy1 Tab
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Parameter Description Default

Normal Login Checked The user name must be entered at login.

Unchecked The "Login" dialog box contains a combo box that lists 
all of the entered users, and the user name can be 
selected. By default, the user name that was last 
logged in is displayed.

Unchecked

Multi User Unchecked Only one user may be logged in at a time. After logging 
in, the GCMSsolution applications are launched without 
displaying the "Login" dialog box.

Unchecked

Checked Multiple users can be logged into the GCMSsolution 
software simultaneously. Each time a GCMSsolution 
application is launched, the "Login" dialog box is 
displayed.

Login with Windows 
Username

Available only in the single user mode. The log-in user 
name for Windows is searched at the start-up of 
GCMSsolution, and if the same user name is registered 
for GCMSsolution, the "Login" dialog box is skipped 
upon users' login.

Unchecked

Password Minimum 
Length

Specifies the minimum length of valid passwords from 1 
to 8 characters.

1

Valid Specifies the validity period of passwords from the time 
of their creation or alteration. When "0" is set, 
passwords are permanently effective.

0

Passwords must meet 
complexity requirements

When selected, passwords consisting of alphabet characters only or 
numerals only are no longer available. Use a combination of alphabet 
characters and numerals for passwords.

Unchecked

Lockout Settings (for PC) If failed login attempts exceed the number specified upon completion 
of the lockout settings, any user becomes unable to login from that 
PC for the specified time.

—

Login Attempt Limit If login attempts fail more than the set value, the PC to which logins 
are attempted becomes locked out, and no further login operation will 
be accepted for the time period set in "Lockout Duration".
Specifies the limit of failed login attempts using the [ ] [ ] buttons on 
the right or entering a value directly. When "0" is set, no limit will be 
imposed.

0

Lockout Duration Enter the time duration to lock out the PC when login attempts fail 
more than the set value of "Login Attempt Limit". When "0" is set, 
there will be no PC lockouts.

0

Lockout Settings (for User) If a user's failed login attempts exceed the number specified upon 
completion of the lockout settings, that user on the network becomes 
unable to login for the specified time. 

—

Login Attempt Limit If login attempts fail more than the set value, the user who attempted 
logins becomes unable to login for the time period set in "Lockout 
Duration".
Specifies the limit of failed login attempts using the [ ] [ ] buttons on 
the right or entering a value directly. When "0" is set, no limit will be 
imposed.

0
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7. The Policy2 tab is used for additional user administration settings.
Settings on this page can be performed only by users with rights assigned by the 
system administrator.

Figure 2.63  System Administration Policy2 Tab

Lockout Duration Enter the time duration to lock out the user when login attempts fail 
more than the set value of "Login Attempt Limit". When "0" is set, the 
user will not be locked out.

0

# of Levels for Duplicate 
Password Checking

Prohibits assigning a password which has already been used within 
the specified times of the recent password change recorded in the 
history. Setting this parameter to "0" will cancel the duplication check.

0

All users must use 
password

When selected, any user without a password must set one the next 
time they open the "User Property" box. 

Unchecked

   Note

If "SHIMADZU User Authentication Tool" is set in the "User Authentication Mode 
Select" window at the installation of the GCMSsolution, the policy setting range is 
determined according to "SHIMADZU User Authentication Tool".

Parameter Description Default

   Note

If the length of time for which a password is valid has been exceeded, a message is 
displayed instructing the user to change the password. Click the OK button to 
display a dialog box for changing the password.
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Setting Item Description Default

Audit Trail Apply audit trail function when 
creating method file

This forces audit trail settings to be used when a 
new method is created. It is the same when a new 
method is created by selecting a template.

Unchecked

Prohibit editing parameters on 
instrument

Prevents the user from changing the instrument 
parameters in the method file. The parameters can 
be changed in the instrument monitor.

Unchecked

Report Prohibit multiple files in output 
report

Prevents loading and printing of files for individual 
items in the report item Properties File tab.

Unchecked

Output report type in header Prints in the header the type of application from 
which the report is output.

Unchecked

Output data status in header Print the data status in the header. Unchecked

Output security level in header Print the security level in the header. Unchecked

File 
Management

Prohibit data file overwrite The file name must be changed when saving to an 
existing data file during single run and batch run 
analyses. In the GCMS postrun analysis screen, an 
existing data file cannot be overwritten.

Unchecked

Prohibit method file overwrite In the GCMS analysis and GCMS post analysis 
data acquisition screen and calibration curve 
screen, an existing method file cannot be 
overwritten.

Unchecked

Prohibit report file overwrite In the report generation screen of all the 
applications, an existing report file cannot be 
overwritten.

Unchecked

Prohibit batch file overwrite In the batch table screen of all the applications, an 
existing batch file cannot be overwritten.

Unchecked

   Note

These settings are stored in the "SysAdmin.mdb" database file in the system folder 
(normally, in C:\GCMSsolution, under a standard installation). In addition, the 
screen color setting. etc., for individual users are stored in the "SysAdmin.upf" 
found in the same folder.
As a safety contingency for unexpected accidents or errors, it is recommended that 
you backup these files.
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2.9.6 Templates

If method, batch, or report format files are expected to have similar parameters, templates 
for each type of file may be created to save time and prevent errors in parameter settings.

1. Creating a Template
Although the procedure below describes how to make a method file template, it 
applies to batch and report format templates as well.

(1) Enter the method parameters to be included in the template. Select File > Save 
Method As Template. The "Save As Template" dialog box is displayed. 

Figure 2.64  "Save As Template" Dialog Box

(2) Enter a name for the template in the New Template text box, and click the OK button. 
If a template with that name does not exist, the template is saved. If a template with 
the same name does exist, a confirmation message is displayed to verify overwriting 
the existing file. Click OK to overwrite the file and save the template.
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2. Generating New Files from Templates
Although the procedure below describes how to generate a new method file from a 
template, it applies to batch and report format files as well.

(1) Select File > New Method File to open the "File New" dialog box.

Figure 2.65  "File New" Dialog Box

(2) Select the Use Template radio button, and select which template to use from the list 
box. Click the OK button. The new file, created from the content of the template, is 
displayed.

Figure 2.66  "Setting Options" Dialog Box
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(3) Click the Create from Template option button, select the appropriate template from 
those listed in the list box, and then click OK.
The contents of the template are reflected in the newly created file, and the edit 
screen is displayed.

   Note

Select the New File radio button if the new file should not include content from the 
template.



2  Basic Operation
2.9 Common Operations

84 GCMS-QP2010

This page is intentionally left blank.



3.13.

85GCMS-QP2010

3  Data Acquisition

3.1 Overview

This section describes the windows and functions associated with data acquisition.

3.1.1 "Method Development Acquisition" Window

Figure 3.1  "Method Development" Window

This screen layout is displayed when Method > Instrument Parameters is selected. It can 
also be displayed by clicking the Method Development icon in the Assistant Bar, or the 
Data Acquisition Param toolbar button. This layout is stored for each user when the "Real 
Time Analysis" window is closed. 
The items in this screen are described in the following table.

Sampler Tab
GC Tab

MS Tab
Chromatogram and 
Spectrum View Title Bar Toolbar

Assistant Bar Output Window Instrument Method View
Instrument Monitor

Menu Bar
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"Method Development Acquisition" Window

3.1.2 "Data Acquisition" Window

Figure 3.2  "Data Acquisition" Window

Title Bar Displays currently operating application names, process 
names or method file names.

Menu Bar Displays various command menus for the displayed window.

Toolbar Displays buttons for the various command tools for the 
displayed window.

Assistant Bar Lists command icons corresponding to the general operation 
sequence. Ordinarily, the respective operation is selected by 
clicking these icons.

Chromatogram/Spectrum View Displays real time data that has been transferred from the 
detector during data acquisition.

Instrument Method View Parameters to be used during data collection are set for each 
unit of the instrument. To modify the parameter settings, click 
the tab corresponding to the unit.

Instrument Monitor Displays various instrument parameters in real time. Used to 
determine whether the instrument is ready to initiate analysis.

Title Bar Menu Bar Toolbar Chromatogram and Spectrum View

Assistant Bar Output Window Instrument Monitor
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This screen layout is displayed when Data Acquisition is selected from the Assistant Bar, 
or when Instrument Parameters is deselected from the Method menu or toolbar. The 
method development mode is exited when the check does not appear next to the 
Instrument Parameters menu item and the Data Acquisition Param toolbar button is not 
inverted. This layout is stored for each user when the "Real Time Analysis" window is 
closed. 

3.1.3 Assistant Bar

This section describes the various icons displayed in the Acquisition Assistant Bar during 
data acquisition.

Title Bar Displays currently used application names or process names 
and method file names.

Menu Bar Displays various command menus of the displayed window. 
Toolbar Displays buttons for the various command tools for the 

displayed window.
Assistant Bar Lists command icons corresponding to the general operation 

sequence. Ordinarily, the respective operation is selected by 
clicking these icons.

Chromatogram/Spectrum 
View

Displays real time data that has been transferred from the 
detector during data acquisition.

Instrument Monitor Displays various instrument parameters in real time. Used to 
determine whether the instrument is ready to initiate analysis.

Top Returns to the Real Time Assistant Bar.

Instrument 
Method Wizard

Sets instrument parameters for GC, MS, and autosampler used 
for analysis.

Sample Login Used for single runs to assign a file name to the data file 
obtained by data acquisition, select a vial number and 
determine whether to print a report.

Standby Downloads the parameters set in the Instrument Parameters 
view to the instrument, and places the instrument in ready 
mode, so that data acquisition can be initiated.

Start Initiates data acquisition. The retention time is displayed, and 
the chromatogram or spectrum is displayed in real time.

Stop The MS operation is halted. The GC temperature elevation 
program and the GC time program continue. The GC operation 
is stopped if the STOP button on the GC instrument is pressed.

Instrument 
Parameters

Display instrument parameters. On/off can be selected.

Snap Shot GCMS post run analysis is displayed and MS data from the start 
of data acquisition to the clicking the Snap Shot button can be 
examined.

Guide Describes the procedure of data acquisition.
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3.1.4 Overall Data Acquisition Process

The data acquisition process is performed as described below.

Develop Method

In method development, the instrument parameters of the GC, MS and 
autosampler are set. When a method has been previously constructed, 
the content of the method file is checked See Section 3.2 "Method 
Development Parameters", page 90.

Login Sample
The sample name, sample ID, the data file name, and other 
information is entered for a single sample. See Section 3.3 "Single 
Run Setup", page 104.

Inject Sample 
and Acquire 
Data

The system is prepared for data acquisition, and the sample is 
introduced manually or automatically. See Section 3.4 "Data 
Acquisition", page 107. During data acquisition, acquired data can be 
analyzed. See Section 3.4.3 "Data Analysis", page 108.

Analysis

Acquired data is saved and analysis is completed. For subsequent 
data processing, refer to Chapter 4 "Qualitative Analysis" on page 111, 
Chapter 5 "Quantitative Analysis" on page 137 and Chapter 6 
"Generating Custom Reports" on page 165. The tasks of data 
acquisition through analysis may also be performed automatically. 
Refer to Chapter 7 "Continuous Analysis" on page 175.
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Figure 3.3  The Data Acquisition Process

Data File Method File Processing (Assistant Bar)

Save

Method 
Development

Data 
Acquisition

Sample 
Login
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Start

End

Quantitative/Qualitative 
Processing
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Application

Save

Data 
Collection

Settings

Data 
Analysis

To GC/MS Postrun 
Application
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3.2 Method Development Parameters

This section describes how to develop a Method using the parameters in the "Acquisition" 
window. When a method is saved as a method file, consistent analysis results can be 
obtained by using the same method.
Perform system configuration using the GCMS Real Time Analysis application before 
creating a method. A method can be created in Instrument Parameters or by using the 
Method Wizard.

3.2.1 Instrument Parameters

Click the Method wizard icon in the Assistant bar to open the Method wizard window.
(1) Sampler

Displayed when the AOC is selected in system configuration. Refer to Section 3.2.2 
"Sampler (Autosampler) Tab", page 91 for parameters and settings. Click the Next 
button to continue.

(2) GC Parameters (1)
Displayed when the GC is selected in system configuration. Refer to Section 3.2.3 
"GC Parameters (GC Tab)", page 93 for parameters and settings. Click the Next 
button to continue.

(3) GC Parameters (2)
Displayed when the GC is selected in system configuration. Refer to Section 3.2.3 
"GC Parameters (GC Tab)", page 93 for parameters and settings. Click the Next 
button to continue.

(4) MS Parameters (1)
Displayed when the MS is selected in system configuration. Refer to Section 3.2.4 
"MS Parameters (MS Tab)", page 97 for parameters and settings. Click the Next 
button to continue.

(5) MS Parameters (2)
Displayed when the MS is selected in system configuration. Refer to Section 3.2.4 
"MS Parameters (MS Tab)", page 97 for parameters and settings. When the setting is 
finished, click the OK button. The "Instrument Method Wizard" window closes and a 
method file is created. If additional settings are required, edit the GC and MS tabs in 
the "Instrument Parameter" window.
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3.2.2 Sampler (Autosampler) Tab

Select View > Instrument Parameters > Sampler tab. The Sampler tab is displayed.

Figure 3.4  Instrument Parameters Sampler Tab

Data acquisition and analysis can be performed with the default values. Refer to the table 
below when more detailed settings are desired.

Parameter Description Unit Range Default

# of Rinses 
with Solvent 
(Pre-run)

Specifies the number of times the syringe is rinsed with 
solvent before injection.
When Solvent Flush is selected as the injection mode, this 
setting is not available.

0 - 99 0

# of Rinses 
with Solvent 
(Post-run)

Specifies the number of times to rinse the syringe with solvent 
after injection into the gas chromatograph. Change this 
setting when a different type of sample is to be injected, or 
when the same sample is injected multiple times.

0 - 99 1

# of Rinses 
with Sample

Specifies the number of times the syringe is rinsed with 
sample before injection. Change this setting when a different 
type of sample is to be injected, or when the same sample is 
injected multiple times.

0 - 99 2

Plunger 
Speed 
(Suction)

Specifies the plunger speed when aspirating a sample.
This speed applies to sample aspiration for sample rinsing 
and for sample injection. For pumping and solvent rinses, the 
aspiration speed is always High speed.

High, Middle, 
Low

High

Viscosity 
Comp. Time

Specifies the wait time between aspiration and injection. Low 
viscosity liquids are drawn up into the syringe simultaneously 
with the plunger. A longer wait time should be specified if high 
viscosity liquids are used.

sec. 0 - 99.9 0.2
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Figure 3.5  "Injection Mode" Dialog Box

Plunger 
Speed 
(Injection)

Selects the speed of the plunger during sample injection. This 
is not the speed at which the syringe descends into the 
injection port.

High, Middle, 
Low

High

Syringe 
Injection 
Speed

Selects the speed at which the syringe descends into the 
injection port.

High, Low High

Injection 
Mode

Selects Normal or one of the Solvent Flush modes for the 
injection. Press the Set button to change the injection mode.

0

Advanced Allows making more detailed settings.

Injection 
mode

Sets the injection mode. Setting is performed by clicking on 
the Setting... button to open the "Injection Mode" window. 
Select from among the following 5 options.

0 - 4
3: Can be 
selected when 
equipped with 
AOC-20s.
4: Can only be 
selected when 
equipped with 
AOC-20s.

0

0: Normal injection (Sample only)

1: Sample + air + solvent

2: Sample + solvent

3: Sample + air + Standard + air + solvent

4: Sample + Standard + solvent

When an injection mode other than normal injection is selected (i.e. solvent flush mode), select 
one of the following two options to set number of number of solvent rinses prior to sample injection.
Same as number of sample rinses prior to injection
Same as number of solvent rinses after injection
After making the setting, click the OK button to complete the settings.

Parameter Description Unit Range Default
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3.2.3 GC Parameters (GC Tab)

This section describes how to set the parameters for the gas chromatograph.
Select View > Instrument Parameters > GC tab. The GC tab is displayed.

Figure 3.6  Instrument Parameters GC Tab

   Note

When the Advanced button is selected, more detailed autosampler parameters are 
provided. Refer to GCMS Help for further information on specific parameters.

   Note

The Control Mode parameter determines which Carrier Gas parameters will be 
displayed. The Carrier Gas parameters include Column Inlet Pressure, Column 
Flow, Linear Velocity, Split Ratio, Total Flow, and Carrier Gas Flow. Pressure and 
flow control parameters cannot be set for an instrument that does not have an 
electronic flow rate controller.

   Note

If the wide bore column (internal diameter 0.53 mm) is used, the flow rate control 
range at low oven temperature is narrowed, and may cause a flow rate control error 
at the GC. Care must be taken when setting the flow, using the following guidelines.
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Control Ranges (using full volume injection with column I.D. 0.53 mm, length 30 m)

Depending on the flow rate, an error may be generated when the oven temperature is 
lowered even if it is running normally at a higher temperature.

Oven Temperature (ºC) Flow Rate Setting Range (mL / min)

50 10 - 15

100 7 - 15

150 6 - 15

200 4 - 15

Parameter Description Unit Range Default

Column Oven Temp. Specifies the temperature of the column oven. °C –99 - * 50

Injection Temp. Specifies the injection port temperature. °C –99 - * 25

Injection Mode Selects the injection mode. This parameter is not 
displayed for OCI/WBI.

Split/
Splitless/
Direct

Split

Sampling Time If Splitless is selected as the Control Mode, the 
Sampling Time parameter specifies the interval 
between the time of sample injection and the time 
at which the split flow path is opened.

min. 0 - 9999.99 1

Flow Control Mode Selects the control mode of carrier gas flow. Flow 
can not be selected when the injection mode is 
Split or Splitless.

Flow/Linear 
Velocity/
Pressure

N/A in 
Split 
mode

Pressure This parameter is disabled when Direct is selected 
in the Injection Mode and Flow is selected in the 
Flow Control Mode.

kPa 0 - 970 100 kPa

kgf/cm2 0 - 9.89

psi 0 - 140.7

Total Flow Total Flow = Column Flow + Split Flow + Purge 
Flow. The value is held constant during the 
programmed temperature gas chromatography. 
This parameter is disabled when Direct is selected 
in the Injection Mode and Linear Velocity or 
Pressure is selected in the Flow Control Mode.

mL/min 0 - 1200 50

Column Flow Displays the rate of volumetric flow inside column. 
The Column Flow is automatically calculated from 
the Column Inlet Pressure. 
When the Model is set to "Dual TMP" in the 
System Configuration window, it is recommended 
that the Column Flow parameter be set to 15 mL/
min or below. It is also recommended that this 
parameter be set to 2 mL/min or below for Single 
TMP models. This is because an insufficient 
degree of vacuum is obtained when exceeding 
these values, and may have a bad influence on 
ion generation.

mL/min
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Linear Velocity Displays the linear velocity. Linear velocity is 
automatically calculated from the Column Inlet 
Pressure.

cm/sec

Purge Flow Specifies the purge flow. Disabled in the case of 
No Purge APC.

mL/min 0.0 - 1200

Split Ratio Specifies the split ratio or the ratio of the column 
flow to the split flow. When a split ratio is set, the 
system sets the total flow rate based on the 
calculated carriergas flow rate, so that the desired 
split ratio occurs at the oven temperature. Set the 
split ratio to –1.0 to fix the total flow rate 
regardless of the oven temperature. This 
parameter is disabled when Direct is selected in 
the Injection Mode parameter.

–1,
0 - 120000

–1

Detail of Injection 
Port

Opens the "Detail Setting of Injection Port" 
window. Characters appear in black when details 
are set. This parameter is disabled for WBI.

Program Allows the entry of time program steps. Item to be 
programmed (oven temperature, pressure, and/or 
flow rate) can be selected from the drop-down list.

Oven 
Temperature, 
Flow, 
Pressure, 
Purge Flow

Rate The ratio of increase or decrease for a 
temperature, pressure and flow rate program, 
expressed in incremental units.

Temp./Pressure/
Flow

The temperature, pressure, or flow value in a 
program.

Hold Time The amounts of time to maintain a temperature, 
pressure, or flow rate in a program.

min 0 - 9999.99

Column Displays the column related parameters set in 
System Configuration. To change these 
parameters, click the Set button in the column 
section.

Automatic Zero 
Correction after 
Ready

Performs the zero correction automatically when 
the instrument is ready. For detectors other than 
MS.

CRG (Oven) Uses CRG for the column oven. This parameter is 
displayed when CRG (Oven) is checked in the 
Option tab in GC2010 / System Configuration 
window.

CRG (INJ) Uses CRG for cooling of the injection port.This 
parameter is displayed when CRG (INJ#2) is 
checked in the Option tab in GC2010 / System 
Configuration window.

* Refer to GCMS Help for upper limits.

Parameter Description Unit Range Default
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To change the parameters for a time-controlled GC during data acquisition, create a time 
program. Click the GC Program button to open the "GC Program" dialog box.

Figure 3.7  "GC Program" Dialog Box

A pre-run program is a time program that controls the operation of various units prior to 
analysis.

A run-time program is a time program that controls the operation of various units during 
analysis. 

Parameters Description Units Range

Time (min) Enters the retention time at which to perform the 
command.

min. 0 - 655

Device Selects the unit to be used from the list in the combo 
box. Devices are defined in the Instrument Configuration 
menu.

Event Select the appropriate command.
Refer to GCMS Help for more information.

Setting Enters a value that corresponds with the selected device 
and event. Refer to GCMS Help for more information.
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3.2.4 MS Parameters (MS Tab)

This section describes the parameters for the MS. Select the Method > Instrument 
Parameters > MS tab to view the MS parameters.

Figure 3.8  Instrument Parameters MS Tab

Data acquisition and analysis can be performed with the default values. Refer to the table 
below when more detailed settings are desired.

   Note

When the Load Chromatogram button of the "GC Program" dialog box is selected, 
the "GCMS Data File Open" dialog box opens, and the TIC can be read from an 
existing data file. Click the chromatogram while one of the Time (min) fields is 
selected to enter that retention time into the selected Time (min) field.
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Parameter Description Unit Range Default

Temperature Enters the temperature of the ion source. ºC 100 - 260 Values from 
System 
Configuration

Interface 
Temperature

When GC is connected, temperature of the GC heat 
port connected to MS is definable. When GC is not 
connected, interface temperature appears in gray.

ºC 0 - * 25

Solvent Cut 
Time 

Sets the time to turn on the filament once the solvent 
elutes after sample injection.
Normally, when the sample is injected, a large quantity 
of solvent is introduced into the analysis system. This 
results in a sharp decrease in the vacuum inside the ion 
source, which has a detrimental effect on the filament 
and other components. To prevent this, the filament is 
turned OFF while the solvent is passing through the 
analysis system.
Note: When analyzing a sample with peaks that elute 
before the solvent, use an MS program to turn the 
filament ON and OFF.

min. 0 - 9999.9 2.00

Detector 
Voltage

Sets the detector voltage.
Selecting the radio button determines whether to 
handle the setting in the Edit box as an absolute value 
or as a relative value. When "Absolute" is changed to 
"Relative," the gain is set to 0.
Absolute: Used when directly setting the voltage.
Relative to the Tuning Result: Used when setting an 
absolute value from the voltage in the tuning file to be 
used. Positive (+) and negative (-) symbols may be 
used.
Caution: Note that when the voltage is set at a high 
value, a larger number of ions will be detected and the 
detector could be damaged. However, as the 
instrument ages and sensitivity drops, the detector 
voltage can be gradually increased.

kV Abs: 0.50 - 3.00
Rel.: -2.50 - 2.50

Rel. 0

Threshold Sets the noise threshold level. Ion signals below this 
value will be treated as noise and deleted from the data. 
This parameter is setable when Scan is selected in 
Acquisition Mode.

count 0 - 9999 1000
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Use MS 
Program

Specifies whether to use an MS program. When 
checked, the Set button is enabled.

Micro Scan 
Width

Sets the scan width when performing micro scan 
measurement. The Setting range is (0.00 to 1.00). 
When set to "0," micro scanning is not performed.
About Micro Scan Measurement: In SIM analysis, data 
is collected with the MS control fixed at a set m/z value. 
Micro scanning is a measurement method that collects 
data with the MS scanning over a minute range. 
Improved reproducibility can be expected in the 
analysis data when this method is used.

amu 0.00 - 1.00 0

* Refer to GCMS Help for upper limit.

Parameter Description Unit Range Default



3  Data Acquisition
3.2 Method Development Parameters

100 GCMS-QP2010

The parameters below differ, depending on whether the Acquisition Mode is Scan or SIM.

Scan Parameters

Figure 3.9  Scan Parameters

SIM Parameters

Figure 3.10  SIM Parameters

Parameter Description Unit

Start Time Sets the data acquisition start time. min.

End Time Sets the data acquisition end time. min.

Acquisition mode Selects scan.

Event Time Sets the interval for a single scan. Sec.

Start m/z Sets the starting mass range m/z. u

End m/z Sets the ending mass range m/z. u

Scan Speed Sets the speed at which scanning is performed in the specified 
m/z range. This will be automatically selected and displayed 
from the possible settings according to the measurement m/z 
range and the Event Time. A smaller value (slower scan) 
reduces the noise in the data.

Parameter Description Unit

Start Time Sets the data acquisition start time. min.

End Time Sets the data acquisition end time. min.

Acquisition mode Selects SIM.

Event Time Sets the interval for a single scan. Sec.

Ch1-m/z - Ch64-m/z Sets the m/z for each channel. u
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FASST (Fast Automated Scan/SIM Type) Paramenters

Figure 3.11  If both Scan and SIM are selected.

If the Start Time and End Time are set to the same time respectively in successive two rows, 
the data of the two rows are acquired every Event Time one after the other. In this case, the 
first row is called Event 1, and the second row Event 2.
The Group number is displayed in the left column of the table. If  two events are set for a 
group, the Group number is displayed in the row of Event 1 only. The event number and 
group number for each row is displayed in the top left of the table as "Group Number-Event 
Number".
The maximum number of events for a group is 2. Set the Acquisition mode for Event 1 to 
Scan, and SIM for Event 2.

For details, see FASST Measurement Operation Manual.

To change the MS parameters during data acquisition, use a time program. Select the Use 
MS Program check box, and then click the Set button to open the "MS Program" dialog box. 

   Note

Up to 128 groups can be set.
However, with a version of GCMSsolution earlier than version 2.40, if a method file 
containing more than 65 groups is opened, it may not run normally. If the instrument 
parameters of a data file with more than 65 groups are displayed, it will not run 
normally. It will not be able to display chromatograms for groups after the 65th 
group.
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Figure 3.12  MS Program "Dialog Box"

Enter the parameters into the MS Program table as described below.

Parameter Description Unit Range

Time (min) Specifies the retention time at which to perform the command. min.

Command Selects a command to execute during data acquisition. Click the 
desired cell, and the cell becomes a combo box. Select a command 
from the combo box.

DetectorVolts= Changes the detector voltage at the specified 
time.

kV 0.50 - 3.00

FilamentON Turns on the filament at the specified time. No value.

FilamentOFF Turns off the filament at the specified time. No value.

PFTBAOpen Opens the standard (PFTBA) solenoid valve at 
the specified time.

No value.

PFTBAClose Closes the standard (PFTBA) solenoid valve at 
the specified time.

No value.

Reagentgas1Open Opens the reagent gas1 solenoid valve. No value.

Reagentgas1Close Closes the reagent gas1 solenoid valve. No value.

Reagentgas2Open Opens the reagent gas2 solenoid valve. No value.

Reagentgas2Close Closes the reagent gas2 solenoid valve. No value.

Value Specifies a value for Command parameters that require one.
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   Note

When the Load Chromatogram button of the "MS Program" dialog box is selected, 
the "GCMS Data File Open" dialog box opens, and the TIC can be read from an 
existing data file. Click the chromatogram while one of the Time (min) fields is 
selected to enter that retention time into the selected Time (min) field.
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3.3 Single Run Setup

This section explains how to set the parameters for a single run, including sample name, 
sample ID, data file name, and sampler parameters, if used.

3.3.1 "Sample Login" Dialog Box

Select the Sample Login icon of the Data Acquisition Assistant Bar. The "Sample 
Login" dialog box opens.

Figure 3.13  "Sample Login" Dialog Box

Sample Name Specifies the name of the sample. The name is used for identifying data 
files and is output on reports.

Sample ID Specifies the ID number or lot number of the sample. It is useful to set this 
item since it can be used as a search parameter for the data file. It can be 
changed during data acquisition. Up to 31 characters may be entered.

Data File Specifies the filename for saving the acquired data.
The file extension is automatically added. The path of the file when only the 
name was entered results in the same path as the method file opened upon 
Data Acquisition.

Base Line Data Sets a data file name for differential chromatogram (base line 
chromatogram). This field is only used when GC detector is used.

Data Description Specifies comments to be registered in the datafile.
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The "Select Data File" dialog box opens when the Folder button to the right of the 
text field is clicked. Select a directory in which to save the data and enter the file 
name.

Figure 3.14   "Select Data File" Dialog Box

Sampler Parameters (See Figure 3.13  "Sample Login" Dialog Box)

   Note

If the "Sample Login" dialog box is used to analyze a sample multiple times, or if the 
file name that has been entered is the same as an existing file, confirm whether to 
overwrite the file when the analysis begins. Add a number to the file name and use 
the automatic increment function in a batch table to avoid overwriting data. Check 
for duplicate file names prior to initiating data acquisition.

Vial # Specifies the position occupied by the vial in the autosampler.

Injection Volume Specifies the amount of sample to inject. This volume is injected the 
number of times set in Multi Inj. Times.

Multi Inj. Times Specifies how many times to inject the sample.

Tuning File If the Tuning File field is left blank, the tuning file either used during the last 
data acquisition or saved during the last tuning is used. The path of the file 
when only the file name is entered is GCMSsolution\System\Tune#. (# is 
the system number; GCMSsolution is the folder specified during the 
installation.)

Syringe Capacity Verifies the syringe capacity specified in System Configuration. Note that 
this parameter cannot be edited from the "Sample Login" dialog box.

Report Selects the printing of a report after data acquisition is completed. Enter 
the full file name of the report format file to be used to print the report, or 
click the File Folder button to browse for the file. The "Select Report 
Format File" dialog box is displayed. Select the file, and click the Open 
button. The full path is now displayed in the Report text box. The path of 
the file when only the name was entered results in the same path as the 
method file opened upon Data Acquisition. 
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The "Select Report Format File" dialog box opens when the Folder button to the 
right of the Report text field is clicked. Open the directory in which file is saved, and 
select the file name.

Figure 3.15   "Select Report Format File" Dialog Box

For a description of the Sample Login Advanced parameters, refer to GCMS Help.
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3.4 Data Acquisition

This section describes instrument preparation and data acquisition. During acquisition, real 
time data is displayed, and upon completion, it is saved as a data file.

3.4.1 Standby

During Standby, the method is downloaded to the instrument and the instrument is prepared 
for analysis.

Select the Standby icon on the Data Acquisition Assistant Bar.

3.4.2 Start

Select the Start icon in the Data Acquisition Assistant Bar. Acquisition and analysis 
are performed as specified in the selected method.

The real time spectrum and chromatogram are displayed.

   Note

When the Standby icon is selected, and the method has not been saved, a dialog 
box is displayed to prompt the user to save the method.
To save the method, select the Yes button. If the method has been saved 
previously, the old method file is overwritten with the new information. If the method 
has not been saved, the "Save Method File As" dialog box is displayed. Select a 
directory, enter a filename, and click the Save button. The method is then 
downloaded to the instrument.
To download the method to the instrument without saving it, select the No button. 
The method is downloaded to the instrument.
To abort the method download, select the Cancel button.

   Note

Selecting the Start button on the GC unit can also start data acquisition, whether an 
autosampler is used or not.
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3.4.3 Data Analysis

During data acquisition, the acquired data is written to the data file. If the GCMS 
Postrun Analysis application is launched by selecting the Snap Shot icon in the 
Data Acquisition Assistant Bar, the acquired data is displayed.

3.4.4 Stop

Data acquisition and analysis may be stopped during a run. Select the Stop icon in 
the Data Acquisition Assistant Bar.

   Note

For more information about the GCMS Postrun Analysis application, refer to 
Chapter 4 "Qualitative Analysis" on page 111 and Chapter 5 "Quantitative Analysis" 
on page 137.

   Caution

If data acquisition and analysis are stopped with the Stop command, the MS program 
stops immediately, but the GC temperature program does not stop until the sample is 
processed. This prevents leaving sample residue in the column. To stop the GC 
immediately, press the Stop button on the GC unit.
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3.5 Instrument Monitor

In this section, procedures for monitoring the current status of the instrument are described. 
Click the Detail button in the Instrument Monitor section to set values and initialize use time 
for consumable parts.

3.5.1 Instrument Monitor

Figure 3.16  Instrument Monitor

Items Description

GC, MS, HS Appears in different colors depending on the current status of GC, 
MS, HS. Refer to GCMS Help for more information.

Units Select the radio button for Line 1 or Line 2 to display the information 
corresponding to that unit. These buttons are only displayed if 2 lines 
are connected.

Vacuum Indicates vacuum with a graph. Triangle indicators move according 
to actual values.
When the Ion Gauge is set to "None" in the System Configuration 
window, high vacuums are not displayed.

GC Consumables, MS 
Consumables

The background color of the icons changes to indicate maintenance 
or replacement is required.

Other Parameters To set other parameters, click the Detail... button and open the 
"Instrument Monitoring Details" window. For each parameter, refer to 
GCMS Help.
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4  Qualitative Analysis

4.1 Overview

This section explains how to use the GCMS Postrun Analysis application for performing 
qualitative analysis on previously acquired data and printing reports.

4.1.1 "Qualitative Data Analysis" Window

Figure 4.1  "Qualitative Data Analysis" Window

Data Explorer Title Bar Menu Bar Toolbar Chromatogram View

Assistant Bar Spectrum View

Title Bar Displays the name of the application, user, active window, and file.

Menu Bar Displays the menus that are available in the active window.

Toolbar Displays the command buttons that are available in the active window.

Assistant Bar
Displays the command icons that apply to a specific function or window. To 
open the window or activate the command, click the appropriate icon.

Data Explorer
Displays all files by type, including Data, Method, Report Format, Batch, 
and All Files. Data can easily be opened for analysis by double clicking the 
file icon or dragging it to the appropriate location.

Chromatogram 
View

Displays the chromatogram from the current data file. All of the acquired 
data is displayed in the upper TIC window. The TIC, MIC and MC are 
displayed in the lower MC window.

Spectrum View Displays the mass spectrum for the current retention time.
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4.1.2 Qualitative Analysis Procedures

Procedures for qualitative analysis are described below.

1. Viewing Acquired Data
Open GCMS Postrun Analysis, and click the Qualitative Analysis icon in the 
Assistant Bar.
The "Data Analysis" window is displayed in qualitative analysis mode.
Click the Data tab of the Data Explorer, and double-click the 
appropriate data file. 
The acquired data is displayed in the Chromatogram View.

Figure 4.2  Chromatogram View

Method 
Development

The instrument parameters for the GC and MS, and the qualitative, 
quantitative, data view, and QA/QC parameters, are set in the 
method file. Create a new method file using GCMS Real Time 
Analysis, or use an existing method file after verifying its contents. 
For more information about method development, see Section 3.2 
"Method Development Parameters", page 90.

Sample Injection 
and Data 
Acquisition

Data is acquired in GCMS Real Time Analysis. Enter information 
about single samples in the "Data Acquisition" window, or enter 
information about multiple samples in the "Batch Processing" 
window. Initiate single or batch processing. For more information 
about data acquisition, refer to Section 3.3 "Single Run Setup", 
page 104 and Section 3.4 "Data Acquisition", page 107.

Data Analysis
Open GCMS Postrun Analysis, and click the Assistant Bar 
Qualitative Analysis icon. This chapter describes performing 
qualitative analysis and reporting.
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2. Peak Integration
Peaks must be integrated before spectra can be chosen for similarity searches. 
Peaks can be integrated manually or automatically. Refer to Section 4.3 "Peak 
Integration", page 118.

3. Similarity Search
The Similarity Search tries to match spectra from the integrated peaks to spectra 
belonging to known compounds in the library file. Candidates with varying degrees of 
similarity are displayed for each spectrum in a list. Select a candidate to identify a 
component of the sample by comparison between the known compound and sample 
spectra. Refer to Section 4.4 "Similarity Search", page 130.

4. Printing a Qualitative Report
Using a similarity search, the target compound is compared with candidates from the 
library; three types of reports about the candidates found by the search can be 
printed. Refer to Section 4.5 "Printing Results", page 134.
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4.2 Spectrum Display

This section explains how to display the mass spectrum for any retention time on a 
chromatogram.

4.2.1 Displaying the Spectrum

1. To display a spectrum that corresponds to a specific retention time, double-click at 
the appropriate position on the chromatogram. The spectrum is displayed in the 
Spectrum View.

2. To display a spectrum that corresponds to a compound that is registered in the 
Compound Table, select the appropriate row in the table. If quantitation has been 
performed and the compound was identified, the spectrum is created from the peak 
retention time set in the Spectrum Process tab of the "Qualitative Parameters" dialog 
box. The spectrum is then displayed in the Spectrum View.

3. To display a spectrum that is registered in the Spectrum Process Table, select the 
appropriate row in the table. The spectrum is displayed in the Spectrum View.

4. To display a spectrum from qualitative peak integration data, select the appropriate 
row in the Qualitative Peak Table. The spectrum is created from the peak retention 
time set in the Spectrum Process tab of the "Qualitative Parameters" dialog box. The 
spectrum is then displayed in the Spectrum View.

   Note

If the retention time is in FASST measurement interval, the Scan spectrum is 
displayed.
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4.2.2 Averaging the Spectrum and Background Processing

1. To obtain a clean spectrum, average a range of mass spectra. First, turn on the 
Average function in the Chromatogram View by selecting View > Spectrum 
Calculation > Average, or by right-clicking the chromatogram and selecting 
Spectrum Calculation > Average. With the Chromatogram View in the averaging 
mode, drag the mouse from the starting to ending retention times to set the range 
you wish to average. The averaged spectrum is displayed in the Spectrum View. 
Averaging around the peak apex is usually the most effective.

2. To subtract the background spectrum, first display an original or averaged spectrum. 
Then turn on the Subtract function in the Chromatogram View by selecting View > 
Spectrum Calculation > Subtract, or by right-clicking the chromatogram and 
selecting Spectrum Calculation > Subtract. With the Chromatogram View in the 
subtraction mode, determine a retention time representative of the background and 
double-click it. The spectrum displayed in the Spectrum View is the difference 
between the original or averaged spectrum and the background spectrum.

An averaged background spectrum can also be subtracted. First display an original 
or averaged spectrum. Then turn on the Subtract Averaged Spectrum function in the 
Chromatogram View by selecting View > Spectrum Calculation > Subtract 
Averaged Spectrum, or by right-clicking the chromatogram and selecting Spectrum 
Calculation > Subtract Averaged Spectrum. With the Chromatogram View in the 
average subtraction mode, determine a range of retention times representative of the 
background and drag the mouse from the starting to ending retention times to set the 
range. The spectra for the time range are averaged, then subtracted as the 
background from the spectrum currently displayed in the Spectrum View. A range 
around the start or end of the peak is typically used as the background.

3. To subtract background spectrum repeatedly, select View > Spectrum Calculation 
> Subtract command. With the Chromatogram View in the subtraction mode, 
determine a retention time representative of the background and double-click it while 
holding down the [Shift] key. Then the subtracted result is displayed without clearing 
the previous result. Or select the Spectrum Calculation > Subtract Averaged 
Spectrum command from the menu, determine a range of retention times 
representative of the background and drag the mouse from the starting to ending 
retention times to set the range. The averaged spectrum is subtracted in the range 
defined by dragging without clearing the previous result.

   Note

If the spectrum averaging is performed in FASST measurement interval, the Scan 
spectrum is used. 
If the spectra to be subtracted is acquired using FASST, the Scan spectrum is used 
for the subtraction.
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4.2.3 Displaying Results of Spectrum Calculations

The retention time range used to calculate the resultant spectrum is displayed in 
the top of the Spectrum View. See the table below for simple examples of how the 
time ranges are displayed.

   Note

The toolbar includes Average Spectrum, Subtract Spectrum, and Average & 
Subtract spectrum buttons for easier access to the spectrum calculation functions.
Use the three spectrum calculation buttons on the toolbar as follows.

Average 
Spectrum 
Button

Click the button, and drag the mouse from the starting to ending 
retention times to set the range you wish to average. The averaged 
spectrum is displayed in the Spectrum View.

Subtract 
Spectrum 
Button

Click the button, determine a retention time representative of the 
background, and double-click it. The spectrum displayed in the 
Spectrum View is the difference between the original or averaged 
spectrum and the background spectrum.

Average & 
Subtract 
Spectrum 
Button

Click the button, determine a range of retention times representative 
of the background, and drag the mouse from the starting to ending 
retention times to set the range. The spectrums for the time range are 
averaged, then subtracted as the background from the spectrum 
currently displayed in the Spectrum View.

[10.000] Spectrum at 10.000 min retention time.

[10.000 -> 10.100] Resultant spectrum averaged from retention time range of 
10.000 min to 10.100 min.

[10.000] - [10.500] Resultant spectrum when spectrum at 10.500 min retention time is 
subtracted from spectrum at 10.000 min.

[10.000 -> 10.100] - 
[10.500]

Resultant spectrum where spectrum at 10.500 min retention time is 
subtracted from spectrum averaged from retention time range of 
10.000 min to 10.100 min.

[10.000 -> 10.100] - 
[10.500 -> 11.000]

Resultant spectrum where spectrum averaged from retention time 
range of 10.500 min to 11.000 min is subtracted as the background 
from spectrum averaged from retention time range of 10.000 min to 
10.100 min.

[10.000 -> 10.100] - 
[10.500] - [10.040]

Records resultant spectrum where spectrum at 10.500 min retention 
time is subtracted from spectrum averaged from retention time range 
of 10.000 min to 10.100 min, and the spectrum at 10.040 min 
retention time is subtracted from it further.
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   Note

To save a resultant spectrum for future reference, register it in the Spectrum 
Process Table by selecting Qualitative > Register to Spectrum Process Table, or 
by right-clicking the spectrum and selecting Register to Spectrum Process Table 
from the pop-up menu. Select Qualitative > Show Qualitative Table to view the 
Spectrum Process Table. To display a spectrum saved in the table, select the 
appropriate row.



4.34.
4  Qualitative Analysis

118 GCMS-QP2010

4.3 Peak Integration

This section describes how to integrate chromatogram peaks in the acquired data. The 
peaks can be integrated manually or automatically.

4.3.1 Manual Peak Integration

1. Click the Manual Peak Integrate for TIC/MIC toolbar button, or execute the 
Qualitative > Manual Peak Integrate command.

2. When the cursor is moved over the chromatogram, it is displayed as a vertical line. 
Drag the cursor from the start of chromatogram peak that you wish to integrate to the 
end.

Figure 4.3  Peak Selection for Manual Integration

The "Select Base Line" dialog box is displayed.

Figure 4.4  "Select Base Line" Dialog Box

Peak Start Point Peak End PointDrag
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3. Select how the baseline should be drawn from among Link Point, Horizontal, and 
New Baseline. Click the OK button.

• Link Point uses the beginning and ending time points selected on the 
chromatogram as the beginning and ending points for the baseline. The 
baseline beginning and ending points must overlap the chromatogram.

• Horizontal draws the baseline horizontally from the lowest intensity point 
between the selected chromatogram beginning and ending points. At least the 
beginning or ending point must overlap the chromatogram.

• After selecting New Baseline and clicking the OK button, use the drag function 
again to determine the baseline separately from the peak. The beginning and 
ending peak times are determined from the first drag. The baseline beginning 
and ending points are determined from the second, after closing the "Select 
Base Line" dialog box.

   Note

Select the Tool > Option command, the "Select Base Line" tab is displayed.

If Show Prompt on Manual Peak Integration button is selected, Select Base Line 
window is displayed when manually processing peaks. If Use Following Setting 
button is selected, the baseline is drawn as chosen in next three options without 
displaying the Select Base Line window.
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Figure 4.5  Specify a New Baseline

4.3.2 Automatic Peak Integration

1. Select Qualitative > Qualitative Parameters. The "Qualitative Parameters" dialog 
box is displayed.

Figure 4.6  Qualitative Parameters Peak Integration Tab

   Note

After determining the baseline, the peak is marked on the chromatogram and the 
spectrum is displayed. If a spectrum for a different retention time is currently 
displayed, click the Peak buttons ( ) at the top of the Chromatogram View until 
the marked peak is selected to display its spectrum.
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2. Enter the parameters for Peak Integration in the Qualitative Parameters Peak 
Integration tab.

Peak Integration Parameters
Peak integration is performed as specified by the Peak Integration parameters. The 
Program button is displayed only when performing qualitative peak integration. The 
time program for quantitative peak integration is set from the Program cell in the 
Compound Table.

Parameter Description Units Range

Integration Selects how to integrate peaks from Auto (Area), Auto (Height), or 
Detail.
Auto (Area): The slope is automatically adjusted until the entered # of 
Peaks is obtained. If the peak number is not obtained after adjusting 
the slope, the peaks with the largest areas are included to satisfy the 
peak number parameter. Confirm the final slope from the Qualitative 
Peak Table.
Auto (Height): The slope is automatically adjusted until the entered # 
of Peaks is obtained. If the peak number is not obtained after 
adjusting the slope, the highest peaks are included to satisfy the peak 
number parameter. Confirm the final slope from the Qualitative Peak 
Table.
Detail: Peak integration is based on the Slope, Width, Drift, and 
T.DBL parameters.

# of Peaks If Auto (Area) or Auto (Height) is selected as the integration method, 
this sets the number of peaks for it to target during slope adjustment. 
Depending on the chromatogram, this parameter may not be met 
directly. If the # of Peaks is not obtainable, the peaks with the largest 
areas or highest peaks are included until the parameter is satisfied.
If Detail is selected as the integration method, this parameter is 
disabled.

Slope This parameter determines the sensitivity of peak detection.
The slope, used to find the peak starting and end points, is calculated 
for tangents along the peak. The starting point of the peak is 
determined when the slope reaches a set value. The end point of the 
peak is determined when the negative slope reaches a set value. The 
starting and end points are calculated from a quarter value of the 
Width parameter.
If the Slope parameter is high, the sensitivity will be low. If the Slope 
parameter is low, the sensitivity will be high, but broad peaks will be 
detected as well.
Slope Parameter Precautions
The Slope parameter changes at the time interval specified by the 
T.DBL parameter.
To prevent the baseline from being detected as a peak, the slope 
must be greater than the drift for analyses with extreme baseline drift.

min-1 0 - 4E+11
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Drift This parameter is used to determine the baseline. Normally, the value 
is set to 0, and the baseline is automatically corrected. If the 
automatic baseline correction is incorrect, enter a value that will 
obtain the proper baseline. The Drift should be larger than the slope 
from which the baseline is to be discerned.
The Drift parameter leads to different results depending on whether 
the separation method provides complete or incomplete separation.

min-1 –1E+7 - 1E+7

T.DBL This parameter is the interval at which the Slope and Width are 
automatically changed.
To prevent the Slope and Width from changing automatically, enter a 
value that is larger than the final analysis time. When the peak width 
increases with time, such as with GC isothermal analysis, the Slope 
and Width parameters must be changed over time. When the T.DBL 
is 0, the Slope and Width parameters change automatically as the 
peaks broaden. If the automatically determined interval is incorrect, 
enter a T.DBL parameter as specified by the formula below. The width 
is doubled and the slope is halved at each T.DBL interval.
T.DBL (min) = (Width / Peak Width at Half-Height) x (Peak Retention 
Time) x 2
T.DBL Parameter Precautions
The Width and Slope parameters change at a time interval 
determined by the T.DBL parameter.

min 0 - 10000

Width This parameter is the width at half-height of the narrowest peak 
detected.
The Width parameter is the standard used to distinguish between 
noise and peaks. As noise is narrower than peaks, if Width is set from 
the narrowest peak width at half-height, peaks that are narrower can 
be distinguished as noise and eliminated. If this value is not set 
correctly, errors in peak integration will occur.
The Width parameter should be no greater than the width at half-
height of the narrowest peak in the chromatogram.
Width Parameter Precautions
The Width parameter changes at the time interval specified by the 
T.DBL parameter.
Automatic changes from the T.DBL parameter may occur up to 15 
times per chromatogram, including the changes in a time program. 
For MS quantitative analysis, the width parameter can only change up 
to two times.

sec 0.04 - 200

Min. Area/
Height

Peaks with area/height less than this setting will not be recognized as 
peaks and will not be processed or output in reports.

Base This sets whether area or height will be used in Min. Area/Height.

Note: The setting in the Quantitative Tab determine whether area or 
height is to be used in quantitative calculation.

Parameter Description Units Range
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Smoothing Select the Smoothing method from none, Standard, and Savitzky-
Golay.
None: Smoothing is not performed.
Standard: Smoothing is performed from a moving average, as in the 
CLASS-5000 software.
Savitzky-Golay: Smoothing is performed with the Savitzky-Golay 
method.

# of 
Smoothing 
Times

If the Standard smoothing method is used, this parameter specifies 
how many times to perform smoothing. If the first moving average 
has little effect, set the # of Smoothing Times parameter. By 
smoothing multiple times, the moving average effects are enhanced. 
Smoothing is not performed when the # of Smoothing Times is 0.
This parameter is disabled if None or Savitzky-Golay is selected as 
the smoothing method.

0 - 99

Smoothing 
Width

If the Standard smoothing method is used, this parameter specifies 
the average width for the moving averaging in seconds.
If the Savitzky-Golay smoothing method is used, this parameter 
specifies the number of points to smooth. Only odd numbers of points 
are effective. Even if an even number is entered, an odd number of 
points is smoothed.
This parameter is disabled if None is selected as the smoothing 
method.

sec

Points

0 - 200

3 - 25

Parameter Description Units Range

   Note

Refer to Appendix A "Peak Processing and Mass Spectrum Operations" on page 
273, Section A.1 "Integration and Peak Processing Parameters", page 273 and 
Section A.5 "Troubleshooting", page 304 for more information.
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Time Program for Peak Integration
After clicking the Program button, the "Time Program for Peak Integration" 
dialog box is displayed.

Figure 4.7   "Time Program for Peak Integration" Dialog Box

If optimal peak processing cannot be obtained with the default method parameters, 
use this dialog box to create a time program to change peak integration parameters 
over time.

When peak integration is initiated, qualitative analysis proceeds with the parameters 
entered in the Peak Integration tab. The time program changes the parameters at 
set times. Peak processing continues with the changed parameters.
Use a previously acquired chromatogram to facilitate time program development. 
Select the Load Chrom button, then choose the appropriate data file.

Click in the Time column, then click the chromatogram at the desired time. The 
retention time is automatically entered into the table. Select a command from the 
drop down list, then enter numerical values for commands that are followed by an 
"=".

   Note

For FASST measurement interval, the Scan TIC is displayed.

Command Description Units Range

INTEGRATION 
ON/OFF

Peaks that occur between INTEGRATION OFF and ON are 
considered unnecessary, and are not integrated.

ON/OFF

TAILING ON/
OFF/AUTO

This program performs tailing processing automatically. Forced tailing 
processing is conducted between the TAILING ON and TAILING OFF 
times specified. For TAILING AUTO, tailing processing is performed 
automatically from the time specified.

ON/OFF/AUTO
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HORIZ 
BASELIN ON/
OFF

The baseline of peaks within the HORIZ BASELIN ON to HORIZ 
BASELIN OFF interval is processed to become horizontal.

ON/OFF

PEAK 
DETECT/TOP/
END

Two or more peaks are forced to be processed as one peak. DETECT/TOP/
END

LEADING PK 
ON/OFF

Leading (fronting) processing is conducted within the LEADING PK 
ON to LEADING PK OFF interval.

ON/OFF

WIDTH= Changes the Width peak integration parameter.
Precautions
The Width value changes over time when T.DBL is used. For further 
information, refer to the T.DBL parameter in the Peak Integration 
Parameters table. Normally, the Width command should only be used 
in a time program when the T.DBL command is disabled (the T.DBL 
value is larger than the analysis ending time).
The use of a valid T.DBL value combined with a WIDTH = command 
is treated by the program in the following way:
When a user-specified value has been set for T.DBL: Initially, the 
WIDTH value is equal to the Width value at analysis start. The current 
Width value is calculated with T.DBL. Then the Width value is doubled 
each time the T.DBL time is reached.
When T.DBL is set to 0 (automatic T.DBL): The Width value is 
changed at the time set in the program. Then the Width value is 
doubled according to the width of the peak. Limit of width changes per 
analysis (including analysis with T.DBL): up to 15 times. For MS 
Quantitative processing: up to 2 times.

sec. 0.04 - 200

SLOPE= Changes the Slope peak integration parameter.
Precautions
The Slope value changes with time when using T.DBL. For further 
information, refer to the T.DBL parameter in the Peak Integration 
Parameters table. Normally, the Slope command should only be used 
in a time program when the T.DBL command is disabled (the T.DBL 
value is larger than the analysis ending time).
The use of a valid T.DBL value combined with a SLOPE= command is 
treated by the program in the following way:
When a user-specified value has been set for T.DBL: Initially, the 
SLOPE parameter is equal to the Slope value at analysis start. The 
current Slope value is calculated with T.DBL. Then the Slope value is 
halved each time the T.DBL time is reached.
When T.DBL is set to 0 (automatic T.DBL): The Slope value is 
changed at the set time in the program. Then the Slope value is 
halved according to the width of the peak.

min-1 0.0 - 4E+11

DRIFT= Changes the Drift peak integration parameter. min-1 –1E+7 - 1E+7

Command Description Units Range
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3. After entering each parameter in the Peak Integration table, click the OK button.
Peak marks and baselines are added to the chromatogram displayed in the 
Chromatogram View, and the peaks are integrated.

Figure 4.8  Chromatogram View

T.DBL= Sets the T.DBL peak integration parameter.
Precautions
T.DBL changes the values for the Slope and Width peak integration 
parameters over time. Normally, do not combine this command with a 
WIDTH or SLOPE command that changes Slope or Width parameters 
in a time program.
Processing with a user-specified T.DBL: Initially, the T.DBL parameter 
is equal to the T.DBL value at analysis start; the current Width and 
Slope values are calculated with this value. Then the Width and Slope 
values are changed (Width doubled, slope halved) at the specified 
time.
Auto Processing (T.DBL setting 0): The Slope and Width peak 
processing parameter values are changed from their starting values; 
T.DBL processing is conducted automatically.

min. 0.0 - 10000.0

   Note

Refer to Appendix A "Peak Processing and Mass Spectrum Operations" on page 
273, Section A.1 "Integration and Peak Processing Parameters", page 273 and 
Section A.5 "Troubleshooting", page 304 for more information.

Command Description Units Range
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4.3.3 Manipulation

There are Move the Detection Point and Split Peak in manipulation. These can be 
performed in the Chromatogram view, Quantitative view in Data Analysis window, Single/
Multi Chromatogram Display view in Calibration window or Chromatogram view (Single) in 
Quantitative Browser window. 

1. Move the Detection Point
This allows the cursor to be moved to specify the start point and the end point of 
peak.

(1) If the mouse pointer is moved near a detecting point, the cursor changes to triangle.
(2) Drag the cursor from the previous detecting point to the new detecting point. While 

the mouse cursor is moving, the cursor changes to a vertical line.

   Note

Tailing or leading edges of that peak can be moved. The peak detection points 
cannot be moved into the region of adjacent peaks.

   Note

While the mouse cursor is moving, the drawn baseline (red line) changes according 
to the cursor position.
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(3) When the detecting point is moved to the new position, data processing is performed, 
and Mark, Baseline, Area, Height and Conc. are updated.

2. Split Peak
If this command is selected, the chromatogram area will become the Split Peak 
mode, and a peak can be divided at the specified retention time. In order to cancel 
this mode, please select this command again.

(1) When the Split Peak command is selected from the Qualitative menu, the mouse 
pointer on the chromatogram changes to a cross line.

(2) Click at the splitting point of the peaks. The boundary line is drawn vertically at the 
point.

   Note

The mark of peak processing is expressed as "MI" for the manual peak processing.
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Peak processing is performed for both peaks. Mark, Baseline, Area, Height and 
Conc. are updated for each peak.

4.3.4 Peak Integration by Batch Processing

Refer to Chapter 7 "Continuous Analysis" on page 175 for information about integrating 
peaks during batch processing.

   Note

The mark of peak processing is expressed as "MI" for the manual peak processing.
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4.4 Similarity Search

This section describes how a spectrum shown in Spectrum View can be compared to similar 
spectra in a library file. It also describes the comparison between candidate and target 
spectra, and the identification of components.

4.4.1 Similarity Search for Displayed Spectrum

1. Click the Peak buttons ( ) at the top of the Chromatogram View to select a peak 
to identify with the similarity search. The spectrum of the selected peak, or target 
spectrum, is displayed in the Spectrum View.

Figure 4.9  Spectrum View

2. Click the Similarity Search Result toolbar button to open the "Similarity 
Search Results" window.
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Figure 4.10   "Similarity Search Results" Window

Compounds are listed in the "Similarity Search Results" window sequentially, starting 
with compounds having the highest degree of similarity. The list can be scrolled from 
below with the (  ) buttons to the left of the middle spectrum. The middle spectrum 
changes to the spectrum of the compound that is currently selected in the list.

The top spectrum is the target spectrum, and the second spectrum is a candidate 
compound spectrum from the library. The information in the lower portion of the 
window varies depending on which display option is currently selected in the View 
menu. If Compare is selected, the lower portion contains a second candidate 
spectrum from the same library as the second spectrum. If Information is selected, 
the compound information about the candidate spectrum is displayed. If Subtract is 
selected, the lower portion displays the resultant spectrum from subtracting the 
candidate spectrum from the target spectrum.

   Note

The library file used for the Similarity Search is selected in the Similarity Search tab 
of the "Qualitative Parameters" dialog box. To open the "Qualitative Parameters" 
dialog box, either click the Qualitative Parameters toolbar button or select 
Qualitative > Qualitative Parameters.
Five library files can be selected under Library File Name. A minimum similarity 
index may be entered for each file under Min.SI. The maximum number of hits and 
other parameters are also specified in this tab. Refer to GCMS Help for more 
information about the Similarity Search parameters.
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4.4.2 Similarity Search for Subtraction Spectrum Repeatedly

When you know previously that the target spectrum consists of spectrum of multiple 
compounds, by subtracting the spectrum hit by similarity search and executing similarity 
search again, you can obtain a more accurate search result.

1. Select the Process > Similarity Search for Subtraction Result command.

2. A new Similarity Search window opens, and the subtracted spectrum and the search 
results are displayed. 

3. You can also execute similarity search for the subtraction result again. (up to 2 times 
consecutively)
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4.4.3 Specify Library Spectrum

You can add the library spectrum to the end of the hit list on Similarity Search window.

By doing this, you can display the similarity search results of the spectrum and the similarity 
index, then also can execute Similarity Search for Subtraction Result.

1. Select the Process > Register Library Spectrum to Compound List command.

2. The "Specify Library Spectrum" window is opened.
Enter the library file name and serial number of spectrum which you want to add to 
the Hit List.

.
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4.5 Printing Results

This section explains how to print the default qualitative analysis reports.

4.5.1 Chromatogram and Spectrum

To print a report of the chromatogram and spectrum displayed during 
qualitative analysis, select File > Print Image > Print or click the Print toolbar 
button. Select File > Print Image > Preview, or click the Print Preview toolbar 
button to view the report on-screen before printing. A default report format is used to print 
the chromatogram and spectrum. To edit the default Image report format, select File > Print 
Image > Edit Format.

Print Image Report

Figure 4.11  Printed Report

4.5.2 Similarity Search Results

Use the Report menu in the "Similarity Search Results" window to print the three default 
reports described below. 

Menu command Description

Search Results Prints the target spectrum and the currently displayed candidate 
compound spectrum.
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Figure 4.12  Similarity Search Results Report Selection

4.5.3 Custom Report

To print a custom report from an open data file, select File > Report. The "Report" window 
is displayed. Either create a new report format and select the currently opened data file as 
the data file for each item, or open an existing report format file and select the currently 
opened data file as the data file for each item. Print the report. Refer to Chapter 6 
"Generating Custom Reports" on page 165 for information about creating custom report 
formats.

Comparison Prints the target spectrum, the currently displayed candidate compound 
spectrum, and the resultant spectrum from subtracting the candidate 
spectrum from the target spectrum.

Cmpd Info Prints the compound information, mass table, structural formula, and 
other data about the candidate compound from the library.

Menu command Description
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5  Quantitative Analysis

5.1 Overview

This section describes processing the acquired data with the GCMS Postrun Analysis 
application. It also explains compound identification, calibration curve generation, and 
concentration calculations, and printing of reports.

5.1.1 "Postrun Analysis" Windows

1. The "Data Analysis" Window

Figure 5.1  The "Data Analysis" Window

The items in this screen are described in the following table.

Data Explorer Title Bar Menu Bar Toolbar Chromatogram View

Assistant Bar Spectrum View Compound Table
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2. The "Calibration Curve" Window

Figure 5.2  The "Calibration Curve" Window

Title Bar Displays the name of the application, user, active window, and file.

Menu Bar Displays the menus that are available in the active window.

Toolbar Displays the command buttons that are available in the active window.

Assistant Bar
Displays the command icons that apply to a specific function or window. 
To open the window or activate the command, click the appropriate 
icon.

Data Explorer
Displays all files by type, including Data, Method, Report Format, Batch, 
and All Files. Data can easily be opened for analysis by double-clicking 
the file icon or dragging it to the appropriate location.

Chromatogram 
View Displays the chromatogram from the open data file.

Spectrum View Displays the mass spectrum for a retention time or compound selected 
in the Compound Table.

Compound 
Table

Displays the following tables: 
• Compound table: Contains parameters for compound identification, 

calibration curve creation, and concentration calculations.
• Compound Result table: Displays the results of compound 

identification and concentration calculations.
• Grouping table: Contains parameters for calibration curve creation 

and concentration calculations of the group.
• Grouping Result table: Displays the results of the grouping depending 

on the parameters on the Grouping table.

Title Bar
Menu Bar

Toolbar
Calibration Table View

Calibration Curve View
Calibration Curve Information

Assistant Bar Data Explorer Data File Tree Chromatogram View Compound Table
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Title Bar Displays the name of the application, user, active window, and file.

Menu Bar Displays the menus that are available in the active window.

Toolbar Displays the command buttons that are available in the active window.

Assistant Bar Displays the command icons that apply to a specific function or window. To 
open the window or activate the command, click the appropriate icon.

Data Explorer

Displays all files by type, including Data, Method, Report Format, Batch, 
and All Files. Method files can easily be opened for calibration curve 
creation by double-clicking the file icon and data files can be dragged to the 
Data File Tree for analysis.

Calibration 
Curve View

Displays the calibration curve for a compound selected in the compound or 
results table.

Calibration 
Curve 
Information

Displays the type of calibration curve displayed and results of statistical 
calculations.

Calibration 
Table View

Displays the concentration, and response factor or area/height of each level 
in the currently displayed calibration curve.

Data File Tree
Displays the data files that can be accessed to create the calibration curve 
at each level. The selected data file is the one to which the currently 
displayed compound and quantitative results tables belong.

Chromatogram 
View

Displays the chromatogram for a compound selected in the compound or 
quantitative results table.

Compound 
Table

Displays the following tables: 
• Compound table: Contains parameters for compound identification, 

calibration curve creation, and concentration calculations.
• Compound Result table: Displays the results of compound identification 

and concentration calculations.
• Grouping table: Contains parameters for calibration curve creation and 

concentration calculations of the group.
• Grouping Result table: Displays the results of the grouping depending on 

the parameters on the Grouping table.
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3. "Quantitative Data Analysis" Window

Figure 5.3  "Quantitative Data Analysis" Window

Title Bar Menu Bar Toolbar Chromatogram View

Assistant Bar Data Explorer Quantitative View Compound Table

Title Bar Displays the name of the application, user, active window, and file.

Menu Bar Displays the menus that are available in the active window.

Toolbar Displays the command buttons that are available in the active window.

Assistant Bar
Displays the command icons that apply to a specific function or window. To 
open the window or activate the command, click the appropriate icon.

Data Explorer
Displays all files by type, including Data, Method, Report Format, Batch, and 
All Files. Data can easily be opened for analysis by double-clicking the file 
icon or dragging it to the appropriate location.

Chromatogram 
View

Displays the chromatogram from the opened data file.

Quantitative 
View

Displays the calibration curve and chromatogram for the compound selected 
in the compound or quantitative results table. Displays data for up to five 
compounds at a time.

Compound 
Table

Displays the following tables: 
• Compound table: Contains parameters for compound identification, 

calibration curve creation, and concentration calculations.
• Compound Result table: Displays the results of compound identification 

and concentration calculations.
• Grouping table: Contains parameters for calibration curve creation and 

concentration calculations of the group.
• Grouping Result table: Displays the results of the grouping depending on 

the parameters on the Grouping table.
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5.1.2 Quantitative Analysis Procedures

The procedures for quantitative analysis are described below.

Method Development 

The method file contains the instrument parameters for the GC 
and MS and the qualitative, quantitative, data view, and QA/QC 
parameters. Create a new method file with GCMS Real Time 
Analysis, or use an existing method file after verifying its 
contents. For more information about method development, see 
Section 3.2 "Method Development Parameters", page 90.

Standard Injection and 
Data Acquisition

Data is acquired in GCMS Real Time Analysis. Enter 
information about single standards in the "Data Acquisition" 
window, or enter information about multiple standards in the 
"Batch Table" window. Initiate single or batch processing. For 
more information about data acquisition, refer to Section 3.3 
"Single Run Setup", page 104 and Section 3.4 "Data 
Acquisition", page 107.

Compound Table 
Creation

Open GCMS Postrun Analysis, and click the Assistant Bar 
Quantitative Analysis icon. Open the newly acquired data 
file(s), and analyze the data. Identify the standard compounds, 
and create the compound table as described in this chapter. 
Refer to Section 5.2 "Compound Table", page 143.

Calibration Curve 
Generation

Generate the calibration curve from the compound table. Refer 
to Section 5.3 "Creating Calibration Curves", page 149.

Unknown Sample 
Injection and Data 
Acquisition

Acquire data for unknown samples with GCMS Real Time 
Analysis, and perform concentration calculations. Refer to 
Chapter 3 "Data Acquisition", page 85.

Quantitative 
Calculations and 
Verification of 
Quantitative Results

Identify compounds through quantitative calculations, and 
confirm the concentration calculation results. Refer to Chapter 
5.4 "Performing Quantitation and Confirming Results", page 
151.

Similarity Search

Compounds in the library with spectra that are highly similar to 
the spectrum of the identified compound in the compound table 
are listed sequentially from the most similar, and the spectra are 
compared. Refer to Chapter 5.5 "Similarity Search", page 155.
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The Quantitative Analysis Process

Figure 5.4  The Quantitative Analysis Process
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5.2 Compound Table

This section explains how to create the compound tables that are necessary for peak 
integration, quantitation, and calibration curve generation. The information may be entered 
into the Compound Table directly, or the Compound Table Wizard may be used to facilitate 
the creation process.

1. Open acquired data.
Start GCMS Postrun Analysis, and click the Assistant Bar Create 
Compound Table icon. The "Data Analysis" window is displayed in the 
compound table mode.

2. Click the Data Explorer Data tab, and double-click the data file 
icon for the standard. The data is displayed in the Chromatogram 
View.

3. Click the Assistant Bar Wizard (New) icon. The compound table enters the 
edit mode, and the Compound Table Wizard is displayed.

Figure 5.5  Compound Table Wizard Screen 1/7

4. Complete the Compound Table Wizard 1/7 screen.

Select the Use Current Spectrum Process Table or Integrate of TIC radio button. 

To check the contents of the Spectrum Process Table 
before selecting Use Current Spectrum Process Table, 
click the Cancel button and temporarily close the 
Wizard. Select Qualitative > Show Qualitative Table or 
click the Assistant Bar Qualitative Table icon to open 
the "Qualitative Table" window. Verify the Spectrum 
Process Table on the Spectrum Process tab. Click the 
Assistant Bar Wizard (New) icon to reopen the 
Compound Table Wizard.

   Note

Refer to GCMS Help for more information about the "Qualitative Table" window.
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When "Integrate of TIC" is selected, the Integration Param and Spectrum Format 
buttons are enabled. Click the Integration Param button to verify the contents of the 
Peak Integration tab of the "Qualitative Parameters" dialog box. Click the Spectrum 
Format button to verify the contents of the Spectrum Process tab of the "Qualitative 
Parameters" dialog box.

Figure 5.6  Peak Integration and Spectrum Format Parameters

Click the Next button to proceed to the Compound Table Wizard 2/7 screen.

Figure 5.7   Compound Table Wizard 2/7 Screen

5. Complete the Compound Table Wizard 2/7 screen.
The number of peaks registered in the current spectrum processing table is 
displayed as the value for this text box.

   Note

Refer to GCMS Help for more information about setting the parameters in the Peak 
Integration and Spectrum Process tabs.
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Click the Next button to proceed to the Compound Table Wizard 3/7 screen.

Figure 5.8  Compound Table Wizard 3/7 Screen

6. Complete the Compound Table Wizard 3/7 screen.

The Compound Table is constructed from the peaks in the spectrum process table on 
the screen that are checked in the Proc. column. If peaks that should not be included 
in the Compound Table are checked, click the check box to uncheck them. 
Highlighting a row displays the mass spectrum for the selected compound.

Click the Next button to proceed to the Compound Table Wizard 4/7 screen.

Figure 5.9  Compound Table Wizard 4/7 Screen

7. Complete the Compound Table Wizard 4/7 screen.
Enter the quantitative method, calibration curve, and concentration parameters.



5  Quantitative Analysis
5.2 Compound Table

146 GCMS-QP2010

Click the Next button to proceed to the Compound Table Wizard 5/7 screen.

Figure 5.10  Compound Table Wizard 5/7 Screen

8. Complete the Compound Table Wizard 5/7 screen.

Enter the concentration for each level in the calibration curve, the number of 
reference ions to use in peak identification, and a decimal format for masses. If 
Internal Standard is selected as the Quantitative Method in Compound Table Wizard 
4/7, enter an Internal Standard amount as well.

Click the Next button to proceed to the Compound Table Wizard 6/7 screen.

Figure 5.11  Compound Table Wizard 6/7 Screen

   Note

Refer to GCMS Help for more information about setting the Compound Table 
Wizard 4/7 screen parameters.
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9. Complete the Compound Wizard 6/7 screen.

Edit the information for each compound ID. To change compounds, enter an ID 
number directly or use the spin control arrows to the right of the ID# text box. The 
spectrum corresponding with the selected ID is displayed in the spectrum view.

Select either Reference or Target for the compound type in the Type combo box.

Designate a compound name. When "Use the Current Spectrum Processing Table" 
is selected in the Compound Table Wizard 1/7 and the compound name is 
designated in the table, that compound name is displayed. The first radio option 
depends upon how the compound was entered in the Spectrum Process Table. If a 
Similarity Search was performed on the Spectrum Process Table, the name of the 
first hit compound in the library is the first name option. If a Similarity Search has not 
been performed, the first name option is "RT:" followed by the retention time. When 
the Set Name option is selected, a name may be entered into the text box.

In the table on the right side of the screen, the Target Ion and Reference Ion are 
listed sequentially from the ions having largest relative intensity.

To change a cell in the Type column, click the cell. The cell becomes a combo box; 
select Target Ion, Reference Ion, or Not Used. If changing the target or reference ion, 
first change the Target Ion or Reference Ion to Not Used, then change the other ion 
to Target Ion or Reference Ion.

To change a m/z, click the appropriate cell. Click the button which appears in the cell, 
and the spectrum is displayed. Determine the position of the spectrum from which to 
get the m/z, and double-click that location. The m/z is selected, and the reference ion 
ratio is recalculated.

Click the Next button to proceed to the Compound Table Wizard 7/7 screen.

Figure 5.12  Compound Table Wizard 7/7 Screen
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10. Complete the Compound Table Wizard 7/7 screen.

After confirming that a compound table with the required number of compounds, as 
designated in the Compound Table Wizard 3/7 screen, will be created, click the 
Finish button. The Compound Table will be displayed in the Param's tab of the 
Compound Table View.

11. Set the quantitative parameters.

After creating the compound table, modify the quantitative parameters as necessary. 
Select Quantitative > Quantitative Parameters or click the Quantitative 
Parameters toolbar button. The "Quantitative Parameters" dialog box is displayed.

Figure 5.13  "Quantitative Parameters" Dialog Box

After verifying that the parameters are correct, save the method and data files.

   Note

The Qualitative Parameters time program is accessed from the Peak Integration 
tab. For Quantitative Parameters, the Time Program for Peak Integration is 
accessed from the Program column in the Compound Table.
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5.3 Creating Calibration Curves

This section explains how to create a calibration curve with the data in the compound table.

1. Click the Assistant Bar Calibration Curve icon, and the "Calibration Curve" 
window is displayed.

2. Click the Method tab of the Data Explorer, and double-click the 
method file from which to create the calibration curve. The 
compound table saved with the method file is displayed.

Figure 5.14   Compound Table

3. Click the Data tab of the Data Explorer, select the data file from 
which to create the calibration curve, and drag it from the Data 
Explorer to the Data File Tree.

Figure 5.15  Drag the Data File Icon to the Data File Tree

   Note

When creating a calibration curve with two or more levels, drag the data files for 
each level to its corresponding location in the data file tree.
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4. Click the Assistant Bar Peak Integration for All Data icon.
The calibration curve is generated and displayed in the Calibration Curve 
View.

Figure 5.16  Calibration Curve View

Save the method file.
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5.4 Performing Quantitation and Confirming Results

This section explains how to perform quantitative processing calculations and view the 
results. Compound tables and calibration curves are discussed as well.

1. Click the Assistant Bar Quantitative icon, and the "Quantitative Data 
Analysis" window is displayed.

2. Open the data file on which to perform quantitation.

Click the Data tab in the Data Explorer, and double-click the data 
file icon to open the file. The data is displayed in the respective 
Views.

Figure 5.17  "Quantitative Data Analysis" Window
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3. Click the Assistant Bar Load Method icon, and the "Load Method" dialog 
box is displayed.

Figure 5.18  "Load Method" Dialog Box

4. Select the method file in which the calibration curve is saved, and click the Open 
button. The calibration curve and compound table are displayed.

Figure 5.19  The Calibration Curve and Compound Table are Displayed

5. Click the Quantitate for All IDs toolbar button or select Quantitative > 
Calculate. After Quantitation, the results can be viewed.

6. Click the Results tab of the Compound Table to display the results of 
quantitation.

The information included in the result table is described in the following table.



5  Quantitative Analysis
5.4 Performing Quantitation and Confirming Results

153GCMS-QP2010

Results Table

Figure 5.20  Results Table

Column Description

ID# Displays the compound ID number.

Name Displays the name of the compound.

Conc Displays the calculated concentration.

Ret. Time Displays the retention time of the identified peak.

Type Displays the type as entered in the compound table. If a peak is not identified, 
"Unknown" is displayed.

m/z Displays the m/z value entered in the compound table.

Area Displays the area of the identified peak.

Height Displays the height of the identified peak.

Unit Displays the unit selected in the Compound table.

Recovery Displays the calculated percent recovery. The percent recovery is calculated by 
performing quantitation on a spiked sample.
Yield calculation formula:
(percent yield) = (calculated concentration of spiked sample - calculated 
concentration of unspiked sample)/(amount spiked) x 100
When creating the batch table, the unspiked and spiked samples must always be 
entered sequentially, with the unspiked sample preceding the spike sample. Enter 
the information for the unspiked sample, setting the batch table Sample Type to 
Unspiked. Then enter the information for the spiked sample and set its Sample 
Type to Spiked.

Mode If peak integration has been performed displays the peak integration mode.
• Auto: Indicates that automatic peak integration and identification have 

been performed.
• Manual Integrate: Indicates that manual peak integration or identification has 

been performed.

Search States if a Similarity Search was performed on the identified spectrum. To display 
the search results, double-click the cell or select Show Search Results for 
Compound Table from the right-click menu.

SI The result of similarity calculations are displayed, when the pattern matching of 
identification parameters is checked and the standard spectrum is registered in 
the Compound table. In the FASST measurement interval, the similarity 
calculations are performed for the Scan spectrum.
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   Note

Compounds that have not been identified are displayed in gray rows. Identified 
compounds are displayed in green rows.
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5.5 Similarity Search

This section describes how spectra in the library that are highly similar to the spectra for 
compounds in the compound table are listed and displayed. The spectra from the library, or 
candidate spectra, are displayed sequentially from the most similar to the compound in the 
compound table, or target compound. It also describes the comparison between candidate 
and target spectra.

5.5.1 Similarity Search for Compound Table

1. Open the "Data Analysis" window in the Quantitative or 
Compound Table mode. Click the Data tab in the Data Explorer, 
and double-click the appropriate data file icon. The compound 
table is displayed, as well as the chromatogram and calibration curves, if available.

2. Select the Similarity Search for Compound Table 
command from the Quantitative menu. The 
Compound Table Search tab of the "Quantitative 
Parameters" dialog box is displayed.

Figure 5.21  Quantitative Parameters Compound Table Search Tab

3. Select which types of compounds to include in the Similarity Search from Target, 
ISTD & Reference, and Unknown. More than one type may be included in the search 
at a time.

After making your selection, click the OK button, and the Similarity Search is 
performed.

   Note

If the target compound for a Similarity Search is acquired using the FASST, the 
Scan spectrum is used for the search.
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4. To view the search results, double-click the row of the desired compound or select 
Show Search Results for Compound Table from the right-click menu. The 
"Similarity Search Results" window is displayed.

Figure 5.22  "Similarity Search Results" Window

Compounds are listed in the "Similarity Search Results" window sequentially, starting 
with compounds having the highest degree of similarity. The list can be scrolled with 
the  buttons to the left of the middle spectrum. The middle spectrum changes to 
the spectrum of the compound that is currently selected in the list.

The top spectrum is the target spectrum, and the second 
spectrum is a candidate compound spectrum from the library. 
The information in the lower portion of the window varies 
depending on which display option is currently selected in the 
View menu. If Compare is selected, the lower portion contains a 
candidate spectrum from the same library as the second 
spectrum. If Information is selected, the compound information 
about the candidate spectrum is displayed. If Subtract is 
selected, the lower portion displays the resultant spectrum from 
subtracting the candidate spectrum from the target spectrum.

Figure 5.23  Information Selected in View Menu
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Figure 5.24  Subtract Selected in View Menu

Figure 5.25  Library File Selection

Five library files may be selected under Library File Name. A minimum similarity level 
may be entered for each file under Min.SI. The maximum number of hits and other 
parameters are also specified in this tab. Refer to Appendix A "Peak Processing and 
Mass Spectrum Operations" on page 273 and GCMS Help for more information 
about the Similarity Search parameters.

5.5.2 To Execute a Similarity Search for Subtraction Result

When you know previously that the target spectrum consists of spectrum of multiple 
compounds, by subtracting the spectrum hit by similarity search and executing similarity 
search again, you can obtain more accurate search result.

   Note

The library file used for the Similarity Search is selected in the Similarity Search tab 
of the Qualitative Parameters. To open the "Qualitative Parameters" dialog box, 
either click the Qualitative Parameters toolbar button or select Qualitative > 
Qualitative Parameters.
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1. Select Process > Similarity Search for Subtraction Result command.

2. A new Similarity Search window opens, and the subtracted spectrum and the search 
results are displayed.

3. You can also execute a similarity search for the subtraction result again. (up to 2 
times consecutively)

5.5.3 Specify Library Spectrum

You can add the library spectrum to the end of the hit list on Similarity Search window.
By doing this, you can display the similarity search results of the spectrum and the similarity 
index, then also can execute Similarity Search for Subtraction Result.

1. Select the Process > Register Library Spectrum to Compound List command.

2. "Specify Library Spectrum" window is opened.
Enter the library file name and serial number of spectrum which you want to add to 
the Hit List.



5.65.
5  Quantitative Analysis

159GCMS-QP2010

5.6 Analyzing Unknown Peaks

This section describes the method used to analyze the spectra of compounds listed in the 
compound table that are not target compounds. It is used primarily to analyze contaminants 
and other unknown components.

1. Open the "Data Analysis" window in the Quantitative or 
Compound Table mode. Click the Data tab in the Data Explorer, 
and double-click the appropriate data file icon.

The compound table is displayed, as well as the chromatogram and calibration 
curves, if available. 

2. Select TIC or MIC from Pickup Unidentified 
Peaks in the Quantitative menu. The 
unidentified peak is integrated and listed in the 
results table.

3. Select the Similarity Search for Compound 
Table command from the Quantitative menu. 
The Compound Table Search tab of the 
Quantitative Parameters is displayed.

Figure 5.26   Quantitative Parameters Compound Table Search Tab

4. Select Unknown as the type of compound for which to search, and click the OK 
button. The Similarity Search is performed.

5. To view the search results, double-click the row of the desired compound or select 
Show Search Results for Compound Table from the right-click menu. The 
"Similarity Search Results" window is displayed. 



5.75.
5  Quantitative Analysis

160 GCMS-QP2010

5.7 Grouping

This section describes the method used to group compounds with similar characteristics 
and calculate the concentration for each group.

1. Click the Calibration Curve icon on the Assistant bar. The screen is 
displayed in Calibration Curve mode.

2. Load the method file. Click the Method tab in the Data Explorer, 
and double-click the icon of the method file to be loaded.

The Compound table registered in the loaded method file is displayed.

Figure 5.27  Compound Table

3. Double-click the Data tab in the Data Explorer and drag the data 
file for the calibration curve from the Data Explorer to Data File 
Tree.

4. Click the Edit button in the Compound table and change to the Edit mode. 
Create a group in the Compound table.

5. Click the Group Param's tab.

Enter the Group Name, Group Type, Conc, etc. For a calibration curve, the type of 
the grouping should be selected from the following:

Default: The grouping method selected in Quantitative parameters

Group calibration: Combines peak area and peak height of the compounds that are 
grouped, and quantitates the respective group using the calibration curve.

Concentration Sum: Draws the calibration curve for each compound, quantitates 
each compound, and combines concentrations of the compounds.
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6. Click the Param's tab. Set the group number for respective compound 
selected in the Compound table.

7. Click the View button and switch to the View mode.

8. Click the Peak Integration for All Data icon on the assistant bar. The 
calibration curve is displayed.

9. The result of group quantitation is displayed on the Group Result tab in the 
Compound table.

Figure 5.28   Compound Table
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5.8 Printing Results

This section explains how to print the default quantitative analysis reports.

5.8.1 Calibration Curves

Display the "Calibration Curve" window, and open the appropriate method file. 
Verify that the correct data files are listed in the Data File Tree. To print a report 
of the calibration curve, select File > Print Image > Print or click the Print 
toolbar button. Select File > Print Image > Preview, or click the Print Preview toolbar 
button to view the report on-screen before printing. A default report format is used to print 
the calibration curves. To edit the default Image report format, select File > Print Image > 
Edit Format.

Print Image Report

Figure 5.29  Print Image Preview

5.8.2 Custom Report

To print a custom report from an open data file in the "Data Analysis" window, select File > 
Report. The "Data Report" window is displayed. Either create a new report format and 
select the currently opened data file as the data file for each item, or open an existing report 
format file and select the currently opened data file as the data file for each item. Print the 
report. For information about creating custom report formats, refer to Chapter 6 "Generating 
Custom Reports" on page 165.

The procedure for generating a report from a report format template is described below.

1. Open the data file that will be used for the report in the "Data Analysis" window. 
Select File > Report to display the "Report" window.

2. Select File > New Format File to open the "File New" dialog box. Verify that the Use 
Template radio button is selected. The File New dialog box does not open unless 
"Prompt on File New" has been selected on the File New tab of the "Setting Options" 
window which is displayed by selecting Option in the Tools menu.
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Figure 5.30   File New Dialog Box

3. Select a report format template from the list, and click the OK button. The formatted 
report, including the data from the open data file, is displayed in the "Data Report" 
window.

4. To print the report, use the File > Print command or click the Print toolbar button. A 
report generated with the Quantitative Result (Graph) template is illustrated below.

Figure 5.31  Report Generated with the Quantitative Result (Graph) Template
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6  Generating Custom Reports

6.1 Creating the Report Format

This section describes the procedure for creating a custom report format. This format may 
later be used to print data.

6.1.1 "Report" Window

Figure 6.1   "Report" Window

Menu Bar
Standard Toolbar Title Bar Item Toolbar

Report Toolbar

Assistant Bar Data Explorer Layout View

Title Bar Displays the name of the application, user, active window, and file.

Menu Bar Displays the menus that are available in the active window.

Toolbar Displays the command buttons that are available in the active window.

Assistant Bar
Displays the command icons that apply to a specific function or window. To 
open the window or activate the command, click the appropriate icon.

Data Explorer

Displays all files by type, including Data, Method, Report Format, Batch, and 
All Files. Double-clicking the file icon can open report Format files. A data file 
can easily be assigned to an item in the report by dragging it to the appropriate 
item.

Layout View
Displays the current item placement for a page of the report. Which items to 
include on the page, their location, and other properties may be set on this 
page. 
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6.1.2 Report Toolbar

1. Object Tools

Button Name Function

Pointer Moves and resizes items on the page.

Sample 
Information

Inserts the information entered about the sample, such as the user 
name, sample name, sample type, and vial number, as well as other 
information, as specified in the Sample Information Properties.

Method 
Content

Inserts the instrument parameters and data processing parameters, 
as specified in the Method Properties.

Peak Table Inserts the peak table as specified in the Peak Report Properties.

Chromatogram Inserts the chromatogram as specified in the Chromatogram 
Properties.

Spectrum 
Graph

Inserts the spectrum and any additional information specified in the 
Spectrum Properties.

Mass Table Inserts the mass table specified in the Mass Table Properties.

Quantitation 
Graph

Inserts the chromatograms and reference ion table, as well as other 
information specified in the Quantitation Properties.

Quantitation 
Table

Inserts the quantitation results table as specified in the Quantitation 
Results Table Properties.

Group Result Inserts the group result of the data file to appear on the report.

Calibration 
Curve

Inserts the calibration curve and table, as well as other information 
specified in the Calibration Properties.

Tuning Inserts the tuning conditions and results, as well as other information 
specified in the Tuning Properties.

Status Log Inserts a log of the MS status as specified in the Status Log Report 
Properties.

Library Search Inserts information about the target and candidate compounds as 
specified in the Library Properties. 

Spectrum 
Comparison

Inserts the comparison results as specified in the Spectrum 
Comparison Properties.

Column 
Performance

Inserts the table specified in the Column Performance Report 
Properties.

Spectrum 
Check

Inserts the spectrum check result of the data file to appear on the 
report.

Summary
(Conc.)

Displays the concentration lists of multiple data.

Summary
(Compound)

Displays the quantitation results of multiple data (Conc., Area, Height 
and etc.) lists for each compound.
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2. Formatting Tools

Configuration Inserts information about the system configuration as specified in the 
Configuration Control Properties.

Picture Inserts any graphic file, such as a company logo, as specified in the 
Picture Properties.

Text Inserts the text specified in the Text Properties.

Line Draws a line that may be further specified by its Shape Properties.

Arrow Draws an arrow.

Rectangle Draws a rectangle that may be further specified by its Shape 
Properties.

Ellipse Draws an ellipse that may be further specified by its Shape 
Properties.

Button Name Function

Button Name Function

Align Left Aligns selected objects along their left edges at the furthest left 
edge.

Align Right Aligns selected objects along their right edges at the furthest right 
edge.

Align Top Aligns selected objects along their top edges at the highest edge.

Align Bottom Aligns selected objects along their bottom edges at the lowest edge.

Zoom Zooms in and out of the Layout View to the displayed percentage. 
Enter a percentage directly, or select one from the Zoom combo 
box.

Make Same 
Width

Increases the width of the selected objects to match that of the 
widest item.

Make Same 
Height

Increases the height of the selected objects to match that of the 
tallest item.

Make Same 
Size

Increases the size of the selected objects to match the width of the 
widest item and the height of the tallest item.

Insert Adds a page to the report format. The new page is inserted after the 
currently displayed page.

Delete Removes the page that is currently displayed.

First If there are multiple pages, goes to the first page of the report 
format.



6  Generating Custom Reports
6.1 Creating the Report Format

168 GCMS-QP2010

3. Standard Tools

Figure 6.2  Floating Palette

This function helps you make the most efficient use of the screen. Use this function 
when the width of the tool bar must be reduced. To return the palette to the toolbar, 
either double-click the palette title bar or drag the palette into the toolbar.

Previous If there are multiple pages, goes to the previous page.

Next If there are multiple pages, goes to the next page.

Last If there are multiple pages, goes to the last page.

Button Name Function

Button Name Function

Print Prints the report.

Preview Opens the print preview screen so that the report can be verified 
before printing.

Open Opens existing report format files.

Save Saves the report format file. This overwrites the existing file; to save 
the file to a new name, use File > Save Format File As.

   Note

To turn the toolbar into a floating palette, double-click the toolbar (the area around 
the command buttons), or click the toolbar and drag it to the desired location.
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6.1.3 Creating the Report Format File

1. Click Assistant Bar Report Format icon. The "Report" window opens and 
displays a new, untitled file. 

2. After opening a new file, select Page Setup from the File menu. The "Page 
Setup" dialog box is displayed.

Figure 6.3  "Page Setup" Dialog Box

3. Enter the following parameters.

Group Parameter Description

Paper Size Select which size paper to use for printing.

Source Select the paper tray or how the paper is supplied to the 
printer.

Orientation Portrait or 
Landscape

Determine whether to use the paper horizontally 
(landscape) or vertically (portrait).

Margins
(millimeters)

Left, Right, Top, and 
Bottom

Enter how much space to leave from the left, right, top, and 
bottom of the page in millimeters.

Printer Select which printer to use by default.



6  Generating Custom Reports
6.1 Creating the Report Format

170 GCMS-QP2010

4. Click a toolbar item button, or select an item from the Item menu. Drag the cursor 
over the desired location in the Layout View to place the item in the report.

Figure 6.4  Layout View

The appropriate properties dialog box is displayed.

Figure 6.5  Properties Dialog Box

5. Set the parameters in the various Properties tabs. Although most of the parameters 
vary by item, each item has a General tab for setting the position, size, title, font and 
color, and a File tab for determining the source data file. After all of the parameters 
are entered, click the OK button. The properties dialog box is closed, and the entered 
parameters are applied.

Add additional items to the report, and enter their parameters, as necessary.
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6. If the report will be composed of multiple pages, click the Insert button to add 
a page after the page that is currently displayed.

7. Select View > Header/Footer. The "Header/Footer" dialog box is displayed. 

Figure 6.6   Header/Footer Dialog Box

8. The contents of the table below may be aligned in the Left, Center or Right of the 
page, as determined by the text box in which they are entered. Enter information to 
be printed at the top of the report in the Header tab and the information to be printed 
at the bottom of the report in the Footer tab.

Place the cursor in the Left, Center, or Right text box, and click the button to enter the 
variable for the associated text.

Button Name Function Variable

Font Click the Font button to open the "Font" window. Select 
the font, including size, style and color, in which to display 
the header or footer, and click OK.

Version Click the Version button to include the version of 
GCMSsolution Ver. 2 in the header or footer text.

$Version$

Filename Click the Filename button to include the name of the data 
file in the header or footer text. When using different data 
for each item, include the data file name with the item.

$Filename$

Report# Click the Report# button to include the number of the 
report in the header or footer text. Reports are numbered 
consecutively as they are printed. Enter the number for 
the first report in the "Report Option" dialog box.

$Report#$

Page# Click the Page# button to include the page number in the 
header or footer text.

$Page#$

Date Click the Date button to include the date, as formatted by 
Windows, in the header or footer text.

$Date$

Time Click the Time button to include the time, as formatted by 
Windows, in the header or footer text.

$Time$

Username Displays user name. $User$
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9. After setting the properties for all included items, and entering header and 
footer text, click the Preview button to view the printed report.

10. Save the newly created format as a report format file.

Click the Save toolbar button.

The "Save As" dialog box is displayed the first time that the report format is 
saved.

Figure 6.7  "Save As" Dialog Box

Select the directory where the file will be saved, and enter a file name. Click the Save 
button, and the report format is saved as a report format file (*.qgr).

Use the Save button to save modifications to a report format file by overwriting the 
existing file. Refer to Section 6.2.1 "Opening the Report Format File", page 173.

Button Command

Print Print the report. Refer to Section 6.2.3 "Printing the Report", page 173.

Next Page Preview the next page.

Prev Page Preview the previous page.

Two Page Preview two pages simultaneously.

One Page Preview one page at a time.

Zoom In Enlarge the previewed report.

Zoom Out Reduce the previewed report.

Close Exit the preview window.

   Note

Use File > Save Format File As to save the file under a new name unless the 
existing file is to be overwritten with the modified file. The "Save As" dialog box is 
displayed. Select a directory where the file will be saved, enter a file name, and 
click the Save button.
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6.2 Using Report Format Files

This section describes the procedure for opening existing report format files, importing data, 
and printing reports.

6.2.1 Opening the Report Format File

1. Click the Assistant Bar Report Format icon. The "Report" window is 
displayed.

2. Open the appropriate report format file with File > Open Format File, Open 
toolbar button, or Data Explorer. The report format file is displayed in the Layout 
View.

6.2.2 Importing Data into the Report Format File

1. Click the Data tab of the Data Explorer. All of the data files for the 
currently selected project are listed.

2. Click the appropriate data file in the Data Explorer, and drag it to the Layout View. 
The data file is loaded into the report, and the data is displayed.

Data may also be imported by selecting File > Load Data File.

6.2.3 Printing the Report

1. Click the Assistant Bar Print icon to display the "Print" dialog box.

Figure 6.8  "Print" Dialog Box
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2. Select which pages to print from "All", "Pages" or "Selected". "All" prints every report 
page. "Pages" allows a range of pages to be printed. "Selected" prints portions of the 
report that were selected before the print command was executed.

3. Enter the number of copies to print in Number of copies.

4. Click the OK button to print the report.

   Note

Clicking the Properties button next to the name of the Printer changes the printer 
parameters. For details about the printer properties, refer to the printer manual.
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7  Continuous Analysis

7.1 Overview

This section describes two types of automated processing. One is used by GCMS Real 
Time Analysis to acquire and analyze data from multiple samples. The other is used by 
GCMS Postrun Analysis to analyze the data from multiple data files. For both types of 
automation, a method file must first be created.

7.1.1 Automated Data Acquisition and Data Analysis

Figure 7.1  Automated Data Acquisition and Analysis
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7.1.2 Automated Postrun Analysis

Figure 7.2  Automated Postrun Analysis
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7.2 Automated Data Acquisition and Data Analysis 

This section describes data acquisition and analysis with GCMS Real Time Analysis using 
an autosampler. For information about the qualitative and quantitative analysis parameters, 
refer to 
Chapter 4 "Qualitative Analysis" on page 111 and Chapter 5 "Quantitative Analysis" on page 
137.

7.2.1 Creating a Batch Table

1. Start GCMS Real Time Analysis, and click the Assistant Bar Batch 
Processing icon. The "Batch Table" window is displayed.

Figure 7.3  "Batch Table" Window

Title Bar Menu Bar Toolbar Batch Table

Assistant Bar Output Window Instrument Monitor
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2. Click the Assistant Bar Settings icon, and the "Settings" dialog box is 
displayed.

Figure 7.4  "Settings" Dialog Box

Title Bar Menu Bar Toolbar Batch Table

Data ExplorerAssistant Bar Output Window
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Start Row Tab
Indicate the row where batch processing will start.

Type Tab
Select the line for batch data acquisition and post run analysis.

Parameter Description

Start on next row Batch processing starts from the row after processing was stopped. If a 
data file was not created for that row, batch processing will start on that 
row. Before processing starts, a message is displayed to verify whether to 
start from the next row or the first row.

Start from # Batch processing starts from the indicated row. Before processing starts, a 
message is displayed to verify whether to start from the indicated row or 
the first row.

Parameter Description

Line 1
Line 2
Line 1 & Line 2

Selects which line to use in the Batch table.
Line 2 and Line 1 & 2 are only selectable when multiple analytical lines are 
enabled in the system configuration.
When Line 1 & 2 is selected, two rows at a time are added to (or deleted 
from) the batch table. In this way the processing of both Lines 1 and 2 is 
performed for each sample indicated.
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Folder Tab
This tab determines the directory to search by default for a type of file. For example, if the 
name of a data file, but not a full path, is entered, the program will get the full path from the 
folder specified in this tab.

Data Filename Tab

Parameter Description

Use Current Folder The program uses the folder that is currently selected in the Data Explorer. 
This is usually the folder in which the batch file was saved.

Use Specified 
Folder

Allows the entry of the default directory for the data, method, and report 
format files. To browse for a directory, click the Folder button to the right of 
the Data File, Method File, and Report Format File text boxes. 

Use Same Folder To use the same directory for data, method and report format files, check 
Use Same Folder. The folder indicated in the Data File text box is used as 
the default folder for all of the files.

Parameter Description

Generates 
filename 
automatically with 

When checked, the file name is automatically named using the information 
selected in the Selected Items box. Select the item(s) to be used in the 
name from the left box, and click the Add button to move the item of the 
Selected Items box. To remove an item from the name, select it in 
Selected Items, and click the Del button. Determine the order in which the 
items appear in the name by selecting the item in the Selected Items box 
and clicking the Up and Down buttons. Items that may be included in the 
name: Batch Filename, Batch Table Line #, Method Filename, Username, 
Sample Name, Sample ID, and Current Date.

Auto-increment 
format

Selects one of the four auto-increment formats. The options include: 
1, 2, ...; 01, 02, ...; 001, 002, ...; and 0001, 0002, ....
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ASCII Convert Tab
When Output ASCII File(s) is checked, the results of batch processing are exported to an 
ASCII file.

QA/QC Tab
Check Execute QA/QC to perform QA/QC.

Parameter Description

Output per batch
Output per analysis

Indicates whether to export the selected information to a text file after 
processing the entire batch (Output per batch) or one row of the batch 
table (Output per analysis).

Output File Allows the entry of the full path name into the Output File text box, or 
filename selection by browsing for the appropriate directory and 
entering the name by clicking the Folder button to the right of the text 
box.

Over write
Auto-increment

Indicates whether to overwrite an existing text file or to increment the 
filename if a file with the same name already exists.

Output Items Selects the items to include in the text file from the following: Data File 
Properties, Compound Quantitative Result, Compound Search Result, 
Qualitative Peak Table, Column Performance Table, Spectrum 
Process Table, Spectrum Search Result, Chromatogram (TIC), 
Chromatogram (MIC), and Spectrum. Checked items are exported to 
the text file.

Delimiter Used to determine how to separate the information in the text file. The 
options include Tab, Comma and Other. If other is selected, enter the 
delimiter in the text box to the right.

Parameter Description
Output File (Text Style) Allows the entry of the full path name into the Output File text box, or 

filename selection by browsing for the appropriate directory and 
entering the name by clicking the Folder button to the right of the text 
box. The output files are tab delimited.

Merge File, Overwrite 
File, Auto-increment

Indicates whether to add to the file (Merge File), overwrite it (Overwrite 
File), or make new files by adding a number to the file name 
automatically, if a file with the same name already exists.

Output HTML Style 
File (<File name>.htm)

When checked, exports the QA/QC results to an HTML file in addition 
to text file output. The HTML file has the same name indicated in the 
Output File text box, with an ".htm" extension.

Output CSV Style File 
(<File name>.csv)

Selects whether to output CSV type files in addition. The CSV file has 
the same name indicated in the Output File text box, but with an ". csv" 
extension.
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Option Items Tab
The batch table can include up to five Option columns as established by the Table 
Style. If these Option columns are included, use the Option Items tab to give the 
column a title. Up to 31 characters may be entered. The title may be referred to in the 
data file properties or in the sample information of a report.

3. Click the Assistant Bar Wizard icon, and Batch Table Wizard is displayed.

Figure 7.5  Batch Table Wizard - Initial Screen

Batch Table Wizard - Initial Screen

Parameter Description

Batch Table Selecting New creates a new table. Append adds to the last row of the 
currently displayed batch table.

Batch Type Selects which Analytical Line to use in the Batch table. Some types cannot 
be entered depending on the system configuration.
Select from Line 1 & 2, or Line 1 or Line 2 only.

Sample Type Selects the type of samples that will be included in the batch.
• Choose Standard & Unknown when both standards and unknown 

samples will be included in the batch. After clicking the Next button, 
enter the standard, then unknown information. The standard rows will 
be placed before the unknown samples in the batch table. If 
Quantitative is selected for Data Processing under Method, a new 
calibration curve will be generated based on the standard analysis 
results. The calibration curve is saved in the method file. The updated 
method will be used for subsequent analyses, and the unknown sample 
analysis results are quantitated using that calibration curve.

• Select Unknown Only to create a batch table with unknown samples 
only. After clicking the Next button, the unknown sample parameter 
screen is displayed. Only unknown sample rows will be created in the 
batch table.
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After all of the parameters have been entered, click the Next button.
If Standard & Unknown or Standard Only is selected as the Sample Type, the Batch Table 
Wizard proceeds to the Standard Sample (1) screen. If Unknown Only is selected, the Batch 
Table Wizard proceeds to the Unknown Sample (1) screen.

Figure 7.6  Batch Table Wizard - Standard Sample (1) Screen

Method Allows the entry of the full path name into the Output File text box, or 
filename selection by browsing for the appropriate directory and entering 
the name by clicking the Folder button to the right of the text box. If a 
Method file is currently open in the "Data Acquisition" window, its Method 
file name is displayed by default. The method file indicated here is entered 
in the batch table by default, but a different file can be specified in the 
table.

Data Processing Specifies whether to perform quantitative and/or qualitative analysis. If 
Quantitative is checked, the Analysis Type will include Integration for 
Quantitative and Quantitative Calculations. If Qualitative is checked, the 
Analysis Type will include Integration for Qualitative, Make Spectrum 
Process Table, and Similarity Search.

Parameter Description
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Batch Table Wizard - Standard Sample (1)
This screen is displayed when "Standard & Unknown" or "Standard Only" is selected as the 
Sample Type in the first Batch Table Wizard screen.

After all parameters have been entered, click the Next button.

The Batch Table Wizard proceeds to the Standard Sample (2) screen.

Parameter Description

Vial # If an autosampler is used, enter the position number from the rack for the 
first standard vial. The text box to the right indicates the final vial position, 
calculated from the number of currently indicated calibration points. Ensure 
that the standard samples are correctly placed in the autosampler tray.
This parameter is needed only when an autosampler is used.

# of Calib The number of points in the calibration curve is determined from the 
method file and displayed as the default. This number can be changed in 
the Wizard. Changing the number of calibration points changes the final 
vial position indicated in Vial #.

Average Count Specifies the number of injections per standard vial. The total number of 
standard analyses is the # of Calib. multiplied by the Average Count.

Injection Volume Used to enter the injection volume. Once the Wizard is finished, the 
volume in each row of the batch table can be changed.

Sample Name Specifies a Sample Name for the standards. This parameter is used in 
combination with Sample ID to distinguish a particular file of samples and 
standards from others. This parameter is optional.

Auto-increment When Auto-increment is checked, the Sample Name is automatically 
incremented with a number, creating unique sample names for 
subsequent rows.

Sample ID Specifies a Sample ID. This parameter is used to distinguish samples and 
is useful when analyzing the same sample using different Methods or 
when the same Method is used for the analysis of several samples. This 
parameter is optional.

Auto-increment When Auto-increment is checked, the Sample ID is automatically 
incremented with a number, to create unique sample IDs for subsequent 
rows.
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Figure 7.7  Batch Table Wizard - Standard Sample (2) Screen

Batch Table Wizard - Standard Sample (2)
This screen is displayed when "Standard & Unknown" or "Standard Only" is selected as the 
Sample Type in the first Batch Table Wizard screen.

After the parameters are entered, click the Next button.

The Batch Table Wizard proceeds to the Unknown Sample (1) screen.

Parameter Description

Create Filenames 
Automatically

Specifies whether to automatically generate file names. This parameter 
can only be changed when a new batch table is created. When adding to 
an existing batch table, the current setting is indicated. Data file names 
cannot be defined when this parameter is checked.

Data File Name Specifies the data file name. Select Auto-increment to automatically 
increment the file extension. Each data file name must be unique.

Report Out Specifies whether to generate a report. If the item is selected, specify a 
Report Format file.

Report Format File When printing a report, this item specifies the Report Format file. The file 
folder icon may be used to browse for the Report Format file.

Data Description Allows a description to be entered in the data file, as desired.
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Figure 7.8   Batch Table Wizard - Unknown Sample (1) Screen

Batch Table Wizard - Unknown Sample (1)
This is the first Wizard screen to set up unknown samples in the batch table.

After entering the parameters, click the Next button.

The Batch Table Wizard proceeds to the Unknown Sample (2) screen.

Parameter Description

Vial # If an autosampler is used, enter the position number of the first sample 
vial. The text box to the right indicates the final vial position as calculated 
from the currently displayed Sample Count number. Ensure that the 
samples are correctly placed in the autosampler tray.
This parameter is needed only when an autosampler is used.

Sample Count Used to enter the number of unknown samples for which data is to be 
acquired. If there are no unknown samples, enter 0, the Next button 
changes to the Finish button and there are no further parameters to enter.

Injection Volume Used to enter the injection volume. Once the Wizard is finished, the 
volume in each row of the batch table can be changed.

Sample Name Specifies a Sample Name for the unknown samples. This parameter is 
used in combination with Sample ID to distinguish a particular file of 
samples and standards from others. This parameter is optional.

Auto-increment When Auto-increment is checked, the Sample Name is automatically 
incremented with a number, so that unique sample names are created for 
subsequent rows.

Sample ID Specifies a Sample ID. This parameter is used to distinguish samples and 
is useful when analyzing the same sample using different Methods or 
when the same Method is used for the analysis of several samples. This 
parameter is optional.

Auto-increment When Auto-increment is checked, the Sample ID is automatically 
incremented with a number, so that unique sample IDs are created for 
subsequent rows.
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Figure 7.9  Batch Table Wizard - Unknown Sample (2) Screen

Batch Table Wizard - Unknown Sample (2)
This screen is displayed if Unknown samples are entered into the Batch Table Wizard 
Unknown Sample (1) screen.

After entering the parameters, click the Finish button. The Batch Table Wizard closes and a 
batch table is generated.

When parameters for specific rows differ from the Wizard parameter entries, make the 
changes directly in the batch table.

Parameter Description

Create Filenames 
Automatically

Specifies whether to automatically generate file names. This parameter 
can only be changed when a new batch table is created. When adding to 
an existing batch table, the current setting is indicated. Data file names 
cannot be defined when this parameter is checked.

Data File Name Specifies the data file name. Select Auto-increment to automatically 
increment the file extension. Each data file name must be unique.

Report Out Specifies whether to generate a report. If the item is selected, specify a 
Report Format file.

Report Format File When printing a report, this item specifies the Report Format file. The file 
folder icon may be used to browse for the Report Format file.

Data Description Allows a description to be entered in the data file, as desired.
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Figure 7.10   Batch Table

4. Batch tables can be created and existing tables edited in the "Batch Table" window, 
without using the Batch Table Wizard.

If a batch table is created without the Wizard, the new table has only a single row 
initially. When the last row of the table is edited, a new, blank row is added 
automatically. A batch table can contain up to 1000 rows.
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Pop-up Menus
Right-click the cell of interest to display the relevant pop-up menu. Select the 
appropriate command in the menu. The available commands range from copying 
and pasting to editing the Table Style.

Figure 7.11  Right-click Menu

Sequential Entry
When information such as the vial number, sample name, sample ID, and data file 
are sequential for a number of rows, multiple rows can be entered by incrementing 
the information automatically. Highlight the appropriate column and select Edit > 
Input Col. Data. For example, to fill out the Sample ID column automatically, the 
following dialog box is displayed. 

Figure 7.12  Automatically Filing the Sample ID Column

In the pictured "Sample Name" dialog box, clicking the OK button enters sample IDs 
from test 001 to test 030 in lines 1 - 30.

Changing the Batch Table Columns
To hide or show table columns, or change the order in which they appear, open the 
"Table Style" dialog box with the Edit > Table Style command or select Table Style 
from the right-mouse menu.

For more information about batch tables, refer to GCMS Help.
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7.2.2 Performing Continuous Analysis

This section explains starting and stopping batch processing. Other batch table commands 
included on the Assistant Bar when in Batch Processing mode are also explained.

1. Start 
Click the Assistant Bar Start icon, Start toolbar button or select Batch > 
Start to initiate batch processing. Batch processing starts with the first row 
or the row indicated in the Settings Start Row tab.

2. Pause
To pause batch processing, click the Assistant Bar Pause/Restart icon or Pause/
Restart toolbar button, or select Batch > Pause/Restart. Continuous data 
acquisition and analysis is temporarily halted. Rows that have not been processed 
can be edited during the pause. The row currently being processed cannot be edited.

To resume processing, click the Assistant Bar Pause/Restart icon or 
Pause/Restart toolbar button, or select Batch > Pause/Restart again. 
Batch processing continues with the row on which it was paused.

3. Stop
To stop batch processing, click the Assistant Bar Stop icon or Stop toolbar 
button, or select Batch > Stop. Processing stops whether it is currently 
occurring or it is paused.

4. Edit Method
Click the Assistant Bar Method Development icon to edit a method file 
used by the batch table. The "Data Acquisition" window opens, and the 
method file, including the instrument parameters, selected in the batch 
table is displayed. Methods cannot be edited during batch processing.
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7.3 Automated Postrun Analysis

This section describes how data processing is automated in the GCMS Postrun Analysis 
application. For information about the qualitative and quantitative analysis parameters, refer 
to Chapter 4 "Qualitative Analysis" on page 111 and Chapter 5 "Quantitative Analysis" on 
page 137.

7.3.1 Creating a Batch Table

1. Open GCMS Postrun Analysis, and click the Assistant Bar Batch 
Processing icon. The "Batch Table" window is displayed.

Figure 7.13  "Batch Table" Window

Title Bar Menu Bar Toolbar Batch Table

Output WindowAssistant Bar Data Explorer
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2. Click the Assistant Bar Settings icon, and the "Settings" dialog box is 
displayed.

Figure 7.14   "Settings" Dialog Box

For more information about the "Settings" dialog box, refer to the second topic of 
Section 7.2.1 "Creating a Batch Table".

3. A batch table can be created automatically from data files. Click the Assistant Bar 
Select Data Files icon, and the "Select Data File" dialog box is displayed.

Figure 7.15   "Select Data File" Dialog Box

Select the file to use for data processing. Select multiple files by holding the control 
or shift keys down while clicking the files with the mouse. Select a file and click the 
Down arrow button to display that file in the text box below. Change the sequence of 
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the files by selecting a file in the bottom text box and using the Up or Down arrow 
button. The batch table is generated with the rows in the displayed order of the files 
selected. When Open is clicked, a batch table is generated from the sample 
information in the selected data files.

GCMS Postrun Analysis can open and modify batch files created in GCMS Real 
Time Analysis, however, parameters for data acquisition are not displayed, and only 
data processing can be performed.

7.3.2 Performing Continuous Postrun Analysis

1. Start 
Click the Assistant Bar Start icon or Start toolbar button, or select Batch > 
Start to initiate batch processing. Batch analysis starts with the first row or 
the row indicated in the Settings Start Row tab.

2. Stop
To stop batch processing, click the Assistant Bar Stop icon or Stop toolbar 
button, or select Batch > Stop. Processing stops if it is currently occurring.
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8  Quantitative Browser

8.1 Overview

In Quantitative Browser, the quantitation results of multiple data (concentration, area, 
height, etc.) are listed for each compound specified in Compound Table in the method file. 
The listed quantitation results are displayed after being statistically calculated (Average, 
%RSD, Max, Min, Standard Deviation) as they are needed. You can print out these results 
as summary reports.

8.1.1 Quantitative Browser Window

Quantitative Result View

Chromatogram View Calibration Curve View

Compound Table ViewTitle Bar Menu Bar
Tool bar

Assistant Bar Data Explorer

Title Bar
Displays currently used application names or process names and method 
file names. 

Menu Bar Displays various command menus of the displayed window.

Toolbar Displays buttons for the various command tools for the displayed window.

Assistant Bar Lists command icons corresponding to the general operation sequence.

Data Explorer Data file or method file can easily be opened by double-clicking on file icon.

Quantitative Result 
View

This view loads multiple data files and displays quantitative result (Conc. 
Area, Height, ...) as well as statistics (average, %RSD, maximum, minimum 
and standard deviation) in a table format.

Compound Table 
View

This view displays the Compound Table and Grouping Table of the currently 
loaded method file, as well as the Identification Result and Grouping Result 
of the data file selected on the Quantitative Result view.

Chromatogram 
View

In the data file selected on the Quantitative Result view, the ID 
chromatogram selected on Compound Table view is displayed.

Calibration Curve 
View

In the currently loaded method file, the calibration curve of compound 
which is selected on Compound Table view is displayed.
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8.2 The Main Operations in Quantitative Browser Window

8.2.1 Displays the List of the Quantitative Results of Multiple Data

The Quantitative Browser displays the quantitative results of multiple data which are 
calculated based on one single compound table. The compound table is loaded from the 
method file you directly specified, or from the method file used for the quantitation of the 
data file you loaded on Quantitative Browser.

1. To load a method file
(1) Click on the Method tab in Data Explorer. Data Explorer 

becomes the method file mode. 

(2) Double-click the icon of the method file to be loaded. All 
data files which constitute the calibration curves (Sample type: Standard) included in 
the method file are loaded automatically.

2. To load a data file
(1) Click on the Data tab of the Data Explorer. Data Explorer 

becomes the data file mode.

(2) Double-click on the appropriate data file.

3. To load a batch file
(1) Click on the Batch tab of Data Explorer. Data Explorer 

becomes the batch file mode. 

(2) Drag and drop the appropriate batch file to the Quantitative 
Browser. The Quantitative Result view searches for the row for which sample type is 
"Standard" in the batch file, and loads the method file for the first hit row and all data 
files which use the method file. If no such row is found on the batch file, the 
Quantitative Result view searches for the "Unknown" row, and loads the method file 
on the first hit row and all data files which use the method file.

Displays the list of the 
quantitative results of 
multiple data.

Displays peak integration and quantitative result as well as 
statistics in a table format. (Reference: 8.2.1 "Displays the List of 
the Quantitative Results of Multiple Data")

Executes peak 
integration/quantitation 
of multiple data 
simultaneously.

Executes peak integration/quantitation for all compounds of 
multiple data simultaneously. Moreover changes parameters for 
peak integration or identification or modifies the calibration curve. 
(Reference: 8.2.2 "Execute Peak Integration/Quantitation of 
Multiple Data Simultaneously")

Outputs the list of 
quantitation results as 
summary report.

Outputs the list of quantitative results and statistics as summary 
report. (Reference: 8.2.3 "Output the List of Quantitation Results 
as Summary Report")
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4. To switch data type 
In Quantitative Result view, you can extract and display its 
loaded data by their sample type, such as [Standard], 
[Unknown], [Control] and [Spiked]. You can also display [All] 
data despite of their sample type. These can be switched on 
the [Data Type] on the [View] menu or by pushing the 
buttons on the toolbar. 

5. To switch compounds for the list of quantitative results
On Quantitative Result view, the quantitative results are displayed for 
each compound on Compound Table view. To switch, select the desired 
compound on the ID spin button on the upper part of Quantitative Result 
view, or select the row of the compound on Compound Table view.

6. To sort all lines in the Quantitative Result view
Select the View > Quantitative Result > Sort by Filename menu, to sort all lines in 
the Quantitative Result view by filename.

7. To show/hide items on Quantitative Result view, or change the order
Select the View > Quantitative Result > Table Style command, to set the 
parameter in "Table Style" window.

   Note

[Standard] here means the data that constitutes the calibration curve in a method 
file. Even if the sample type of a data is actually standard, it is treated as [Unknown] 
if it does not constitute the calibration curve in the opened method file.

   Note

For the Standard sample on Quantitative Result view, you can display the 
difference between calculated concentration and set concentration on the same 
level on Compound Table.

   Note

The calibration curve of target compound is displayed on Calibration Curve view.
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8. Confirm the statistics
Statistics (average, %RSD, maximum, minimum, and standard deviation) are 
computed and displayed based on the data that is displayed in this view. You can 
execute statistic calculations for all cells other than data file name, sample name, 
sample ID, sample type, set concentration, level#, mark, and statistics.

8.2.2 Execute Peak Integration/Quantitation of Multiple Data Simultaneously

1. If you click on the Peak Integration for All Data in Assistant Bar, 
peak integration and quantitation for all compound IDs in all data 
files are executed.

2. To analyze only data file selected on Quantitative Result view, 
select the Process > Peak Integration > Peak Integrate for all IDs command.

3. To analyze only displayed ID in the selected data file on Quantitative Result view, 
select the Process > Peak Integration > Peak Integrate by ID command.

8.2.3 Output the List of Quantitation Results as Summary Report

1. Click on the Summary Report icon in Assistant Bar, then Report 
Editor window appears. (A report format has already been loaded.) 

2. To change the report format, double-click on the Summary 
(compound) item and edit on Summary (Compound) Properties 
window. When File > Save Format File As command is selected, your change is 
saved in the file named as "MS Report Quantitative Browser Report.qgr", and will be 
used for the next summary output.

3. If there is no need to change the format, click on the Print icon in 
Assistant Bar. The report will be printed out.
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8.3 Verify the Calibration Curve

The calibration curve view displays the calibration curve of the compound selected by the 
Param's or Results tab in the compound table. When the Group Param's or Group Results 
tab is displayed on the compound table view, only group calibration curves are displayed.

1. Modify the calibration curve
Click on the Modify Calibration Curve icon in Assistant Bar, 
"Calibration Curve" window opens.

The method file which is loaded in the "Quantitation Browser" 
window is automatically loaded.

Calibration points and points before averaging are displayed on the calibration 
curve view. Also on calibration curve, the reference lines are displayed to indicate 
the area of the peak identified in the date file selected in Quantitative Result view, 
and the calculated concentration. By these lines, you can easily verify which part of 
the calibration curve corresponds to the quantitation result.

REFERENCE
To add/delete the data file of standard sample to/from calibration point, refer to "5.3 
Creating Calibration Curves".

   Note

When you return to "Quantitative Browser" window from the "Calibration Curve" 
window, the browser automatically re-executes the quantitation for compound ID of 
all data files whose calibration curve were modified.
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8.4 Manual Peak Integration and Manual Peak 
Identification

The chromatogram view consists of the Single tab and the 
Sample Info. tab. Both tabs display the data file information 
selected on the quantitative result table.

On Single tab, chromatogram of selected compound on Compound table is displayed, and 
you can verify whether the target peak is detected or properly identified. The 
chromatograms (Max: 5) of the reference ions are overlaid with the target chromatogram. In 
addition, the table of the reference ions information is displayed below the chromatogram. 
For these chromatograms, you can manually specify peaks (Manual Peak Integration,) or 
change peaks to be identified (Manual Identification).

1. Manual Peak Integration
(1) Select the Process > Peak Integration > Manual Peak Integrate command. The 

cursor on the chromatogram changes to a vertical line, select the time range for the 
peak to use by dragging with the mouse. The select Base Line dialog box is 
displayed, and select how the base line should be drawn.

2. Manual Identification
(1) Select the Process > Manual Identification command. The cursor on the 

chromatogram changes to a vertical line, click in the peak area at the retention time 
to identify. The peak will then be identified. If the wrong peak has been identified, the 
identification can be changed by dragging the identification mark displayed on the 
peak in the chromatogram to the correct peak to be identified.

   Note

When manual peak integration is performed, the peak identification will also be 
performed automatically.
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8.5 Save the Layout of Quantitative Browser Window

You can save, loaded method file name, data file name, the information of selective 
(highlighted) data file /compound on Quantitative Result View/Compound Table View, as 
Browsing File (extension: *.qgq). By reloading this browsing file, you can easily restore the 
status of these files.

1. Select the Layout > Save Browsing File As command.

REFERENCE

For the using "Save File As" dialog box, refer to "2.9.2 Opening and Saving Files".

   Note

The position of the view, the size, the color information, etc. are saved for each user 
who can log on, instead of this browsing file.
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9  Data Browser

9.1 Overview

In the Data Browser, the chromatograms and spectra in multiple data files can be displayed 
simultaneously. The Data Browser window consists of the cells to display information. Each 
cell can display the chromatogram or spectrum loaded from a single data file, and by 
increasing cells, the information on a maximum of 64 cells are displayed simultaneously (8 
cells each in vertical and horizontal). By operating a cell, (zoom, changing retention time, 
etc.) you can co-execute the operation for chromatogram or spectrum on each of the cells. 
By removing focus pins, you can operate cells independently.

9.1.1 Data Browser Window

Title Bar
Displays the currently used application name, or process name and 
data file name.

Menu Bar Displays various command menus of the displayed window.

Toolbar Displays buttons for the various command tools for the displayed window.

Assistant Bar Lists command icons corresponding to the general operation sequence.

Data Explorer Data file can easily be opened by double-clicking on file icon.

Chromatogram Cell
Displays the chromatogram and its information with the specified group 
and mass (TIC, MIC, MC).

Spectrum Cell Displays the spectrum and its information at a specified retention time.

Sample Information 
Cell

Displays sample information (Method Filename, Acquired by, Date 
Acquired, etc.) of data file.

Cell
A cell can load one single data file. In Data Browser window, the 
information on a maximum of 64 cells are displayed simultaneously (8 
cells each in vertical and horizontal). 

Focus Pin Button
If the pin of the cell is pressed (indicated in green), the cell receives the 
information sent from other cell. 

Title Bar Menu Bar Chromatogram Cell
Spectrum Cell

Focus BarFocus Pin ButtonCell

Sample Information Cell

Assistant Bar Data Explorer

Tool bar
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9.1.2 Opens the Data File

1. Click on the Data tab in Data Explorer.

2. Double click the desired data. 
The "Select Data Type" window is opened.

3. Select the data type and the target cells.

4. The Data file is loaded in the specified cell.

Focus Bar
This is displayed for focused cell. Menu commands are valid for cells 
with the focus bar.

Parameter Description

Data Type
Chromatogram: Displays the chromatogram and chromatogram information.
Spectrum: Displays the spectrum and spectrum information.
Sample Information: Displays the sample information.

Target Cell

Load Data to Current Cell: 
      Loads into the currently selected cell. 
Open as New Cell: 
      Adds a new cell. 

Cell Location

Rightward:
Adds a cell for a column and displays. When Open as New Cell is selected, 
the browser adds the same number of columns as data files exist, and then 
loads the data files on the first row.
Downward: 
Adds a cell for a row and displays. When Open as New Cell is selected, the 
browser adds the same number of rows as data files exist, and then loads the 
data files on the first column.
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9.1.3 Changes the Cell Layout

Specify the number of cells displayed on the window.

1. Click on the Cell Arrangement icon in Assistant Bar. 
The "Cell Arrangement" window is opened.

2. The following setup is carried out.

Parameter Description

Cell Created

Divides the data browser into the number of cells specified here in a 
grid shape.
Row: 
Specifies the number of rows.
Col.: 
Specifies the number of columns. 

Scroll Mode
When checked, the horizontal or vertical scroll bar is displayed as 
necessary.

Cell Displayed
Specify the number of rows and columns displayed on the data 
browser at one time. Valid only when Scroll Mode is selected.



9.29.
9  Data Browser

206 GCMS-QP2010

9.2 Operation on Chromatogram Cell

This window displays the chromatogram with the specified group and mass (TIC, MIC, MC). 
The displayed chromatograms are determined on the fragment table. Chromatograms are 
either overlaid or in the stack display. When analysis is being performed with multiple 
groups (SIM ion sets), only the chromatogram for one of the groups is displayed. To change 
the group is performed by Next Group command or Previous Group command from View 
menu.

9.2.1 Sets the Displayed Chromatograms

The displayed chromatograms in Chromatogram cell are determined on the Fragment Table 
window.

1. Select the View > Fragment Table command, the "MS Fragment Table" is displayed. 

2. In the MS Fragment Table window, choose between displaying TIC, MIC, or None in 
the chromatogram window. In addition, specify MC m/z and magnification factors. 
When displaying the MIC chromatogram, MIC table needs to be set up beforehand. 
To edit the MIC table, click the Method > Data Load Format command. 

9.2.2 To Work with Other Cells

If you click a focus pin button, the pin is stuck (indicated in green), and by operating 
the cell, you can co-execute the similar operation for the other pin-stuck cells.

1. If you zoom a chromatogram, the chromatograms on the other chromatogram cell 
are also enlarged in the same Time and Intensity range.

2. If you double click on chromatogram, the spectrum corresponding to the retention 
time is displayed on spectrum cell.
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3. If you execute a spectrum calculation on chromatogram, the spectrum calculation 
within the same time range is also performed on the other chromatogram cells, and 
the calculated spectrum is displayed on each of the spectrum cells which has loaded 
the same data file.

9.2.3 To Change Display Range

1. To set the display range of chromatogram, drag on the 
chromatogram or click on the Display Settings icon in Assistant 
Bar.

2. If "Chromatogram Settings" window is opened, carry out the 
following setup.

   Note

If the retention time is in FASST measurement interval, the Scan spectrum is 
displayed.

Parameter Description

Display Mode Select Overlay or Stack.

Range Settings

When the Range Settings is checked, the range of the intensity axis 
and the time base will be specified. When the check is OFF, the 
chromatogram from the starting time of the analysis to the end on the 
current group will be displayed. Click on the Initialize button to 
normalize the X-axis and Y-axis.

Display 
Chromatogram 
Information

Select whether to display the chromatogram information.
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9.2.4 Print the Cell Image

1. To print a report, select the File > Print Image for Selected Cell command, the 
Report Editor window appears. (A report format has already been loaded.)

2. To change the report format, double-click items and edit on the property window. 
When File > Save Format File As command is selected, your change is saved in the 
report format file named as "Data Browser MS Chromatogram Report.qgr", and will 
be used for the next image printing of chromatogram cell.

3. If you have no need to change the format, just click on the Print 
icon in Assistant Bar. The report will be printed out.
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9.3 Operation on Spectrum Cell

This window displays the spectrum at a specified retention time.

9.3.1 To Display Spectrum within Specified Retention Time

1. Double-click on chromatogram cell at a retention time. In this case, focus pins need 
to be stuck both on Chromatogram cell and Spectrum cell. 

9.3.2 Subtracting Spectrum

1. Stick focus pin on Spectrum cell, and click on the Subtract Spectrum icon in 
tool bar. 

2. Stick focus pin on chromatogram cell, and double-click on the chromatogram on 
chromatogram cell to specify the retention time you need. Then the spectrum is 
subtracted, and the result is displayed on spectrum cell.

9.3.3 To Execute Similarity Search for Spectrum

1. Select the Process > Similarity Search for Current Spectrum command.
If the library file name is not specified to use for similarity search, set on the Similarity 
Search tab in Qualitative Parameters and select the Process > Similarity Search 
for Current Spectrum command.

REFERENCE

About the averaging the spectrum or subtract averaged spectrum, refer to "4.2.2 
Averaging the Spectrum and Background Processing".
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2. The "Similarity Search Results" window will be open.
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9.3.4 To Work with Other Cells

If you click a focus pin button, the pin is stuck (indicated in green,) and by 
operating the cell, you can co-execute the similar operation for the other pin-stuck 
cells.

1. If you enlarge a spectrum, the spectra on the other spectrum cells are enlarged in the 
same m/z and Intensity range.

2. If you double-click on spectrum, the mass chromatogram of the m/z is displayed on 
chromatogram cell of scan data.

9.3.5 To Change Display Range

1. To set the display range of spectrum, drag on the spectrum or click 
the Display Settings icon on Assistant Bar. 

2. If "Spectrum Settings" window is opened, carry out the following 
setup.

Parameter Description

Range Settings

When the Range Settings is checked, the range of the intensity axis and 
the m/z axis will be specified. When the check is OFF, the spectrum from 
the starting m/z of the analysis to the end on the current group will be 
displayed. Click on the Initialize button to normalize the X-axis and Y-axis.

Display Spectrum 
Information

Select whether to display the spectrum information.
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9.3.6 To Print the Image of a Cell

1. To print a report, select the File > Print Image for Selected Cell command, then 
Report Editor window appears. (A report format has already been loaded.)

2. To change the report format, double-click items and edit on the property window. 
When File > Save Format File As command is selected, your change is saved in the 
report format file named as "Data Browser MS spectrum Report.qgr", and will be 
used for the next image printing of spectrum cell.

3. If you have no need to change the format, just click on the Print 
icon in Assistant Bar. The report will be printed out.
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9.4 Save the layout in Data Browser Window

On Data Browser, you can save the information of each cell such as data file name, data 
type, cell position, etc. as layout file (*.lyt). By opening this layout file, you can easily reload 
the series of data files relating to each of the cells.

1. Select the Layout > Save Layout File As command.

REFERENCE

For the using "Save File As" dialog box, refer to "2.9.2 Opening and Saving Files".
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10  Maintenance

10.1 Precautions

Read and follow the following MS maintenance precautions to ensure optimal MS 
performance and prevent accidents.
Shut down all modules including the MS before performing GC maintenance as described 
in the GC user manual.

   WARNING

1. Follow all relevant precautions when performing a maintenance operation.
2. Wear clean gloves when working on the ion source box or interior of the mass 

spectrometer.
3. Use clean tools to disassemble parts. Contaminants from dirty tools or gloves 

can generate background noise. Clean any tools used inside the mass 
spectrometer with a lint-free cloth and acetone.

4. Place parts on a clean cloth as they are removed, to ensure that they remain 
clean.

5. Take note of how the parts are assembled to ensure correct re-assembly.
6. Operations that require opening the power unit or moving the MS should be 

performed by a Shimadzu representative. Only changing columns and minor ion 
source box maintenance should be performed by the user.
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10.2 Filament Replacement

The filament can burn out after extended use or by a decrease in vacuum level. This section 
describes changing the filament. Follow these precautions when performing this procedure.

Figure 10.1  Ion Source Box Diagram

   WARNING

Electric shock hazard. Turn off the instrument and confirm that the main switch is off. 
Confirm that the circuit breaker for the instrument is off.

   WARNING

The ion source and interface are usually heated during operation. Before maintenance, 
allow the instrument to cool for at least 10 minutes once it has been turned off.

Filament 1

Interface

Hook

Filament 2
Ion Source

Pt Sensor 
Terminals
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Terminals

Repeller 
Terminal

Filament 1 
Terminals

Heater Terminals

Lens 
L2
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10.2.1 Filament Replacement Procedure

1. Turn off the instrument as described in Section 2.4.2 "Shutting Down the 
Instrument", page 26.

2. Confirm that the main instrument switch is off.

3. Confirm that the circuit breaker for the instrument is off.

4. Rotate the knob and open the front panel.

5. Disconnect the filament by pulling the lead connectors from the lead pins (1).

6. Loosen the retaining nut (2) and pull out the filament (3).

Figure 10.2  Ion Source

7. Completely insert the new filaments and tighten the nut.

8. Reconnect the filament leads by pushing the lead connectors onto the lead pins.

1 Lead Pins

3 Filament

2 Filament Retaining Nut

3 Filament
(255-10197-91)

2 Filament Retaining Nut

1 Lead Pins

   Note

Precautions during filament installation:
1. Insert the filament completely.
2. Do not allow the filament leads to contact any other part when the filament is 

seated.
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10.3 Cleaning the Ion Source Box and Repeller Electrode

The function of the ion source is to bombard a sample with electrons, causing ionization and 
therefore the production of ions. Consequently, the source parts become contaminated over 
time. When the ion source box or repeller electrode are contaminated, the generated ions 
are not produced effectively, decreasing sensitivity. Remove and clean the ion source box 
periodically.

   WARNING

Electrical shock hazard. Turn off the instrument and confirm that the main instrument 
switch and circuit breaker are off.

   WARNING

Exercise caution when handling the organic solvent used to clean the ion source box. 
Provide proper ventilation in areas where organic solvent is used.

   WARNING

The ion source and interface are usually heated during operation. Before maintenance, 
allow the instrument to cool for at least 10 minutes once it has been turned off.

   WARNING

There is a risk of burns because the ion source box and repeller electrode are still hot 
after drying/baking. Make sure that parts cool sufficiently before maintenance.
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10.3.1 Removing the Ion Source Box and Detaching the Repeller Electrode

Figure 10.3  Ion Source Box Diagram after the Filaments Have Been Removed

1. Shut down the instrument according to Section 2.4.2 "Shutting Down the 
Instrument", page 26.

2. Confirm that the main instrument switch is off.

3. Confirm that the instrument circuit breaker is off.

4. Rotate the knob and open the front panel.

5. Carefully pull the lead connector from the pin of the repeller electrode in the figure 
above with forceps.

6. Screw the jig for attaching/detaching the ion source box into the threaded hole on the 
box.

7. Loosen the retaining screws (3) that supports the ion source box by a half turn.

3 Retaining Screw
4 I/F Cap

Interface

1 Pin
2 Jig Screw Hole

5 Hook
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8. Push the interface cap (4) to the right, and rotate the hook (5) downward.

Figure 10.4  Positioning the Hook

9. Loosen the retaining screws (3) and detach the box.

10. Detach the jig and separate the box and repeller.

11. Loosen the nut with the wrench and detach the repeller electrode.

12. Clean according to Section 10.3.3 "Cleaning the Ion Source Box and Repeller 
Electrode", page 223.

About 1 mm
(When Mounting Ion Source)

Hook Position When 
Replacing Ion Source

Hook Position When 
Detaching Ion Source
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10.3.2 Re-Assembling the Ion Source Box and Repeller Electrode

Figure 10.5  Ion Source Box and Attachment Jig

1. Place the repeller electrode in the ion source box and adjust so that the repeller is 
positioned in the center of the ion source box.

Figure 10.6  Positioning the Repeller Electrode

2. Install the parts in the ion source box as shown in the diagram. (Figure 10.5 "Ion 
Source Box and Attachment Jig") Use the two retaining screws to temporarily hold 
the parts in place.

3. Attach the installation jig to the ion source box.

Nut
(023-04020)

Spring Washer
(023-77020)

Washer
(023-66120)

Insulator
(225-01068)

Ion Source Box Retaining Screw
(Screw: 225-10236-01
Washer: 023-66030)

Plate
(225-10249)

Insulator
(225-01068)

Ion Source Box
(225-10445)

Repeller Electrode
(225-10255)

Spacer
(225-10312)

Box Attachment Jig
(225-10194-91)

The smaller circle is centered 
inside the larger circle.
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4. Push up the hook on the interface cap, and attach it onto the box.

Figure 10.7  Positioning the Hook

5. Adjust the jig vertically so that the interface cap is completely inserted into the box.

6. Detach the jig and tighten the two retaining screws used to hold the parts in place. 
The left screw should be tightened first.

7. Attach the repeller lead connector.

About 1 mm
(When Mounting Ion Source)

Hook Position When 
Replacing Ion Source

Hook Position When 
Detaching Ion Source

   Note

1. Verify that the cap at the end of the interface is seated firmly in the hole on the 
ion source.

2. Ensure that the repeller electrode lead connector is attached.
3. Verify that the ion source is seated straight.

   Note

Precautions for reassembly of the ion source box and lens 1.
1. Do not use excessive force to tighten the screws; this could bend the lens or 

break the insulating parts.
2. Use a circuit tester to ensure that the repeller electrode and the ion source box 

are insulated.
3. Do not clean the insulator parts. New parts can be purchased if the parts are 

contaminated.
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10.3.3 Cleaning the Ion Source Box and Repeller Electrode

1. Polish parts with abrasive paper. Refer to Section 10.3.4 "Required Materials", page 
223.

Figure 10.8  Cleaning the Ion Source Box and Repeller Electrode

10.3.4 Required Materials

1. Abrasive paper
• P/N 085-35124-02 (general finishing, 20 sheets)
• P/N 085-35124-03 (extra-fine finishing, 20 sheets)
If parts are extremely contaminated, polish with general finishing paper followed by 
extra-fine finishing paper. If parts are only slightly contaminated, polish with extra-fine 
finishing paper only.

   Note

Precautions for polishing the ion source box and repeller electrode:
1. Be careful not to bend the electrode when polishing it.
2. Remove dust from the surface with a clean compressed air source.
3. Perform ultrasonic cleaning in acetone or petroleum ether.
4. Dry for about 30 min at 90 - 120 °C. When analyzing trace amounts or easily 

adsorbed compounds, bake at 400 °C for an hour in a commercially available 
furnace.

5. Store the dry ion source box and repeller in a clean box.

Remove dust from surface

Polishing
Acetone 
(Petroleum 
Ether)

Drying

Ultrasonic 
Cleaning
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10.4 Vacuum Pump Maintenance

This section describes how to change the rotary pump oil and replace the lubricant for the 
main turbomolecular pump. The rotary pump oil is still hot after shutting down the system. 
Wait at least 10 minutes before performing maintenance.

10.4.1 Changing the Rotary Pump Oil

The rotary pump (model E2M1.5) requires an oil change every 3000 hours. The oil must be 
changed to prevent vacuum level deterioration, oil leaks and excessive noise.

The oil must have the proper characteristics for the pump. Use only pure oil of the following 
specification: Rotary pump oil Ultragrade 15 1L (P/N 017-30163-11).

Oil Change Procedure

Figure 10.9  Rotary Pump

   WARNING

Danger of serious burns. The rotary pump oil is hot immediately after shutdown. Wait at 
least 10 minutes before performing maintenance.

Vacuum Port

Oil Filler Plug

Exhaust Port

Oil Gauge

Drain Plug

Motor
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1. Shut down the instrument according to "Shutting Down the Instrument" in 
Section 2.4.2 "Shutting Down the Instrument", page 26.

2. Wait at least 10 min.

3. Turn the rotary pump motor switch off.

4. While using an appropriate container and wearing rubber gloves remove the drain 
plug and drain the oil. Use caution: Oil will be discharged when the drain plug is 
removed.

5. When the oil has finished draining, replace the drain plug temporarily and turn the 
motor switch on.

6. Click the Assistant Bar Vacuum Control icon to open the "Vacuum Control" 
dialog box.

Figure 10.10   "Vacuum Control" Dialog Box

7. Click the Advanced button in the lower part of the window to access the manual 
operation system. Click the Start button of the rotary pump adjacent to the Rotary 
Pump oil replacement item in the Vacuum System group.

Figure 10.11  "Advanced Vacuum Control" Dialog Box

8. Leave the rotary pump on for 5 - 10 sec. The pump will operate, discharging the 
remaining oil inside the pump.

9. Click the rotary pump Stop button in the "Vacuum Control" dialog box.
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10. Turn the rotary pump motor switch off.

11. Remove the drain plug, and drain the remaining oil.

12. Close the drain plug, and remove the oil filler plug. Add fresh oil until the oil reaches 
the MAX mark on the oil gauge (about 0.28 L).

13. Replace the oil filler plug.

10.4.2 Changing the Lubricant for the Turbomolecular Pump

The turbomolecular pumps installed in some GCMS-QP2010 models need to have the 
lubricant replaced. The QP2010 models for which replacement of the lubricant is necessary 
are shown in the following table (If the standard turbomolecular pump provided in the 
QP2010 has been replaced with that of another model, this may make replacement of the 
lubricant necessary in some cases even if the QP2010 model is not listed as an applicable 
model in the table). Please contact your service representative when you need to replace 
the lubricant.

xx=24, 34, 37, 39, 91 or 92

   Note

In addition to the oil changing procedure, pump overhaul should be performed 
every 1500 hours. Refer to the E2M1.5 user's manual.

Frequency of replacement of 
lubricant

Parts number of QP2010

Not necessary 225-10000-xx, 225-10001-xx, 225-10002-xx
225-10005-xx, 225-10006-xx, 225-10007-xx
225-10040-xx, 225-10041-xx, 225-10042-xx
225-10085-xx, 225-10086-xx, 225-10087-xx
225-10003-xx

Every 1 to 1.5 year 225-10080-xx, 225-10081-xx, 225-10082-xx
225-10090-xx, 225-10091-xx, 225-10092-xx

   Note

It is recommended that turbomolecular pump overhaul is performed every 
25000 hours.
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10.5 Cleaning the Fan

The fan and fan guard must be periodically cleaned.

10.5.1 Cleaning the Fan

1. Shut down the instrument according to the procedure described in Section 2.4.2 
"Shutting Down the Instrument", page 26. Ensure that all of the power switches are 
off.

2. Vacuum dust from the vents of the MS.

3. Vacuum dust from the fan and fan guard on the back of the gas chromatograph (GC).

4. Vacuum dust from the vents of the personal computer (PC) system and any other 
instrument modules, such as the autosampler.

   Note

Do not use the instrument if dust has accumulated on the fan or fan guard. 
Insufficient cooling could compromise performance.

   WARNING

To prevent injuries or accidents when cleaning the fan and fan guard, ensure that 
instrument is shut down and verify that all power switches are off.
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10.6 Checking for Leaks

This section describes how to check the instrument for leaks. If an air leak is clearly present, 
locate the leak as described in Section 10.6.2 "MS Vacuum Leak Check", page 232, and 
take corrective measures.

Operating an instrument with an air leak can cause a decrease in sensitivity, an increase in 
noise, filament burnout or other problems. Always check for leaks after performing 
maintenance.

A GC leak will have different symptoms than an MS leak. Normally, carrier gas will leak from 
the system if there is a GC leak, while air will be drawn into the system when there is an MS 
leak. To check for GC leaks, refer to Section 10.6.1 "GC Carrier Gas Leak Check", page 
228. To check for MS leaks, refer to Section 10.6.2 "MS Vacuum Leak Check", page 232 
and Section 10.6.3 "Vacuum Leak Check Using Peak Monitor", page 233.

10.6.1 GC Carrier Gas Leak Check

To check for GC carrier gas leaks, a blank plug (vespel ferrule filled with wire) is installed in 
the injection port column connection, and the split and purge vents are sealed with a blank 
nut. This seals the carrier gas in the injection port flow line, the carrier gas flow line, and the 
split and purge gas flow lines. Leaks are detected by observing the change in pressure of 
the sealed carrier gas over time. Changes in carrier gas pressure are observed by 
monitoring flow from the GC-2010 Keypad and Display Panel.

1. Shut down the instrument according to Section 2.4.2 "Shutting Down the 
Instrument", page 26. Turn the MS power source off, but leave the GC-2010 power 
source on.

2. Open the GC oven, and remove the column on the injection side.

3. Install the blank plug in place of the column in the injection port.

4. Install G-type blank nuts in the vents for the split and purge gas, respectively.

Figure 10.12  Flow Path Diagram

5. Ensure that the carrier gas supply pressure (cylinder pressure) exceeds 350 kPa.

6. On the GC-2010 "Flow key" screen, set the Injection mode to "Direct" and the Control 
mode to "Pressure."

7. Set the injection pressure at 350 kPa, press ON/OFF (PF Menu) and turn on the 
AFC.

CARRIER IN

PURGE VENT

SPLIT VENT
ESC 
(Split Control Valve)

Trap

Trap

Molecular Sieve

AFC
Flow Rate 
Sensor

TFC
(Total Flow Control Valve)

Pressure 
Sensor

SPC
(System Purge 
Control Valve)

Column Inlet 
Pressure Sensor
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8. Wait 5 minutes and verify that the injection pressure is between 300 and 400 kPa. If 
the pressure is above 400 kPa, loosen the column nut slightly and let the pressure 
decrease. If the pressure is below 300 kPa, increase the injection pressure slightly.

9. Verify that the total flow is below 2 mL/min. A total flow greater than 2 mL/min 
indicates a carrier gas leak.

10. Press ON/OFF (PF Menu) on the "Flow key" screen and turn off the AF Control.

11. Allow pressure to stabilize after turning off the AF Control.

12. Verify that the pressure does not decrease by more than 30 kPa per hour. A pressure 
decrease exceeding 30 kPa per hour indicates a leak.

13. While the carrier gas is sealed under pressure, possible leaks can be checked by 
using an electronic gas leak detector (available commercially) at the connections for 
each flow path, such as the G-type nuts and injection port nuts.

14. When a leak is detected, tighten the part or remove it and inspect for problems. 
Replace the three aluminum spacers when a G-type nut is removed.
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15. If a leak was detected because of a pressure decrease after step 14, replace the 
injection port septum, and verify that the O-ring is properly installed on the glass 
insert in the injection port. Repeat the pressure leak test described in steps 8 - 12.

Figure 10.13  Top of Injection Port Assembly

16. If a leak is detected after step 15, tighten the nuts of the injection port assembly, and 
repeat the pressure leak test described in steps 8 - 12.

17. If a leak continues to be detected, the leak is probably located in the flow lines of the 
carrier gas, split or purge vents. Tighten connections (1) - (7) in the flow path 
diagrams shown in Section 10.6.1 "GC Carrier Gas Leak Check", page 228, or 
remove the parts and check for problems. Replace the three aluminum spacers when 
a G-type nut is removed.

18. Repeat the pressure leak test described in steps 8 - 12.

Injection Port Nut

Glass Insert Nut

Injection Port

Septum 
Nut

Needle 
Guide

Septum

Injection 
Port

   Note

Precautions for sealing GC carrier gas under pressure:
1. Ensure that there are no leaks after disassembling and reconnecting a G-type or 

M-type nut.
2. Replace the three aluminum spacers when a G-type nut is removed.
3. Do not touch any GC parts other than the injection port connections and parts (1) 

- (7) of the flow path diagram of Section 10.6.1 "GC Carrier Gas Leak Check", 
page 228. Contact your Shimadzu Service Representative for maintenance in 
other areas.
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Procedure for Pressure-Sealing Carrier Gas

Figure 10.14  Procedure for Pressure-Sealing Carrier Gas

No Leaks

Septum was leaking 
or graphite ferrule 
was not properly 
installed.

Injection Port nut was 
leaking.

Flow line connection 
was leaking.

Install blank nuts in split 
and purge vents, and seal 
carrier gas under pressure.

Change septum, check 
installation of graphite 
ferrule, and seal carrier 
gas under pressure.

Tighten injection port 
assembly nuts, and seal 
carrier gas under pressure.

Tighten connections (1)-(7) 
in the flow path diagram of 
Section 10.6.1, "GC Carrier 
Gas Leak Check" and seal 
carrier gas under pressure.

Contact your Shimadzu 
representative.

No Leak

Leak
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10.6.2 MS Vacuum Leak Check

This section describes MS vacuum leak check procedures. Leaks can be large enough to 
take the rotary pump off-line, or small enough to allow the turbomolecular pump to function 
almost normally.

Ensure that the O-ring is properly installed on the MS door. The O-ring seals the connection 
between two surfaces, preventing vacuum leaks and maintaining the proper vacuum in the 
MS.

When the MS door is opened to perform maintenance, observe the following precautions to 
avoid leaks.

   Note

Observe the following precautions to prevent vacuum leaks:
• Do not forget to install the O-ring.
• Install the O-ring properly.
• Remove any foreign material from the O-ring.
• Remove foreign material, including pieces of O-ring, from sealing surfaces.
• Do not scratch sealing surfaces.
• Do not forget to install the Vespel ferrule where the column connects to the interface.
• Firmly tighten the column interface nut.
• Change the GC septum on a regular basis (around 80 to 100 injections).

If the rotary or turbomolecular pumps are not functioning properly:
1. The sound of air exhausting from the rotary pump does not diminish after a few 

minutes.
2. The turbomolecular pump operates, but the vacuum system power shuts down 

after about 5 minutes.
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If the situation in step 2 occurs, a vacuum leak is indicated. Wait for the MS to vent, then 
check the front door and the connection between the column and interface according to the 
above precautions for preventing vacuum leaks. If a vacuum leak occurs in a location other 
than the front door or connection between the column and interface, contact your Shimadzu 
Service Representative.

Figure 10.15  Front Door and Sealing Surfaces

10.6.3 Vacuum Leak Check Using Peak Monitor

Vacuum leaks too small to prevent proper operation of the instrument can still affect the 
instrument performance. This section describes the procedure for checking for those leaks. 
The operations described in this section can be used provided that the instrument and 
turbomolecular pump are functioning properly and the Turbo Pump light is green in the 
"Vacuum Control" dialog box.

This method monitors the water (m/z 18) and nitrogen (m/z 28) peaks from the "Peak 
Monitor" window. The height of these two peaks is compared to check for small vacuum 
leaks.

1. Click the GCMS Real Time Analysis Assistant Bar Tuning icon. The 
"Tuning" window opens.

2. Click the Assistant Bar Peak Monitor View icon. This opens the "Peak 
Monitor" window.

Front Door and Seal Surface
- Attach O-ring Properly
- Remove Any Debris Adhering to O-ring
- Do Not Forget to Attach the O-ring

Do not scratch 
the seal surface.



10  Maintenance
10.6 Checking for Leaks

234 GCMS-QP2010

3. Set the m/z of the ions to be monitored to 18 (water) and 28 (nitrogen), or choose the 
Water, Air Monitor Group.

4. Set the detector voltage to about 1.00 - 1.50 kV so that the peaks for m/z 18 and m/z 
28 are visible.

5. Turn on the filament.

6. Compare the peak heights for m/z 18 and m/z 28. If the height of m/z 28 is more than 
twice that of m/z 18, a vacuum leak is indicated.

7. When a vacuum leak is detected, shut down the instrument according to 
Section 2.4.2 "Shutting Down the Instrument", page 26. Turn off the main instrument 
switch.

8. Follow the precautions for vacuum leak prevention described in Section 10.6.2 "MS 
Vacuum Leak Check", page 232.

   Note

If an optional accessory for sample introduction is connected, the vacuum leak 
check may not meet standards, even if there is not leakage in the GC/MS.
Insufficient purging may result in a high 28 m/z to 18 m/z ratio. When this occurs, 
increase the total flow of the GC to around 200 mL/min to purge.
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10.6.4 Vacuum Check using Petroleum Ether

This procedure is based on the suction produced when a vacuum leak occurs in the MS. If 
there is a leak, the petroleum ether applied to the contact surface between the column and 
the interface will be detected at that time in the "Peak Monitor" window, by the m/z 43 peak. 
The vacuum check is performed by monitoring the fluctuations of this m/z 43 peak.

1. Click on the Tuning icon in the GCMS analysis assistant bar. The "Tuning" 
window opens.

2. Click on the Peak Monitor View icon in the Assistant bar to open the "Peak 
Monitor" window.

3. Set the m/z for the ion to be monitored in the "Peak Monitor" window to 43 
(fragment ion of petroleum ether). Set the magnification factor to 50 - 100.

4. Set the detector voltage to 1.00 - 1.50 kV.

5. Turn on the filament.

6. Fill a syringe with petroleum ether.

7. Apply petroleum ether to the contact surfaces of the front door and between the 
column and interface. 

8. Observe the m/z 43 peak in the "Peak Monitor" window. If the m/z 43 peak fluctuates 
greatly (increases), there is vacuum leak at the petroleum ether application site. 

9. Repeat the procedures described in steps 7 and 8. If there is no change in the m/z 43 
peak, there is no leak.

10. If a vacuum leak has been detected, follow the precautions for vacuum leak 
prevention described in Section 10.6.2 "MS Vacuum Leak Check", page 232.

   Note

Precautions when Performing Vacuum Leak Check with Petroleum Ether
1. Use only petroleum ether.
2. Do not spill petroleum ether on any electronics. 
3. Do not allow petroleum ether to contact any site other than contact surface 

between the interface and column.
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10.7 Software Installation

This section describes reinstallation of GCMSsolution when this or other applications are 
not functioning properly.

10.7.1 Before Installation

Check the following items before installing the software.

Installation Disks
The installation program is provided on CD-ROM.

This program decompresses program files stored on the CD-ROM and copies them to the 
PC hard drive during installation.

Windows Installation
Windows 2000, Windows XP or Windows Vista is required.

On a new PC, check to make sure that Windows has been installed on the PC hard drive 
and is functioning properly. 

Internet Explorer version 3.02 or higher is required.

10.7.2 GCMSsolution Installation

1. Start the PC and log in to Windows. Place the GCMSsolution installation disk in the 
CD-ROM drive.

If the "Found New Hardware Wizard" window is displayed after starting Windows, 
click the Cancel button and close the window. This means that the driver for MS is 
not installed in the PC. Install the driver after the GCMSsolution Installation. Refer to 
Section 10.8.4 "Installation of the Driver for MS (Windows 2000)", page 254.

GCMSsolution Setup launches automatically, and the "Welcome" window is 
displayed.

For Windows Vista, the dialog box "A program needs your permission to continue" 
may be displayed. In this case, click the Continue button to proceed.

   Note

The software cannot be installed by copying the contents of the CD-ROM to the 
hard disk of the PC. Installation must be performed by the method described here.

   Note

If the GCMSsolution software is being reinstalled, first uninstall the GCMSsolution 
software. Refer to Section 10.7.3 "GCMSsolution Uninstall", page 242.
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Figure 10.16  "Welcome" Window

2. Read the contents of the "Welcome" window, then click the Next button.

The "Detecting Internet Explorer" window is displayed.

Figure 10.17  "Detecting Internet Explorer" Window

   Note

If the "Welcome" window does not open automatically, select Run from the 
Windows Start menu. For Windows Vista, select the Start menu > All Programs > 
Accessories > Run. Enter E:\ GCMSsolution\Setup.exe as the name of the 
program to execute (where E: is the CD-ROM drive), and click the OK button.

   Note

When the OK button in the "Welcome" window is clicked, and the Fail to detect 
DAO message is displayed, click the OK button to stop the installation. Refer to 
Section 10.7.4 "DAO Installation", page 245, and after installation of "Data Access 
Objects (DAO) Setup", try installing GCMSsolution again.
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3. Click the OK button in the "Detecting Internet Explorer" window.
The screen switches to the "Installing HTML Help" window.

Figure 10.18  "Installing HTML Help" Window

4. Select Yes and click the Next button.
The "User Authentication Mode Select" window is displayed.

Figure 10.19  "User Authentication Mode Select" Window

5. Specify the user authentication mode. When not using the CLASS-Agent, select 
"User Database in GCMSsolution". When using the CLASS-Agent, select an 
arbitrary user authentication mode by referring to Section "2.9.4, 3. Using Shimadzu 
User Authentication Tool".
The "Do you want to use the GC detector?" window is displayed.

Figure 10.20  "Do you want to use the GC detector?" Window
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6. The installation of GCsolution starts after clicking the Yes button. If the No button is 
clicked or the installation finishes, the screen returns to GCMSsolution Installation. 
The "User Information" window of GCMSsolution is displayed.

Figure 10.21  "User Information" Window

7. Enter the User Name and Company in the "User Information" window. Then click the 
Next button.
The "Choose Destination Location" window is displayed.

Figure 10.22  "Choose Destination Location" Window

8. The GCMSsolution application will be installed in the Destination Folder indicated in 
the "Choose Destination Location" window. The default directory is commonly 
selected.

   Note

To change the destination folder, click the Browse button of the "Choose 
Destination Location" window.
The "Choose Folder" dialog box opens.
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Figure 10.23  "Choose Folder" Dialog Box

Enter the full path in the Path text box, or double click the Folder list box to select the 
installation folder.

To change the drive, click the Drive box and select the drive.

Click the Next button, and the "Copying Program Files" status message is displayed. 
The program files are installed.

Figure 10.24   "Copying Program Files" Status Message

   Note

This note is applied in either of the following cases:
• While using Windows XP Professional as the OS, multiple users, including limited 

users (members of the Users group) or members of the Power Users group, share the 
GCMSsolution.

• While using Windows Vista as the OS, multiple users share the GCMSsolution.

In the conditions above, measurement data or method files created by a Windows 
user may be unavailable to other Windows users. This is because (1) default 
security settings for newly created folders are more strict in Windows XP, and (2) 
the user account control (UAC) functions introduced in Windows Vista effects the 
relevant operation. To avoid the problem, the GCMSsolution automatically changes 
the security settings for the installation folder and its subfolders during installation, 
so that all Windows users can share the data files, method files and so on.

Therefore, if you newly create a data folder in any place other than the Data folder 
(or its subfolders) designated during installation, you may become unable to create 
subfolders or save files in that data folder, or files may become unavailable to other 
users. In such cases, change the appropriate security settings for the folder 
created, using the Windows system functions.
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Figure 10.25  "Exit Setup" Dialog Box

To resume installation, click the Resume button.

To stop the installation, click the Exit Setup button. Installation is stopped, and 
GCMSsolution Setup exits.

9. When installation is completed, the "Setup Complete" window opens.

Figure 10.26  "Setup Complete" Window

10. Click the Finish button in the "Setup Complete" window. The "Setup Complete" 
window closes. GCMSsolution setup is completed.

Power to the GC, MS and all other accessories can be turned back on.

   Note

To stop the installation, click the Cancel button.
The "Exit Setup" dialog box is displayed.
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10.7.3 GCMSsolution Uninstall

Figure 10.27  Windows Start Menu

1. From the Windows Start menu, select Control Panel. The "Control Panel" window 
opens.

Figure 10.28  Windows Control Panel

2. Double-click the Add/Remove Programs icon.
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The "Add/Remove Programs" window opens.
For Windows Vista, switch Control Panel to Classic View, and double-click 
Programs and Features.

Figure 10.29   "Add/Remove Programs" Window

3. Click to select "GCMSsolution Ver. 2" from the list box at the bottom of the Currently 
installed programs tab. Click the Change/Remove button.

If GCsolution has been installed, uninstall it as well. The procedure is the same as 
that for GCMSsolution.

4. The "Confirm File Deletion" message is displayed. Confirm that the program should 
be removed, or cancel by clicking the No button.

Figure 10.30  Confirm File Deletion Message
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Figure 10.31  "Remove Shared File?" Dialog Box

When the Yes to All button is clicked, all shared files not used by the system will be 
deleted. Click the Yes button to delete the currently displayed file.

Figure 10.32  "Remove Shared Files?" Confirmation

The "Remove Programs From Your Computer" dialog box is displayed, and 
GCMSsolution program files are removed.

Figure 10.33  "Remove Programs From Your Computer" Dialog Box

   Note

During the uninstall, the "Remove Shared File?" dialog box asks whether to remove 
shared files. All files indicated here are not used except by GSMSsolution; 
therefore, click the Yes To All button.
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5. When the uninstall procedure is completed, the OK button of the Remove Program 
From Your Computer status box becomes active. Click the OK button to complete the 
GCMSsolution uninstall process.

10.7.4 DAO Installation

1. Double-click the Add/Remove Programs icon in the "Control Panel" 
window to open the "Add/Remove Programs" dialog box.
For Windows Vista, click "Uninstall a program".

Figure 10.34   "Add/Remove Programs" Window

2. Click the Add New Programs button and then click the CD or Floppy button.
The "Install Program From Floppy Disk or CD-ROM" window is displayed.

Figure 10.35  "Install Program from Floppy Disk or CD-ROM" Window

   Note

To reinstall GCMSsolution after un-installing it, first, restart your computer before 
reinstalling GCMSsolution.
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3. Click the Next button in the "Install Program From Floppy Disk or CD-ROM" window.
The "Run Installation Program" window is displayed.

Figure 10.36  "Run Installation Program" Window

4. Place the GCMSsolution installation disk in the CD-ROM drive. If the GCMSsolution 
installation window is displayed, click the Cancel button to exit the installation. Enter 
the full path of the DAO installation program in the Open text box. For example, if the 
CD-ROM drive is the E drive, input the following:

E:\ Dao\Disk1\Setup.exe

Click the Finish button.

"Data Access Objects (DAO) Setup" launches and the "Welcome" window is 
displayed.

Figure 10.37  DAO Installation "Welcome" Window
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5. Read the contents of the "Welcome" window and click the Next button.
The "Select Components" window is displayed.

Figure 10.38  "Select Components" Window

6. Select only the Jet 3.5 check box from the "Select Components" window, and click 
the Next button.
The next "Select Components" window opens which allows the selection of the data 
format to be used for Jet 3.5.

Figure 10.39   The Second "Select Components" Window
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7. Deselect all check boxes, and click Next.
DAO is installed, and when completed, the Information message is displayed.

Figure 10.40   DAO Installation Completed

8. Click the OK button to complete "Data Access Objects (DAO) Setup".

   Note

Perform GCMSsolution installation when DAO installation is completed.

   Note

The following message can occur during DAO installation, indicating installation 
failure:
"The OLE automation DLL, OLEAUT32.DLL, could not be found or is an older 
version that is incompatible with DAO3.5. If you continue DAO will not register 
properly. Continue anyway?"
Continue with the DAO installation to its completion. Then install GCMSsolution to 
complete the installation process. 
If the GCMSsolution installation fails, reinstall DAO and GCMSsolution.
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10.8 PC Interface Board Installation

This section describes the installation of the PC Interface board that connects the MS and 
PC and the drivers for the PC Interface board and the MS.

10.8.1 Installing the PC Interface Board

Install the PC Interface board in the PC as follows:

1. Turn off power to the PC and peripheral devices (printer, etc.).

2. Disconnect the power cable from the PC.

3. Remove the PC cover. Refer to the manual for the PC.

4. Remove the cover from the PCI expansion slot where the PC Interface board is to be 
installed. Use a screwdriver to remove the expansion slot screw.

5. Insert the PC Interface board into the PCI expansion slot, and tighten the screw to 
secure the board.

6. Replace the PC cover.

7. Reconnect the PC power cable.

   Note

For a detailed description of this procedure, refer to the user manual included with 
the PC.
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10.8.2 PC Interface Board Driver Installation (Windows 2000)

Driver installation is performed after the interface board is installed in the PC.

1. Turn on the PC. The installation of the driver will start automatically during the 
operating system boot process.

2. Select Settings > Control Panel from the Start menu. The "Control Panel" window 
opens.

Figure 10.41  "Control Panel" Window
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3. Double-click the System icon in Control Panel to open the "System Properties" 
window.

Figure 10.42  "System Properties" Window

Display the Hardware tab and click the Device Manager button.

4. The "Device Manager" window opens. Verify that the driver is indicated under "IEEE 
1394 Bus host controllers."

Figure 10.43  "Device Manager" Window
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10.8.3 PC Interface Board Driver Installation (Windows XP, Vista)

Driver installation is performed after the interface board is installed in the PC.

1. Turn on the PC. The installation of the driver will start automatically during the 
operating system boot process.

2. Select Settings > Control Panel from the Start menu.

Figure 10.44  "Start" Menu

3. The "Control Panel" window opens. Click the Performance and Maintenance icon 
in Control Panel.
For Windows Vista, switch to Classic View, and click the Device Manager icon. 
Then proceed to step 6.

Figure 10.45  "Control Panel" Window
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4. Click the System icon in the "Performance and Maintenance" window to open the 
"System Properties" window. 

Figure 10.46  "Performance and Maintenance" Window

5. Display the Hardware tab and click the Device Manager button.

Figure 10.47  "System Properties" Window
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6. The "Device Manager" window opens. Verify that the driver is indicated under "IEEE 
1394 Bus host controllers".

Figure 10.48  "Device Manager" Window

10.8.4 Installation of the Driver for MS (Windows 2000)

1. Connect the MS to the PC Interface board while Windows is running. The "Found 
New Hardware Wizard" opens automatically.

Figure 10.49  "Found New Hardware" Wizard
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2. Click the Next button. The screen changes to the next screen of the "Found New 
Hardware" Wizard - "Install Hardware Device Drivers."

Figure 10.50  "Install Hardware Device Drivers" Screen

Select "Display a list of the known drivers for this device so that I can choose a 
specific driver" and click the Next button.

3. The screen changes to the next screen of the "Found New Hardware" Wizard - the 
"Hardware Type" screen.

Figure 10.51  "Hardware Type" Screen

Select "Other Devices" and click the Next button.
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4. The screen changes to the next screen of the "Found New Hardware" Wizard - the 
"Select a Device Driver" screen.

Figure 10.52  "Select a Device Driver" Screen

Click the Have Disk button.

5. The "Install From Disk" window opens.
Place the GCMSsolution installation disk in the CD-ROM drive. If the GCMSsolution 
installation window is displayed, click the Cancel button to exit installation.

Figure 10.53  "Install From Disk" Window

Type E:\Driver (E: is CD-ROM Drive) in "Copy manufacturer's files from" text box and 
click the OK button.
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6. The screen returns to the "Select a Device Driver" screen.

Figure 10.54  "Select a Device Driver" Screen

Select "Shimadzu GCMS-QP2010" and click the Next button. If the "Update Driver 
Warning" window opens, click the Yes button.

Figure 10.55  "Update Driver Warning" Window

7. The screen changes to the next screen of the "Found New Hardware" Wizard - the 
"Start Device Driver Installation" screen.

Figure 10.56  "Start Device Driver Installation" Screen

Click the Next button.
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8. The screen changes to the last screen of the "Found New Hardware" Wizard.
Click the Finish button.

Figure 10.57  "Completing the Found New Hardware Wizard"

9. Open the "Device Manager" window and verify that "Shimadzu GCMS-QP2010" is 
indicated under Shimadzu Instruments.
To display the "Device Manager" window, refer to Section 10.8.2 "PC Interface 
Board Driver Installation (Windows 2000)", page 250.

Figure 10.58  "Device Manager" Window
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10.8.5 Installation of the Driver for MS (Windows XP)

1. Connect the MS to the PC Interface board while Windows is running. The "Found 
New Hardware Wizard" opens automatically.

Figure 10.59  "Found New Hardware" Wizard

Select "Install from a list or specific location (Advanced)" and click the Next button.

2. The "Please choose your search and installation options" window opens.

Figure 10.60  "Please choose your search and installation options"

Set the GCMSsolution install disk in the CD-ROM drive. If the GCMSsolution 
installation window is displayed, click the Cancel button to exit installation.

Check to "Include this location in the search:" check box, type E:\Driver (E: is CD-
ROM Drive) in text box.

Click the Next button.
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3. Installation of device driver starts automatically.

Figure 10.61  "Please wait while the wizard installs the software"

4. When the window below is displayed, click the Finish button.

Figure 10.62  "Completing the Found New Hardware Wizard"
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5. Open the "Device Manager" window and verify that the "Shimadzu GCMS-QP2010" 
is indicated under the Shimadzu Instruments.

To display the "Device Manager" window, refer to Section "10.8.3 PC Interface Board 
Driver Installation (Windows XP, Vista)".

Figure 10.63  "Device Manager" Window

10.8.6 Installation of the Driver for MS (Windows Vista)

Make sure that the GCMSsolution has already been installed onto your computer before 
installing the driver software for the mass spectrometer.

1. While Windows is running, connect the MS to the PC I/F board. The "Found New 
Hardware" window is automatically displayed.

Figure 10.64  "Found New Hardware" Window

Click "Locate and install driver software (recommended)".
In the "User Account Control" window, click the Continue button.

2. If a window is displayed asking: "Allow Windows to search online for driver software 
for your Shimadzu GCMS-QP2010?", click "Don't search online". If this window is not 
displayed, proceed to step 3.
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3. The "Insert the disc that came with your Shimadzu GCMS-QP2010" window will be 
displayed.
Click "I don't have the disc. Show me other options".

Figure 10.65  "Insert the disc that came with your Shimadzu GCMS-QP2010"

4. The "Windows couldn't find driver software for your device" window will be displayed.
Click "Browse my computer for driver software (advanced)".

Figure 10.66  "Windows couldn't find driver software for your device"
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5. The "Browse for driver software on your computer" is displayed.
Click the Browse button and specify "C:\GCMSsolution\Program (C: is the hard drive 
where the GCMSsolution is installed.)". Click the Next button.

Figure 10.67  "Browse for driver software on your computer"

6. The installation of the device driver begins.

Figure 10.68  "Installing driver software"

If the dialogue box "Would you like to install this device software?" is displayed 
during installation process, click the Install button.
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7. The "The software for this device has been successfully installed" window will be 
displayed. Click the Close button.

Figure 10.69  "The software for this device has been successfully installed"
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11  Troubleshooting

11.1 Operational Problems and Remedial Measures

This section describes operational problems that can occur during an analysis, the causes 
of these problems and recommended solutions. Contact your Shimadzu Service 
Representative if symptoms persists after remedial action, or if other problems arise.

11.1.1 Error status indicated by LED on MS

Figure 11.1   LED Error Indications

Normal LED Indications LED Error Indications

Switch ON MS Unit

All 3 LED's light

Green LED goes out

Red LED goes out

Yellow LED remains ON

Yellow LED does not light

Red LED lights

Green LED does not go out

Red LED does not go out

- Appropriate power is not supplied
- Power supply malfunction.

- Controller board malfunction

- DRAM Initialization Error

- FPGA Write Error

- If yellow LED does not light, verify that power is 
appropriately suppled.

- If the LED display indicates an error, switch OFF 
the power, wait a few seconds, then switch the 
power ON again.

- If the above steps do not remedy the problem, 
contact your Shimadzu Service Representative.



11  Troubleshooting
11.1 Operational Problems and Remedial Measures

266 GCMS-QP2010

11.1.2 GCMSsolution Software Startup Errors

Figure 11.2  Software Startup Errors

Error message displayed at GCMSsolution startup

Are PC and MS or MS and GC 
connected properly?

Is GC power on?

Is MS power on?

Restart after following the suggestions 
presented in the Error Messages section of 
GCMS Help.

All connections must be made properly 
(refer to Section 1.3.1 "GC/MS Analytical 
System").

Turn on GC power supply and restart.

Turn on MS power supply and restart.

No

No

No

Yes

Yes

Yes
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11.1.3 Vacuum System Auto Startup Errors

Figure 11.3  Vacuum System Startup Errors

Error during vacuum system automatic start-up.

Does Rotary Pump1 
(RP1) operate?

Do the RP1 power cable 
and switch operate?

Turbo pump starts 
30 sec. after RP1 starts.

Is the RP1 oil at the 
proper level?

Check for vacuum leaks (refer to Section 10.6 
"Checking for Leaks").

Vacuum system not automatically restored after power failure.

Vacuum Restart mode has 
been specified.

Vacuum system was 
already off during the 

power failure.

Select the "Vacuum Restart Mode" check 
box in the Vacuum Control window.

Automatic restart will not occur.

Adjust RP1 oil level.

Turbo pump controller malfunction.

Contact your Shimadzu Service 
Representative.

Connect the RP1 power cable to the back 
panel of the MS, and turn on the RP1 switch.

No

Yes

No

No

No

Yes

Yes

Yes

Yes

Yes

No

Yes
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11.1.4 MS Filament ON Errors

Figure 11.4  MS Filament ON Errors

Error message appears when filament is on.

"Filament consumed" 
message appears.

Filament installation 
correctly performed.

Filament malfunction

"Trap/Total current 
insufficient" message 

appears.

Ionization mode and ion 
source match.

Filament installation 
correctly performed.

Filament open 
(or burned out)

"RF power source error" 
message appears.

Synchronization error

"Detector High-Voltage 
power supply error" 
message appears.

Contact your Shimadzu Service 
Representative.

Contact your Shimadzu Service 
Representative.

Replace or exchange the filaments 
(refer to 10.2 "Filament Replacement").

Re-install the filament 
(refer to Section 10.2 "Filament 
Replacement").

Change ionization mode in the System 
Configuration window, or change the ion 
source to match (EI: use EI ion source; CI: 
use CI ion source).

Replace or exchange the filaments 
(refer to section 10.2 "Filament 
Replacement").

Replace or re-install the filament 
(refer to section 10.2 "Filament 
Replacement").

No

Yes

No

No

Yes

Yes/No

Yes/No

Yes

Yes

Yes

Yes

Yes

No

No

No

Yes
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11.1.5 Autotuning and Analysis Errors

Figure 11.5  Autotuning Errors

Autotuning Errors

Error message 
displayed when 

standard is introduced.

"Initialization Error" 
message appears.

Was standard introduced?

"Resolution Adjustment 
Error" message 

appears.

"Intensity Adjustment 
Error" message 

appears.

"Mass Calibration Error" 
message appears.

"Mass Pattern 
Correction Error" 

message appears.

An unknown error occurred during tuning.
Perform the tuning again.

In the same error appears when tuning is 
repeated, clean the ion source and 
repeller according to the procedures in 
Section 10.3 "Cleaning the Ion Source 
Box and Repeller Electrode", page 218.

Open PFTBA standard valve.

Yes

Yes

Yes

Yes

No

No

No

No

Yes

No

No

Yes Perform actions described in Section 
11.1.4 "MS Filament ON Errors".
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No peaks appear, or peaks are too small.

Carrier gas flows?

Carrier gas leaks

Proper column 
installation

Temperature of column, 
injection port or interface 

has dropped.

Appropriate column 
selection

Split ratio too large

Sample concentration or 
injection amount too low

Filament open (or 
burned out)

Change or replace the filament, refer to 
Section 10.2 "Filament Replacement".

Increase sample concentration or inject a 
greater volume of sample.

Decrease split ratio.

Change to an appropriate column (check 
column polarity, etc.).

Increase the temperature of each heated 
zone to the appropriate value.

Install the column correctly, refer to Section 
2.6 "Column Replacement".

Tighten any leaking connections, refer to 
Section 10.6 "Checking for Leaks".

If carrier gas is not flowing, refer to Section 
2.4.1 "Starting the Instrument".

No

Yes

No

Yes

No

Yes

Yes

No

No

No

Yes

No

Yes

No

Yes

Yes
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Figure 11.6  No Peaks or Small Peaks

Figure 11.7  Analysis Errors

Detector voltage too low

Appropriate analytical 
conditions

MS properly tuned
Perform autotuning or adjust the instrument, 
refer to Section 2.8 "System Check and 
Tuning".

Correct the method parameters, refer to 
Section 3.2 "Method Development 
Parameters".

Increase detector voltage gradually.
Yes

No

No

Yes

No

No

"Detector saturated" message appears during analysis.

Is solvent cut time set to 
an appropriate value?

Detector voltage too high.

Sample concentration or 
injection volume too high

No

No

Yes

Yes

Yes

Turn on the filament after solvent has completely 
eluted. If peaks elute before the solvent, use a time 
program to turn the filament off and on.

Decrease the detector voltage.

Reduce the sample concentration by making a 
dilution or reduce the injection volume.
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11.2 Vacuum System Protection Functions

This section describes the protection functions when something abnormal is detected in the 
vacuum system.

11.2.1 Overview

Three items are monitored during evacuation in the GCMS-QP2010. System protection 
occurs when something abnormal is detected.
• Status of the turbomolecular pump.
• Back pressure of the turbomolecular pump. (Low vacuum in "Instrument Monitor" 

shows the backpressure)
• Vacuum of analyzer housing. (High vacuum in "Instrument Monitor" shows the 

vacuum)
• When the Ion Gauge is set to "None" in the System Configuration window, 

high vacuum is not displayed.
• In case of Single TMP model, high vacuum is not monitored.

11.2.2 Protection Functionality

1. The filament, detector high voltage and RF power supply are turned off when the 
following occur:

(Dual TMP model)
(1) Low vacuum (monitored by Pirani gauge) is greater than 100.0 Pa.
(2) Turbomolecular pump is not in "Ready" condition.
(3) High vacuum (monitored by ionization gauge) is larger than 1.0E-2 Pa.

(Single TMP model)
(1) Low vacuum (monitored by Pirani gauge) is greater than 25.0 Pa.
(2) Turbomolecular pump is not in "Ready" condition.

Filament, detector high voltage and RF voltage are turned on again when the 
following conditions are satisfied.

(Dual TMP model)
(1) Low vacuum (monitored by Pirani gauge) is smaller than 80.0 Pa.
(2) Turbomolecular pump is in "Ready" condition.
(3) High vacuum (monitored by ionization gauge) is smaller than 0.8E-2 Pa.

(Single TMP model)
(1) Low vacuum (monitored by Pirani gauge) is less than 20.0 Pa.
(2) Turbomolecular pump is in "Ready" condition.

2. The vacuum system is automatically stopped when one or more of the following 
condition continue for more than 5 minutes.

(1) Low vacuum (monitored by pirani gauge) is larger than 100.0 Pa.
(2) Turbomolecular pump is not in "Ready" condition.

The vacuum system LED is red and blinks when the vacuum system is stopped.
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A.1A  
Appendix A Peak Processing and Mass 

Spectrum Operations
A.1 Integration and Peak Processing Parameters

This section describes the peak detection algorithms and explains the types of peak 
processing that can be performed. The described parameters can be used in combination to 
properly detect and identify peaks.

A.1.1 Integration Parameters

In the table below, peak processing parameters are described in the order in which 
processing occurs. A setting range is given where applicable. Default values are shown in 
parenthesis.

Normally, the default values for the parameters can be used to detect peaks properly. For 
complex chromatograms, determine optimal values by referring to Section A.5.1 "Peak 
Processing", page 304.
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Peak Processing 
Order

Parameter
Function Description

Range
(Default)

Comments

Peak detection Width Minimum peak width
0.04 - 200 sec
(2.0 sec)

Set to the width at half-height of the 
narrowest peak occurring during analysis.

Slope Peak detection sensitivity
0 - 4E+11 /min.
(100.0 /min.)

Sensitivity of peak detection
Slope = tan θ

Peak 
Processing 
mode

Auto (Area) The slope is adjusted automatically so that 
the number of peaks specified is obtained. 
If the specified peak number is not reached 
after slope has been adjusted, peaks with 
the largest areas are included until the set 
number of peaks is reached.

Auto (Height) The slope is adjusted automatically so that 
the number of peaks specified is obtained. 
If the specified peak number is not reached 
after slope has been adjusted, the highest 
peaks are included until the set number of 
peaks is reached.

Detail Set the parameter. If peak processing is 
performed in the automatic mode, the final 
slope value can be verified in the spectrum 
process table.

# of Peaks Maximum number of 
detected peaks 
(5)

If peak processing is performed in the 
automatic mode, the number of peaks to be 
detected can be specified. For certain 
types of chromatograms, there may not be 
enough peaks to reach the specified 
number.

Baseline processing Drift Magnitude of baseline 
fluctuation
–1E+7 - 1E+7 /min 
(0.0 = automatic 
processing)

Distinguishes between a peak and baseline 
drift.

When Drift is set to 0, baseline correction is 
performed automatically.

Width at 
Half-Height

B

C D
A

Baseline
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Processing peaks with 
poor separation

Measurement of peak 
area

None Automatic If peaks are not separated sufficiently (co-
eluting), they are normally divided by 
drawing a vertical line perpendicular to the 
baseline to the valley between the peaks. 
Depending on the width of the valley 
between the peaks, they may be divided by 
the baseline.

Other T.DBL. Width & slope change 
time 
0 - 10000 min
(1000 min)

At the specified T.DBL time, the peak width 
parameter is doubled and the peak 
detection sensitivity parameter is halved. 
Automatic processing is performed when 
this parameter is set to 0.

Min. Area/
Height

Min. Area/Height
0 - 109

(0)

Peaks with areas (or heights) below this 
value will be excluded from a similarity 
search and quantitation.

Smoothing 
Method

None Smoothing not performed.

Standard Moving averaging performed 

Savitzky-Golay Smoothing performed by Savitzky-Golay 
method.

Smoothing 
width

Smoothing moving 
average time width
0 - 200 sec
(0 sec)

For noisy chromatograms, peak detection 
may not be performed correctly under 
normal peak processing conditions. In 
these situations, applying a moving 
average can perform additional smoothing. 
This parameter specifies the range of time 
over which the averaging occurs.

(3 - 25 point) Use only odd numbers when setting the 
number of smoothing points using the 
Savitzky-Golay method.

# of Smoothing 
Times

Smoothing repetitions
0 - 99
(0)

Smoothing effects can be increased for a 
given chromatogram by repeating the 
moving averaging procedure. This 
parameter specifies the number of 
repetitions.

Peak Processing 
Order

Parameter
Function Description

Range
(Default)

Comments

Vertical Split Tailing
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A.1.2 Width

Width is the most important of the peak processing parameters for optimizing peak 
detection.

To set the Width, determine the narrowest peak that will be analyzed on the chromatogram. 
Use a value for Width less than the width of this peak at half-height. Peak detection occurs 
for peaks that are approximately 1/4 of the specified width.

Figure A.1  Determining the Half-Width Value

Errors in peak detection and peak area determinations will occur if the Width is set 
incorrectly. The Width parameter significantly changes the way peaks are processed. Use a 
value that is appropriate for the narrowest peak to be analyzed to set this parameter.

A.1.3 Slope

Peak detection is performed using the peak slope as shown in the diagram below. Peak 
slope is the linear slope of the chromatogram at peak start.

Peak start is determined when the peak slope becomes larger than the set value. 
Conversely, the peak end is determined when the slope becomes smaller than the negative 
of the set value.

The starting and end points are calculated from a quarter value of the Width parameter.

Slope is also known as peak detection sensitivity.

Width at Half-Height

   Note

Removing unwanted peaks using Width
Noise peaks are generally narrower than target peaks. Using the width of the 
smallest target peak to determine the Width value will eliminate noise peaks from 
peak processing.
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As the Slope value increases, the peak detection sensitivity decreases. Conversely, as the 
Slope value decreases, the peak detection sensitivity increases, allowing even broad peaks 
to be detected.

Figure A.2  Peak Detection and Slope

   Note

Slope value criteria

The optimal slope value for peak processing depends on factors such as noise 
conditions and peak width. For capillary GC, the following values are generally 
observed.

Slope = maximum peak height/2000

For example, if the height of the largest peak is 146896 counts, then the Slope is 
set to a value of about 70 (/min).

The height of the largest peak can be easily obtained from the "GCMS Postrun 
Analysis" window or "Chromatogram Compare" window.

If too many unwanted peaks are detected, double the Slope value until the desired 
peak processing is obtained. Conversely, if the target peaks are not detected, halve 
the slope value until they are detected.
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A.1.4 Drift

1. Automated baseline processing (Drift = 0)
Baseline correction will be performed automatically when the Drift parameter is set to 
0. Two peaks are co-eluting when the width of the valley between the peaks (T2) is 
smaller than the estimated width of the immediately preceding peak at half height 
(T1). Peaks are separated by processing as described in the following section. If T2 
is larger than T1 the baseline is adjusted to separate the two peaks.

Figure A.3  Automatic Drift Processing with Narrow and Broad Valleys

2. Baseline processing for specified Drift values (Drift ≠ 0)
Specifying a value other than 0 for Drift in a time program will result in the region 
being processed by baseline correction, even in locations where the valley width (T2) 
is narrow.

Figure A.4  Baseline Processing when Drift Is Set to a Value other than 0
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Baseline correction is performed differently from when the Drift is 0. The slope set 
with the Drift value extends along the dotted line shown in the diagram from the point 
of peak initiation (S). A corrected baseline is created when the peak end point is 
below the Drift slope line.

   Note

1. Changes in the Drift parameter will cause the baseline to be determined differently 
for identical chromatograms as shown below.

With a low drift setting, three peaks A, B and C are 
processed as co-eluting peaks.

A and B are processed as co-eluting peaks, and C is 
processed as a completely separate peak.

With a high drift setting, the peaks will be completely 
separated.

2. Set the Drift to a slightly higher value than the baseline drift for portions of the 
chromatogram where peaks appear.
If the Drift setting is too low, the end points of peaks will fall below the Drift level, 
causing peaks to be analyzed as co-eluting.

Drift

Drift
Drift

Drift Drift Drift
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A.1.5 Processing Co-Eluting Peaks

Two or more peaks that are inadequately separated when detected by the parameters of 
Width, Slope and Drift are considered to be co-eluting.

A determination is automatically made whether the co-eluting peaks are simply to be 
separated vertically or treated as a tailing peak with a smaller peak eluting in the tailing 
area.

Vertical Separation

Figure A.5  Vertical Separation

Co-eluting peaks are generally processed by vertical separation.

Tailing Processing
The use of tailing processing is based on the two peaks' height ratio, the height of the valley 
and the separation conditions. The tailing peak and the peak present on the tail can then be 
determined.

Figure A.6  Tailing Processing

Processing of Co-eluting Peaks
The automatic processing of co-eluting peaks is illustrated below.

Peak A is processed as tailing, and peaks B and C are processed as peaks present on the 
tail of the main peak A.

Co-eluting peaks that are present on the tail, such as peak C, are processed by vertical 
separation.

Ratio of two peak heights H1/H2
Valley height H2/H3
Separation conditions W1/W
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Peaks E, F and G are also co-eluting peaks, and are processed by vertical separation.

Figure A.7  Co-eluting Peaks Processed on a Tail and by Vertical Separation

Vertical Separation

Tailing Processing
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A.1.6 T.DBL

1. Width and Slope values changed automatically (T.DBL = 0)
When T.DBL is set to 0, the Slope and Width parameters change automatically 
according to peak width. Peaks in isothermal GC analysis are initially narrow and 
their width increases over time. Early-eluting peaks have steep slopes, so the peak 
detection sensitivity (Slope) needs to be relatively low; later peaks are much broader 
and require increased peak detection sensitivity. The Width value must also be 
increased over time to detect broader peaks.

Figure A.8  Slope and Width Values Change Automatically when T.DBL = 0

A T.DBL setting of 0 (automatic) should not be used for chromatograms where the 
peak widths do not increase over time, as in GC temperature programmed analysis. 
This setting should also not be used when a broad peak appears long after a sharp 
peak, as in the next diagram, or when peak widths narrow after they were broad. In 
these cases, set T.DBL to a value other than 0.

Figure A.9  Use a T.DBL Value Other Than 0

2. When T.DBL is set to a value other than 0, the Slope (peak detection sensitivity) and 
Width (minimum width at peak half-height) parameters change by a factor of two, as 
shown below, at a time interval specified by T.DBL.

Automatic changes in Slope and Width using T.DBL

Figure A.10  Slope and Width Changes with T.DBL

Sharp peak

Broad Peak
Sharp peak

Width

Slope Slope
2

2xWidth 4xWidth 8xWidth

Slope
4

Slope
8

0 T.DBL 2xT.DBL 4xT.DBL
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Figure A.11  Determining T.DBL when a Peak that Doubles in Width Cannot 
Be Located

(1) Use the width at half-height of the initial sharpest peak for the Width parameter. 2 sec 
is used in this example.

(2) Measure the retention time and width at half-height of the last small peak. A retention 
time of 20 min, and a width at half-height of 30 sec are used.

(3) Time required for 2x increase = (2 sec / 30 sec × 20 min × 2) = 2.7 min.
General formula:

3. Disabling T.DBL so that Width and Slope values not changed automatically.
For most GC temperature-programmed analyses, peak widths do not increase over 
time and the Width and Slope values should not be changed automatically. To 
disable T.DBL, set it to a value longer than the final time for peak processing.

   Note

For qualitative processing, up to 15 Width changes are permitted per 
chromatogram. For quantitative processing, up to 2 changes are allowed, including 
Width or T.DBL changes in a time program. One chromatogram is counted per ID.

Normally, T.DBL is set to the time required for a peak to reach twice its initial peak 
width. If it is difficult to find a peak on the chromatogram that doubles in width, the 
value can be calculated as shown below.

Width at half-height of the 
initial sharpest peak is 2 sec.

Width at half-height of the last small peak 
is 30 sec. Retention time is 20 min.

T.DBL First Peak Width at Half-Height
Last Peak Width at Half-Height
---------------------------------------------------------------------------------- Last Peak Retention Time 2××=
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A.1.7 Peak Processing Time

Peak processing occurs only during the interval specified by the peak processing start and 
end times.

If peak processing ends as the peak slope is increasing, the area of that peak will not be 
determined.

If peak processing ends as the peak slope is decreasing, the peak area will be determined 
up to that time. 

If peak processing ends as the peak slope is increasing for a co-eluting peak, the former 
peak is considered to be the final peak. In the following example, the calculated area is 
shaded.

Effect of end peak processing during a peak.

Figure A.12  Ending Peak Processing during a Peak

STOP

STOP
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A.1.8 Peak Processing With a Time Program

Time programs can be used as part of a method to repeat the same processing for several 
chromatograms. A time program can be used as a peak processing method for routine 
analysis.

In addition to the peak processing parameters described above, a time program can be 
used to suspend peak processing during a specified time frame, removing unnecessary 
peaks, and to adjust tailing processing ranges. Peaks that were not processed as tailing 
during normal processing can be specified as tailing in a time program.

Figure A.13  Peak Processing Using a Time Program

Tailing Processing Using a 
Time Program

3.5 Min. 4.8 Min.
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A.1.9 Minimum Area/Height

This parameter has no direct effect on peak processing. After normal peak processing 
occurs based on the peak processing parameters, the minimum area/height values can be 
used to remove peaks from the following locations:

(1) Drawing the baseline, annotation and peak detection marks (display and report)
(2) Peak report
(3) Spectrum process table
(4) Quantitative (or calibration) calculations

A.1.10 Smoothing

For very noisy or complex chromatograms, or in situations where peak detection does not 
occur properly under normal peak processing conditions, applying a moving average can 
smooth the chromatogram.

Smoothing width: Sets the average width over which the moving average is taken, in units of 
seconds.

# of Smoothing Time: When a single moving average smoothing has little effect, the 
smoothing can be repeated several times. This enhances the effects of the moving average 
operation.

   Note

Subjecting the actual chromatogram data to moving averaging performs smoothing. 
Consequently, the actual chromatogram is changed. The use of smoothing should 
only be considered when processing is not possible under ordinary peak 
processing conditions.
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A.2A  A.2 Mass Spectrum Operations

This section describes the two mass spectrum editing functions, Averaging and Background 
Subtraction. These functions allow the extracting of complete spectrum information under 
various conditions.

A.2.1 Mass Spectrum Background Correction (Subtraction)

Data obtained by mass spectral measurement will contain peaks associated with column 
background and residual gases. A high degree of separation can be obtained with a 
capillary column, but some peaks cannot be completely resolved. In these instances, the 
peaks of adjacent compounds overlap with those of the target compounds, making 
qualitative processing difficult. More accurate qualitative processing may be accomplished 
by applying background subtraction to the mass spectrum.

Background subtraction is performed as follows. First, the masses of all of the mass peaks 
appearing in the two spectra for the target and background are rounded to obtain integer 
masses. Next, the intensities of the same integer masses appearing in the target and 
background spectra are subtracted and the masses including decimal places, are returned 
to the masses in the original target spectrum. Resulting intensities that have a negative 
value are omitted at this time.

A.2.2 Mass Spectrum Averaging

When MS analysis is performed in scan mode, a spectrum scan is performed linearly from 
the low to the high masses. This can favor the high mass relative abundances or favor the 
lower mass relative abundances, depending on when the peak elutes relative to the 
acquired scan. 

For example, when using a 0.5 second scan and a mass range of 10amu to 700amu, the 
time from when the intensity of the mass 10 is analyzed to the time when the intensity of the 
mass 700 is analyzed is 0.5 seconds. Spectra are different depending on the exact point in 
time that the peak's true apex elutes compared to the start of the scan. The ratios of low 
mass intensities and high mass intensities will be different in terms of the analyzed 
spectrum versus the actual spectrum. Averaging throughout the mass spectrum, including 
the peak apex can produce a more accurate mass spectrum.
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The process of mass spectrum averaging is used to compensate for the relative abundance 
distortion seen on the leading side and on the tailing side of chromatographic peaks as well 
as at the apex. Either the scans of the entire peak can be averaged or an equal number of 
scans from the front side and tailing side should be averaged with the apex. This gives an 
averaged spectrum that represents the true relative abundances of the ion fragments that 
existed in the ion source and traveled to the detector.

Mass spectrum averaging is performed as follows. First, the masses of all of the mass 
peaks that appear over the entire mass spectrum are rounded to integer masses. Next, the 
intensities of the integer masses are summed, and divided by the number of scans used for 
averaging. After averaging, the integer masses are given the exact mass assignments of 
the spectrum scan containing the greatest intensity.

A.2.3 Performing Mass Spectrum Operations and Similarity Searches 
During Automated Processing

TIC peak processing is automatically performed according to the Peak Integration and 
Spectrum Process parameters specified in the "Qualitative Parameters" dialog box. 
Detected peaks are subjected to averaging or background subtraction accordingly, and the 
spectrum is edited. The results are saved in the spectrum process table, and can be 
checked in the "Data Analysis" window. The spectrum can be averaged from peak start to 
peak end or at the peak apex. Select the background spectrum for subtraction from the 
drop-down list, which includes the peak starting or ending spectrum, or a spectrum obtained 
by averaging over any desired time interval.

An automated similarity search is performed on the edited spectra listed in the spectrum 
process table. If both qualitative peak processing and similarity searches are specified, 
peak processing is first performed, followed by spectrum editing and similarity searches. If 
only similarity searches are specified, similarity searches can be performed automatically 
on edited spectra in the spectrum process table from the "Data Analysis" window.

If similarity searching is specified in the Batch Table in the "GCMS Real Time Analysis" 
window, then similarity searches and sample analyses are performed simultaneously. 
Because the results of peak processing and the number of detected peaks are not known 
beforehand, processing can be slow. It is better to perform automated similarity searches by 
reprocessing acquired data with a batch table in the "Data Analysis" window.
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A.3A  A.3 Similarity Search Parameters and Functions

This section describes the method for calculating the degree of similarity between spectra 
during a similarity search; pre-search parameters which speed up detection from a large 
library; and the post-search parameters.

Retention times are used to identify target components from a two-dimensional 
chromatogram. First, a standard is analyzed; then the retention times of the unknown peaks 
are compared to the retention times of the target peaks in the standard. This identification 
method is not always reliable, because other peaks can elute at the same time as the target 
peaks, especially in complex samples.

Three-dimensional spectral data obtained by GC/MS analysis, allows the identification of 
target components using a similarity search based on spectral information. For the similarity 
search, either a private library, produced from standard spectra, or a public library, supplied 
by NIST, Wiley, etc., can be used.

A.3.1 Similarity Search Calculations

The similarity index (degree of similarity) is a quantitative expression of the difference 
between the spectrum of an unknown sample and a spectrum recorded in a library. The 
difference in intensity of each of the spectral peaks at a given mass (m/z) is determined. 
The degree of similarity increases as the difference between the values decreases.

The similarity index (SI) is calculated using the equation below.

lu(m/z): Relative spectrum intensity of the m/z of the unknown mass spectrum.

lt(m/z): Relative spectrum intensity of the m/z of a mass spectrum recorded in a library.

An SI of 100 indicates mass spectra that are identical, while an SI of 0 indicates spectra that 
are completely different.

SI
lu m z⁄( ) lt m z⁄( )–

m z⁄
∑

lu m z⁄( ) lt m z⁄( )+{ }
m z⁄
∑
-------------------------------------------------------------

 
 
 
 
 
 

=
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A.3.2 Pre-Search Function

Frequently, the number of compounds registered in a public library is so vast that it is best to 
narrow the search with a pre-search. Pre-searching involves a simple comparison of the 
unknown sample spectrum to the spectra registered in the library. Library spectra are 
excluded from the search if there are clear differences between the spectra. This function 
acts, therefore, as a filter.

Certain masses commonly appear, while others rarely appear. The pre-search function has 
been based on the study of many mass spectra, determining which mass peaks are 
produced by fragmentation of the most types of molecules. A number is assigned based on 
the frequency of mass peaks for all masses. This information and the mass peak intensities 
are used to obtain the masses of the most characteristic peaks of the unknown mass 
spectrum. Pre-searching determines whether the ions for these masses are present in a 
spectrum registered in the library.

There are mass spectrum peaks for masses that rarely appear. If the peaks of these 
masses are above a certain intensity, the mass spectrum peaks are taken as the most 
characteristic peaks of an unknown spectrum. This information is used to create the list of 
compounds processed by the similarity search algorithm.

A.3.3 Similarity Search Parameters

There are three parameters used during the actual search: minimum similarity, search depth 
and hit number.

As explained above, the similarity index quantitatively expresses the differences between a 
spectrum registered in the library and the spectrum of an unknown compound. Since there 
is no interest in compounds that show very little similarity, library compounds with a 
similarity index below a certain value will be excluded from the search results.

The "search depth" sets the range of a pre search. A search depth of 1 limits the research to 
the most and next most characteristic spectrum peaks. A search depth of 2 performs the 
research with respect to the most characteristic spectrum peak and the 2nd and 3rd most 
characteristic spectrum peaks. As the search depth increases, the amount of data 
considered during the research increases, along with the similarity calculations on 
registered library spectra. The pre-search effectiveness as a filter diminishes; resulting in a 
broad search which requires more time to complete.

Normally, a search depth of 1 is sufficient. However, if the calculated similarity index is 
extremely low, or when performing a library search for a mass spectrum with a high impurity 
content, a greater search depth may be more appropriate.

The hit numbers obtained from spectra with the greatest calculated similarities are 
displayed in order in the "Similarity Search Results" window.
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A.3.4 Post-Search Functions

A post-search can be conducted when the molecular weight or number of carbon atoms of 
the unknown compound is fairly well known. For example, if the molecular weight of the 
component is known, the hit list is produced from only the compounds within that molecular 
weight range.

The parameters that are used for post searching are: molecular weight, compound name, 
structural formula, class flag, retention index and base peak. Post-searches can be 
performed using these six parameters in combination.

Retention Index
The absolute value of the peak retention time changes according to the analytical 
conditions. Therefore, the elution order of a specific compound can be more universally 
expressed by taking the proportion of the retention time of the specific compound to the 
retention time of a standard peak. That ratio is called the retention index (Ix) and is found by 
the following formula.

Isothermal analysis:

Temperature-programmed analysis:

Where:

tx: Retention time of compound to be analyzed

tn: Retention time of the n-paraffin peak with a carbon number of n eluting prior to the 
compound to be detected

tn+1: Retention time of the n-paraffin peak of carbon number n+1 eluted after the 
compound to be detected

tm: Methane retention time

Ix tx tm–( ) tn tm–( )⁄{ }log
tn+1 tm–( ) tn tm–( )⁄{ }log

-----------------------------------------------------------------= 100× n 100×( )+

Ix tx tn–( )
tn+1 tn–( )

------------------------=
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A.4A  A.4 Peak Identification, Quantitative Calculations, 
and Calibration

There are three quantitation processing functions directly associated with quantitation: Peak 
Identification, Quantitation and Calibration. This section describes these three functions and 
the ID numbers assigned to each component.

A.4.1 ID Numbers

Identification, calibration and quantitation parameters must be specified for each compound 
to perform quantitation of compounds separated by GC. The ID number is the number 
assigned to each component so that the parameters listed above can be specified 
individually.

Although the ID numbers do not have to follow the peak elution order, doing this makes 
working with compound information much easier.

A.4.2 Peak Identification

When peaks are processed based on a Compound Table, peak identification is used to 
determine which peaks are target peaks. This determination is based on the peak retention 
time and the intensity ratio(s) of the target ion to the reference ion(s). A peak is identified as 
a target compound when both identification criteria are met.

1. Identification based on retention time
(1) Absolute retention time method

A target peak is identified based on the standard retention time and its retention time 
window or band, previously entered in the Compound Table. The actual compound 
retention time is used and identification is performed according to the conditional 
formula below.

Target Peak
Standard R. T.

Target Peak
Actual R. T.

– Target Peak R. T. window or band<

   Note

When numerous peaks fall within the identification range, the peak that is closest to 
the standard retention time is identified as the target component.



Appendix A  Peak Processing and Mass Spectrum Operations
A.4  Peak Identification, Quantitative Calculations, and Calibration

293GCMS-QP2010

(2) Relative retention time method
With the relative retention time method, identification is performed after correcting 
the retention time drift for each peak. First, a specified reference peak is identified by 
the absolute retention time method; then the target peaks are identified by the 
conditional formula below.

The actual retention time of the target peak is corrected by calculating a ratio based 
on the shift in retention time of the reference peak. The corrected retention time is 
used for identification.
Since the TIC is used, the mass cannot be used to identify the components. This 
method is most effective when several peaks co-elute. The reference peak must be a 
distinct peak that does not co-elute.

Figure A.14  Relative Retention Time Method

Std. R. T. of peak
to be identified 

 
Std. R. T. of the
reference peak 

 

Actual R. T. of the
reference peak 

 
----------------------------------------------------- Actual R. T. of peak

to be identified 
 ×– R. T. window or band for the

peak to be identified 
 <

Reference Peak
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(3) Multi-reference relative retention time method
For capillary GC temperature-programmed analyses, the retention time shift is often 
not proportional to the retention time. Retention time correction for large retention 
time shifts can be improved by selecting multiple reference peaks. The peaks are 
classified into multiple zones and a reference peak is specified for each zone. The 
peaks within the zone are identified based on each zone's reference peak.
Peaks that elute prior to the first reference peak are identified by a simple relative 
retention time method using only the first reference peak. Subsequent peaks are 
identified with a corrected retention time, which is based on the retention time shift of 
the preceding and following reference peaks. Refer to the formula below.

Where:
t: Actual retention time of the target peak
t1: Actual retention time of reference peak 1
t2: Actual retention time of reference peak 2
T1: Expected retention time of reference peak 1
T2: Expected retention time of reference peak 2

Figure A.15  Multi-Reference Relative Retention Time Method

Target peak corrected for R. T.
t t1–

t2 t1–
---------------- T2 T1–( ) T1+×=

Reference Peak 1

Reference Peak 2

Reference Peak 3
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(4) Window method
The retention time window method specifies a certain retention time span for the 
peaks. This window increases with retention time, as shown in the diagram below. 
For GC isothermal analysis, for example, it is often necessary to increase the 
retention time window over time. The disadvantage of this method is that the time 
span allowed for each component can overlap with the windows of other compounds.

Figure A.16  Window Method

(5) Band method
The band method uses a specific retention time span for each peak. The advantage 
of this method is that an optimal retention time band can be specified for each peak. 
This method can be time-consuming, as it is necessary to make the setting for each 
peak.

The band method is useful when peak widths do not change over time, as in a GC 
temperature-programmed analysis.

Allowed time span (min) = Band (min)

Figure A.17  Band Method

Retention time window (min) Std. R. T. (min) Window (%)×
100

------------------------------------------------------------------------------- 0.02×=

at1+0.02

Peak 1 Peak 2 Peak 3

a: Window (%)
t1, t2, t3: Standard retention times 

for each peak (min.)

t1 t2 t3

at2+0.02 at3+0.02at3+0.02

a1

Peak 1 Peak 2 Peak 3

a1, a2, a3: Bands for each peak
t1, t2, t3: Standard retention 

times for each peak

t1 t2 t3

a2 a3
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2. Identification by ion intensity ratio
In mass spectrum analysis, the relative intensity of each ion fragment is virtually 
constant and produces a value specific to each target compound, providing the 
analysis conditions are constant. 

During an analysis, numerous ions are simultaneously analyzed, and their intensity 
ratios (peak area ratios or height ratios) are determined, allowing component 
identification. Peaks can be accurately identified using ion intensity ratios along with 
retention time. This avoids the mistaken identification of impurities with similar 
retention times.

For quantitative analysis, a maximum of five reference ions can be specified in 
addition to the target ion. After retention time identification, the components are re-
checked for accurate identification by determining if the area or height ratios are 
within the specified ranges.

The reference ion intensity is specified as a percentage with respect to the intensity 
of the target ion.

Absolute Tolerance and Relative Tolerance Ranges
Reference ion spectrum confirmation can be absolute or relative. An absolute 
tolerance specifies the ratio with respect to the intensity of the target ion, regardless 
of the reference ion intensity. A relative tolerance specifies the ratio with respect to 
the intensity of the reference ion.

An absolute tolerance is usually sufficient, but in cases where the intensity of the 
reference ion is extremely small, and that ion is crucial to the identification of the 
peak, the accuracy of identification may be increased by using a relative tolerance.

Absolute tolerance range (%): Ri ± Rw

Relative tolerance range (%): Ri ± Ri • Rw/100

Ri: Ref. intensity ratio with respect to target ion (%)

Rw: Tolerance range (%)
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3. Identification using pattern matching
Once a standard spectrum is registered in the compound table, a similarity 
calculation is conducted for spectra of detected peaks, and a compound is identified 
as the target compound if the similarity value exceeds the set minimum similarity 
value. 

4. Grouping
By grouping such compounds as the isomer or homolog that have the similar 
characteristics, determining the concentration according to group is referred to as 
"grouping".

This software allows selection between two methods of grouping in the "Quantitation 
Parameters", as follows.

(1) Group Calibration
In grouping associated with Group Calibration, the peak areas or peak heights of 
compounds that have been grouped are summed, a calibration curve is drawn for 
each group and quantitation is conducted for each group as a whole.
The group area/height is as follows.
Group area/height = sum total of all compounds in the group

(2) Concentration Sum
In grouping associated with Concentration Sum, a calibration curve is drawn for each 
compound, and after quantitation is conducted for each compound, the sum of the 
concentrations of the compounds in the group is taken as the group concentration.
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A.4.3 Quantitative Calculation Methods

Quantitation is possible by six different methods.

Area Normalization
The detected peak areas or heights are totaled, and the percentage of each peak area or 
height is determined with respect to the total value.

Corrected Area Normalization
This method uses the external standard calibration curve method to quantitate each peak. 
The quantitation values are totaled and the percentage of the quantitation values for each 
component are determined with respect to the total.

Internal Standard
An internal standard compound is added to each standard and sample. Then, a calibration 
curve is created, expressing the relative sensitivity and mass ratio of a standard target peak 
relative to the internal standard peak. The quantitation value of the target compound is then 
calculated by applying this calibration curve to the area ratio or height ratio of the unknown 
peak. This method takes into account variations in analytical conditions.

Concentration (%)
Ai

Ai∑
-------------- 100×=

Concentration (%)
Ai F2i–( ) F1i( )⁄

Ai F2i–( )

F1i
-------------------------

 
 
 

∑
------------------------------------------- 100×=

Concentration
Ai AIS F2i–( )⁄

F1i
---------------------------------------

WIS
Wspl
-------------- DF××=
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External Standard (Absolute Calibration Curve Method)
This method determines the concentration of a target compound by creating a calibration 
curve from the relationship between the absolute mass or concentration of a compound in a 
standard and the area or height of its peak. An unknown sample is analyzed under identical 
conditions, and then the calibration curve is applied to the area or height of the peak in the 
unknown. The analytical conditions of the unknown sample must be exactly the same as 
those of the standard. Since the method accuracy is dependent on the volume of the 
sample injected injection volumes must be constant.

Corrected Area Normalization with Scale Factor
This method calculates peak concentrations using the total area or height as a scale factor 
(dilution factor), rather than letting the total be 100.

Where:

Ai: Peak area (height)

F1i: Slope correction factor

F2i: Constant (intercept)

Wspl: Sample amount 

WIS: Internal standard amount

DF: Dilution factor

SF: Scale factor (use dilution factor value)

Standard Addition
The matrix effect refers to coexisting compounds biasing the concentrations calculated for 
the target compound. The standard addition method counters this problem by adding 
several concentrations of a known test compound to identical quantities of sample and 
calculating the concentrations of the samples. This is accomplished by preparing several 
vials of sample; one vial is left unspiked and the others are spiked with various 
concentrations of standard. After analysis, a calibration curve is created with the quantity of 
standard added on the horizontal axis, and the peak area or height on the vertical axis. 
Quantitation of the sample is performed using this calibration curve.
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A.4.4 Calibration

By analyzing a known concentration of standard, a calibration curve can be created and 
used for quantitation.

The horizontal axis of the calibration curve represents the amount of component (ratio with 
respect to the internal standard when an internal standard is used). The vertical axis 
represents area or height (ratio with respect to the internal standard peak when and internal 
standard is used). A linear or point-to-point curve is drawn.

The calibration curves can be made to pass through the origin, if desired (except for the 
Average RF curve, which must pass through the origin).

Calibration curves are classified into four types.

Linear
Up to 64 different standard concentrations are analyzed, and a linear calibration curve is 
calculated by the least squares method.

If there is only a single calibration level, a simple straight line passes through the single 
point and the origin.

If there are two or more calibration levels, and the curve does not pass through the origin, a 
linear calibration curve is drawn through these two points.

In other cases, a linear curve is drawn using the least squares method.

Each point can represent the average of up to 10 individual analyses.

Figure A.18  Linear Calibration Curve

Area (Height)
(Ratio with respect 
to internal standard)

Component amount
(Ratio with respect to internal standard)
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Quadratic/Cubic
Up to 64 different standard concentrations are analyzed, and a second order (quadratic) or 
third order (cubic) curve is drawn by the least squares method.

For quadratic curves, three or more calibration points are required. The curve will be 
calculated as linear if there are two or fewer points.

For cubic curves, four or more calibration points are required. The curve will be calculated 
as a quadratic equation if there are three points and as linear if there are two or fewer 
points.

Each point can represent the average of up to 10 individual analyses.

Figure A.19  Quadratic/Cubic Calibration Curve
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Point-to-Point
Up to 64 different standard concentrations are analyzed, and a point-to-point calibration 
curve is created. No curve fit constant is displayed in the quantitation table when a point-to-
point calibration curve is used, and none can be entered.

If there is only a single calibration level, a simple line that passes through that point and the 
origin is drawn.

If there are two or more calibration levels, a point-to-point curve is drawn; the initial line 
must pass through the origin.

Each point can represent the average of up to 10 individual analyses.

Figure A.20  Point-to-Point Calibration Curve

Area (Height)
(Ratio with respect 
to internal standard)

Component amount
(Ratio with respect to internal standard)

   Note

Only with point-to-point calibration curves is the determined calibration curve 
constant not displayed in the calibration curve window. Further, the calibration 
curve constant cannot be entered.
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Mean RF
Up to 64 standards with different concentrations are analyzed. First, linear curves are 
calculated passing through each individual point and the origin. Next, the simple average of 
the coefficients of the slopes of these lines is determined. The resulting calibration curve 
must pass through the origin. 

If there is only a single calibration level, a simple curve that passes through that point and 
the origin is drawn.

Each point can represent the average of up to 10 individual analyses.

Figure A.21  Mean RF Calibration Curve
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A.5A  A.5 Troubleshooting

This section describes solutions for peak processing and peak identification problems.

A.5.1 Peak Processing

If peak processing is not performed properly with the method peak processing parameters, 
change the peak processing parameter settings according to this table. A peak time 
program may become necessary to change the peak processing parameters for certain 
components (for example, when the S/N ratio is different for each component).

# Problem Parameters Solution

1 Narrowest peaks not detected. Width
Slope

Set the Width to the width at half-height of the narrowest 
peak.
Decrease Slope by 1/2 in order to increase peak detection 
sensitivity.

2 Two or more peaks are 
detected as one peak.

Width
Slope

Set the Width to the width at half-height of the narrowest 
peak.
Decrease Slope by 1/2 in order to increase peak detection 
sensitivity.

3 Peaks that elute after the 
baseline starts drifting are not 
detected.

T.DBL Set T.DBL to the time that it takes for peak widths to 
double. For temperature-programmed GC analyses, set 
T.DBL to a large value (near the end of data acquisition) to 
disable T.DBL.

4 Late-eluting broad peaks are 
not detected, or integration 
ends during peak elution.

Slope
T.DBL

Decrease Slope by 1/2 to increase peak detection 
sensitivity.
Set T.DBL to the time that it takes for peak widths to 
double, not to 0 (automatic).

5 Small peaks occurring after 
large peaks are not detected.

T.DBL Set T.DBL to the time that it takes for peak widths to 
double, not to 0 (automatic). Use small peaks as the 
reference for selecting the T.DBL value.

6 Large baseline fluctuations 
detected as peaks.

Slope Decrease detection sensitivity by gradually increasing the 
slope by 2x, 4x, . . . until fluctuations are not detected. 
Determine the slope value from the chromatogram 
according to the diagram below.

7 Baseline is not calculated 
consistently or Baseline is 
unstable.

Drift 1) If the same peak in the same chromatogram is not 
processed reliably, disable automated Drift processing. 
See problem #8.

2) If reliable peak processing is not obtained for a peak 
that appears in several samples, or if the baseline 
needs to be calculated uniformly, see problem #8.
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8 The baseline needs to be 
calculated differently.

Drift 1) Set the Drift value as indicated below.

2) Use a time program to perform vertical separation or 
complete separation at different times.

9 Certain peaks do not need to 
be integrated. 

Suspending 
integration 
with 
Integration 
On/Off

1) To remove undesirable peaks that occur at the start of 
data acquisition (i.e., solvent peaks), use a time 
program to suspend integration from 0.1 min to a time 
slightly past the peak apex.

2) A time program is may also be used to suspend 
integration during an analysis.

# Problem Parameters Solution

Separates vertically Separates completely

Drift changes automatically at this time.

Drift changes automatically at this time.

Integration Off Integration On
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10 Tailing processing is needed for 
a peak present on a tail (tailing 
processing is not performed 
automatically, or is not 
occurring correctly).

TAILING ON/
OFF/AUTO

Use a time program. Tailing is set so that the valleys and 
apexes of peaks on the tail are processed correctly as 
peaks on a tail.

Note: When performing tailing processing, the main peak 
must also be integrated. Do not disable peak processing 
with the LOCK command for the main peak.

11 Peaks should not be 
automatically processed as 
tailing.

Tailing The same time program as above is used, and the 
program is divided into tailing ON, tailing OFF and tailing 
AUTO regions.

12 Leading (fronting) processing is 
needed for smaller peaks on a 
fronting peak.

Leading 
(fronting)

Use a time program. Set the Leading ON and Leading 
OFF parameters to include the apex and the valley that 
occur after the peaks on the fronting area.

# Problem Parameters Solution

Tailing On Tailing Off

Leading Pk On Leading Pk Off
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Figure A.22  Determining the T.DBL Value

(1) Use the width at half-height of the initial sharpest peak for the Width setting (normal 
setting). 2 sec is used in this example.

(2) Measure the retention time and width at half-height of the last small peak.

A retention time of 20 min and a half-width of 30 sec are used in this example.

Time required for 2x increase = 2 sec / 30 sec x 20 min x 2x = 2.7 min.

General formula:

   Note

Setting T.DBL when automatic processing is not used
T.DBL should be set to the time when the peak width has doubled in size relative to 
an original peak. If it is difficult to determine this time on the chromatogram, 
calculate the time as shown in the example below.

Width at half-height of the initial 
sharpest peak is 2 sec.

Width at half-height of the last small 
peak is 30 sec. Retention time is 20 min.

T.DBL First Peak Width at Half-Height
Last Peak Width at Half-Height
---------------------------------------------------------------------------------- Last Peak Retention Time 2××=
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A.5.2 Peak Identification

If a target peak is not identified, or if a peak is identified incorrectly, make the following 
changes to the quantitative parameters, or change these settings in the Compound Table.

# Problem Parameter Solution

1 Peak is not identified or is 
identified incorrectly.

Ret. Time Ensure that the Compound Table contains correct 
parameters for the peak.

Window Is the retention time Window correct? Normally set to 
approx. 3 - 5 %.

Band Is the retention time Band correct? Normally set to the 
approximate peak half-width.

2 Wrong peaks are identified. Min Area /
Height

Increase minimum peak area/height to exclude small 
peaks.

LOCK ON/
OFF

Suspend peak integration (lock ON/OFF) in a time 
program to exclude unwanted peaks.

Window Narrow the Window.

Band Narrow the Band.

3 Retention time fluctuates and 
does not allow proper 
identification.

Window Widen the Window.

Band Widen the Band.

4 Retention time shifts cause the 
identification of one or more 
peaks, or the mistaken 
identification of a peak

Relative 
Retention 
Time Method

Use the relative retention time method for identification 
when the retention time shifts. Select a large peak that is 
separate from the other peaks as the reference peak. 
Alternatively, for complex chromatograms, the multi-
reference relative retention time method uses up to eight 
reference peaks for proper identification.
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Appendix B  PDF Output

B.1 Setting up PDF Output

The GCMSsolution provides the capability to output a report in the PDF (Portable Document 
Format) when it is used with Adobe Acrobat, a tool for creation, management, and 
editing of PDF documents. When used with the CLASS-Agent, the GCMSsolution also 
provides the capability of outputting such reports to the printer and converting print images 
into a PDF file, which is then sent to the CLASS-Agent.

B.1.1 Preparation for PDF Output

The following products must be set up before the PDF output capability can be used.

• Adobe® Acrobat®(Version 5 or later)
To install this software, follow the instructions displayed on the screen that automatically 
appears when the CD-ROM for Acrobat® is placed into the drive, and perform the standard 
setup.

• CLASS-Agent
To make archives in PDF format using CLASS-Agent, set it up in accordance with the 
installation manual for CLASS-Agent.

   Note

This software package does not include Adobe® Acrobat®, which must be 
purchased separately. Adobe® Acrobat Reader, which is included in the 
GCMSsolution installation disk, can only be used to read electronic documents of 
the PDF. It does not include the capability of creating a PDF file.

   Note

To use the PDF output capability of this software, Acrobat® Distiller® is required. 
If Acrobat PDF Writer is used, PDF file output may not occur successfully.
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B.1.2 Install the PostScript Printer Driver

The figures in this chapter are displayed on Windows 2000. Operations are similar in 
Windows XP and Windows Vista.

Preparations for installation
For Windows Vista, this installation preparation is not required.

1. Select Control Panel from Start - Settings on Windows. Choose System from 
Control Panel to display "System Properties". 
In Windows XP, select Control Panel from Start on Windows. Choose System from 
Performance and Maintenance to display "System Properties."

2. Select the Hardware tab of the "System Properties" window and click the Driver 
Signing button.
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3. Check that "Block" is not selected in the File signature verification section of the 
"Driver Signing Options" window.

Installing the PostScript printer driver (for Adobe® Acrobat® 6.0)

1. Select Printers from Start - Settings in Windows.
For Windows XP, select Printers and Faxes from Start on Windows.
For Windows Vista, select Start - Control Panel. Switch Control Panel to Classic 
View, and select Printers.
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2. Double-click "Add Printer" on the "Printers" window to start "Add Printer Wizard".
For Windows XP and Windows Vista, click "Add a printer" in Printer Tasks to start 
"Add Printer Wizard".

3. Click the Next button on the "Welcome to the Add Printer Wizard" window.
For Windows Vista, this window is not displayed. Proceed to step 4.
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4. Select "Local Printer" on the "Local or Network Printer" window. Do not select the 
option, "Automatically detect and install my Plug and Play printer". Then click the 
Next button.

5. Select "Use the following port" on the "Select the Printer Port" window and specify 
"FILE: (Print to File)" for the Port. After the settings, click the Next button to proceed 
to "Add Printer Wizard".
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6. Click the Have Disk button on the "Add Printer Wizard" window to display the "Install 
From Disk" window.

7. Click the Browse button on the "Install From Disk" window, select "PDF_Setup.inf" 
from the "\ENGLISH\PDFOutput" folder on the GCMSsolution installation disk, and 
then click the Open button. 
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8. Check that the correct path to "PDF_Setup.inf" is selected on the "Install From Disk" 
window, and then click the OK button.

9. The "Add Printer Wizard" window lists the selectable printers. Select "LabSolutions 
PDF Printer" from the list and then click the Next button. If no appropriate printer is 
included in the list, still click the Next button. 
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10. Check that the printer name selected in step 9 is correctly entered on the "Name 
Your Printer" window. This window allows you to edit the printer name if necessary. 
Select "No" for "Do you want your Windows-based programs to use this printer as 
the default printer?" Then click the Next button.
For Windows Vista, the window "Would you like to install this device software?" may 
be displayed after clicking the Next button. In this case, click the Install button.

11. Select "Do not share this printer" on the "Printer Sharing" window and then click the 
Next button.
For Windows Vista, the [Add Printer] window is displayed. Click the Finish button, 
and proceed to step 15.
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12. Select "No" on the "Print Test Page" window and then click the Next button.

13. Click the Finish button to exit the wizard.
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14. After you have clicked the Finish button, the following warning message may 
appear. In this case, click the Yes button. The installation will be completed 
successfully.

For Windows XP:
Click the Continue Anyway button.
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15. After the installation has been completed, display the GCMS Postrun screen to see 
whether the PDF output settings are valid.

* If a data file in which no report format is recorded is converted into a PDF and then 
saved, a blank PDF file will be created.

Installing the PostScript printer driver (for Adobe® Acrobat®5.0)

1. On the opening window that automatically appears when the CD-ROM for Acrobat® 
product is placed into the drive, click on the Next button to proceed to the next step.

Load a data file to the "Data Analysis" 
window and then select Save Data File 
As... from the File Menu.

Allows you to convert 
Data Report * (report in 
the data file) images 
into the PDF.
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2. On the displayed window, select the Additional Material button. The list of buttons 
related to additional materials will appear.

From the displayed buttons, select the Install Adobe PostScript Driver button and 
then specify a postscript printer for PDF output.
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3. Click on the Update Existing PostScript Printers button. Follow the message on 
each window based on the default values until the "Local Port Selection" window 
appears.

4. On the "Local Port Selection" window, select FILE: for the port. Click on the Next 
button. The "Select Printer Model" window will appear.
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5. Click on the Browse... button on the "Select Printer Model" window to display the 
"Browse for Printer" window. 

Change the drive/folder over to "C:\WINNT\system32\spool\drivers\w32x86". Now 
"Acrobat Distiller" is available for selection from the list of printers. Select it and then 
click on the OK button. 

You will return to the "Select Printer Model" window. With "Acrobat Distiller" selected, 
click on the Next button and subsequently proceed using on the default values until 
the "Printer Information" window appears.
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6. On the "Printer Information" window, specify a printer name. Enter "LabSolutions 
PDF Printer". Now the settings have been completed. Proceeding in accordance with 
the message that will appear on each window completes the installation of the printer 
driver. Each one blank space must be given before and after "PDF".

7. After the installation has been completed, display the GCMS Postrun screen to see 
whether the PDF output settings are valid.

If a data file in which no report format is recorded is converted into the PDF and then 
saved, a blank PDF file will be created.

Load a data file to the "Data Analysis" 
window and then select Save Data File 
As... from the File Menu.

Allows you to convert 
Data Report * (report in 
the data file) images 
into the PDF.



Appendix B  PDF Output
B.1  Setting up PDF Output

324 GCMS-QP2010

B.1.3 [PDF Export] Tab

This tab is used to specify the PDF output settings.

1. Select the Tools > Option command.

2. Specify the parameters about PDF Output in the PDF Output tab.

Parameter Description

Redirect Report to PDF file When selected, the output format of reports is changed to PDF.
Note: The following document information is included in the 

output file:
Title: Filename of the original file
Subject: Name of the application program from which 

the PDF file is output (Data Acquisition, Batch 
Analysis, Batch Postrun, or Report Generator)

Author: Name of the user who was logged in when the 
PDF file is output

Keywords: Status of data (postrun processing without file 
saving or presence/ absence of time program 
for integration in data)

Creator: Product name (GCMSsolution) and version 
number

Other information such as sample information is also 
included though they are not displayed.

Normal Speed Mode 
(Acrobat Distiller®)

When selected, Acrobat® Distiller® is used to output PDF files.
Note: When a password has been assigned to the Admin account, 
the "Changing the Document" security setting of the PDF file is set 
to "Not Allowed" by the Acrobat standard security feature using 
that password as the master password. Other security settings are 
applied in accordance with the settings specified in the Acrobat® 
Distiller®.



Appendix B  PDF Output
B.1  Setting up PDF Output

325GCMS-QP2010

High Speed Mode 
(Acrobat PDF 
WriterTM)

When selected, Acrobat® PDFWriterTM is used to output PDF files. 
When Acrobat Ver.6 is used, "High Speed Mode" is not used. If 
this mode is selected, PDF file output may not occur successfully.
Note: No security settings are applied to PDF files unlike the 

"Normal Speed Mode".

Print report during PDF 
export

When selected, a report is output to the printer at the time of PDF 
output, if the report output format is set to PDF file.

Export PDF file when 
saving data file from <Data 
Analysis>

If selected, a PDF file is output when a data file is saved in the 
"Data Analysis" window.
Note: This setting is effective only when the saved data file 

contains a report format and the CLASS-Agent program is 
set to automatically collect data files.

Parameter Description
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C.1 Performance

Standard model (Dual TMP model)

Single TMP model

Mass Range m/z 1.5 - 1024

Resolution R=2M (FWHM)

EI scan sensitivity S/N>60/1 (RMS) for 1pg octafluoronaphthalene molecular ion at m/z 272

Column DB-5ms 30 m × 0.25 mm I.D., 0.25 µm

Scan range m/z 200 - 300

Interval (Event Time) 0.5 sec

EI SIM sensitivity S/N>60/1 (RMS) for 100fg octafluoronaphthalene molecular ion at m/z 272

Column DB-5ms 30 m × 0.25 mm I.D., 0.25 µm

Interval (Event Time) 0.2 sec

Maximum scan rate 10000 u/sec (single scan)
Scanning max rate for scan range m/z 60 - 660 (600 u) at 0.1 sec interval

Mass Range m/z 1.5 - 900

Resolution R=2M (FWHM)

EI scan sensitivity S/N>30/1 (RMS) for 1pg octafluoronaphthalene molecular ion at m/z 272

Column DB-5ms 30 m × 0.25 mm I.D., 0.25 µm

Scan range m/z 200 - 300

Interval (Event Time) 0.5 sec

EI SIM sensitivity S/N>30/1 (RMS) for 100fg octafluoronaphthalene molecular ion at m/z 272

Column DB-5ms 30 m × 0.25 mm I.D., 0.25 µm

Interval (Event Time) 0.2 sec

Maximum scan rate 10000 u/sec (single scan)
Scanning max rate for scan range m/z 60 - 660 (600 u) at 0.1 sec event time
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C.2C  C.2 Hardware

Gas chromatograph Model GC-2010

Oven temperature Maximum 450 °C

Linear temperature elevation rate (with power 
source voltage of 100, 115 V AC)

40 °C/min up to 200 °C
15 °C/min up to 350 °C
7 °C/min up to 450 °C

Linear temperature elevation rate (with power 
source voltage of 230 V AC) (high power 
oven)

70 °C/min up to 200 °C
50 °C/min up to 300 °C
30 °C/min up to 400 °C

Injection port temperature Maximum 450 °C

GC/MS interface Model Capillary column direct interface

Temperature Room temperature - 350 °C

Ion source Ionization type EI

Temperature Temperature control: 
100 - 260 °C

Filament Dual filament (automatic switching)

Electron voltage setting range 10 - 200 V

Electron current setting range 10 - 250 µA

Analysis part Cylindrical quadrupole with pre-rod

Detector Secondary electron multiplier with conversion dynode

Vacuum system Main pump Differential vacuum system
220 L/sec turbomolecular pump
65 L/sec turbomolecular pump
For Single TMP models, 
65 L/sec turbomolecular pump only.

Backing pump 30 L/min (60 Hz) oil rotary pump
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C.3C  C.3 Workstation

C.3.1 PC

C.3.2 Software

PC CPU Pentium III (600 MHz) or better

Internal memory 256 MB or greater

Hard drive 3 GB or greater

Operating System Windows 2000 SP1 or later

Internet Explorer 3.02 or later

Monitor 15 inch LCD or 17 inch CRT, resolution 1024 × 768 or greater

Printer Laser printer, A4 

*PC may be upgraded without prior notice.

Analysis Analysis Conditions GC measurement conditions, MS measurement and 
data processing parameters are all saved together in 
a method file.

MS measurement mode Scan, SIM (64 channel × 128 groups)

GC detector FID, FPD, FTD, ECD, TCD

Continuous analysis Continuous automated runs using batch processing

Instrument control Start/stop vacuum system

GCMS system automatic and manual tuning

GCMS system check

Data Processing Data analysis Chromatogram/mass spectrum graphing

Chromatogram/mass spectrum comparison

Mass spectrum background deletion and averaging 

Chromatogram area calculation

Column performance calculation

Library search Search modes: similarity index, index search

Up to 5 libraries can be search simultaneously

Structural formula display

Private library editing
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Data Processing Quantitation Maximum number of peaks identified: 1000

Identification method: absolute retention time/ 
relative retention time method, time band/time 
window methods, reference ions (5 max), mass 
pattern matching with registered spectra

Quantitation calculations: corrected area 
normalization with scale factor, internal standard, 
absolute calibration, standard addition, area percent

Calibration curves: linear (least squares method, 
average coefficient method), point to point, 
quadratic, cubic
Weighted (1/C, 1/C2, 1/A, 1/A2)

Calibration points: 64 maximum (averaging of up to 
10 measurements for each point)

Calibration curve correction

Grouping processing

Report generation Chromatograms, mass spectra, peak report, 
similarity search results, quantitation calculation 
results, calibration curves, etc.

Format editing

Batch processing Data processing, report generation continuous 
automated processing

Data conversion ANDI (AIA) conversion, quantitation result ASCII 
conversion, PDF output of report image

System Data Explorer File backup and deletion of various file types 

QA/QC Precision management, quality management, 
recovery rate, spectrum check, etc.

Security Specify users by user name and password, and 
determine levels of authorization.

Audit trail Save the changes (and reasons for change, if 
desired) each time a method file is saved.



331GCMS-QP2010

Appendix C  Specifications

C.4C  C.4 Installation Requirements

Power supply Frequency 50/60 Hz

For GC Single phase AC 100, 115 V 1800 VA

Single phase AC 230 V 2600 VA (for 
high-powered oven)

For MS Single phase AC 100 to 240 V 1000 VA

Voltage fluctuation Operating power voltage range ±10 %

Specification power voltage range ±5 %

* A dedicated power source with a circuit breaker should be provided for the 
unit. Do not share power supply with another device.

* With regards to voltage fluctuations, the device is designed to work in a 
range ±10 % including fluctuations caused by high frequency noise, but it is 
recommended that it be kept within ±5 % including noise to ensure the best 
efficiency. The current frequency fluctuation should be kept within ±0.5 Hz.

* Power supplies for PC, monitor and printer are also required.

Grounding 100 Ω or less

Environmental 
requirements

Temperature Constant within 18 to 28 °C

Humidity 40 to 70 %RH (No condensation)

* An exhaust duct must be installed.
The pump exhaust must be connected to the exhaust duct to avoid oil mists 
and injected solvents and samples from being directly vented into the room.
If this is not possible, the oil mist filter below should be installed. Injected 
solvents and samples are vented directly into the room with the oil mist filter. 
(P/N 042-00124-31, Oil mist filter EMF3)

* Dust, vibrations, spatial noise and corrosive gases should be also avoided.
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C.4.1 Installation Examples

Installation Example (dimension will vary depending on the PC and printer used.)

Figure C.1  Installation Example

Tubing and cable lengths are as follows.

MS rotary pump Vacuum tubing 1.5 m approx.

Exhaust tubing 4 m approx.

Power cord 1.5 m approx.

PC-MS Cable 2 m approx.
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Maintenance Parts List
D.1 Consumable Parts List

This section presents the consumable parts list and maintenance parts list for a standard GCMS-QP2010 
configuration. Parts for optional units are found in their accompanying user manuals. Most of the consumable 
and maintenance parts for the GC component (GC-2010) are shown in the list, but for additional details, refer 
to the GC-2010 User Manual included separately (221-40406). If there are questions concerning parts on this 
list, please ask your Shimadzu representative.

*1: For Dual TMP model only

Unit Name Part No. Part Name Remarks
GC 221-35507-02 SEPTUM SET, (LB-2), 50/PKT

036-11203-84 O-RING, 4D P5, 5/PKT For glass insert 
attachment

221-41444-01 GLASS INSERT, SPL-2010 For Split injection

221-48335-01 GLASS INSERT, SLESS/WBI For Splitless injection

221-48600 DEACTIVATED SILICA WOOL, 2G

221-48876-03 DEACTIVATED GLASS INSERT, SLESS 5/PKT

221-49065-91 AU GASKET 5/PKT 1PC 221-48990 

221-34121-93 MOLECULAR SIEVE FILTER, /SPL-14 For removing carrier gas 
impurities

221-42559-92 FILTER ASSY (SPLIT) Split flow path

221-42559-92 FILTER ASSY (PURGE) Septum purge flow path

201-35183 GASKET, AL, COLUMN PACKING, 100PC For line connections

221-48974 SPACER 1.5 Spacer under Septum 

DIRECT
INTERFACE

670-15003-03 FERRULE, GVF/004, 10/PKT For less than 0.25 mm 
bore capillary column

670-15003-04 FERRULE, GVF/005, 10/PKT For 0.32 mm bore capillary 
column *1

670-15003-07 FERRULE, GVF/008, 10/PKT For 0.53 mm bore capillary 
column *1

670-11009 NUT, SSNE16/012, 5 PCS

ION
SOURCE

225-10340-91 FILAMENT

225-10445 BOX

225-10442-91 REPELLER ASSY

225-10255 REPELLER REPELLER only

225-10446-91 BOX (HEAT TREATED)

225-10447-91 REPRLLER (HEAT TREATED)

225-01068 INSULATOR

CALIBRATION 
GAS

225-09493-03 STANDARD SAMPLE, PFTBA (5 g)

225-09493-01 STANDARD SAMPLE, TRIS (0.5 g)

VACUUM 017-30163-11 ROTARY PUMP OIL ULTRAGRADE15 1 L

JIG, TOOLS 085-35124-03 ABRASIVE CLOTH, ULTRA FINE, 20/PKT

225-10194-91 JIG, IS

225-11657-08 JIG FOR COLUMN CONNECTION (FOR I/F)

225-11657-09 JIG FOR COLUMN CONNECTION (FOR INJ)
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D.2D  D.2 Maintenance Parts List

Unit Name Part No. Part Name Remarks
GC 221-46260-92 PCB KEY ASSY, GC2010

078-12146-01 LCD, LM32019P

221-46470-02 KEY RUBBER 1, GC2010

221-46471-02 KEY RUBBER 2, GC2010

221-43695-91 PT SENSOR ASSY, 17A+

221-43696-91 THERMO COUPLE WITH CONTACT, V2

DIRECT
INTERFACE

225-10547 INSULATOR, I/F

018-23651 ADHESIVE TAPE

036-11251 O-RING, 4D P50

225-10549-91 HEATER BLOCK ASSY For 100 V – 115 V 
(includes heater and Pt 
sensor)

225-10549-92 HEATER BLOCK ASSY For 220 V – 240 V 
(includes heater and Pt 
sensor)

ION
SOURCE

200-44394 CERAMIC, INSULATOR, A24-251-1

225-10439-91 HEATER BLOCK ASSY

225-10436-91 PT ASSY, IS

018-17301 FOIL, AL 250X10MT

225-10200-91 IS ASSY Lenses, Magnets and 
Heater unit

225-10554-91 CUP, I/F A ASSY

034-01602-31 SPRING, SUS UR8-10 

225-10434-91 CABLE ASSY, F1(S)

225-10434-92 CABLE ASSY, F2(S)

225-10434-93 CABLE ASSY, F1(L)

225-10434-94 CABLE ASSY, F2(L)

225-10434-95 CABLE ASSY, L1
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DETECTOR 225-10463-91 EM (H) ASSY Detector as a whole

225-09340-11 EM, AF620 Detector; Secondary 
electron multiplier only 

225-10466-91 SIG CABLE ASSY, DET

225-10466-92 LENS CABLE ASSY, DET

225-10466-93 HV CABLE ASSY, DET

225-10466-94 CDD CABLE ASSY, DET

036-11271 O-RING, 4D P105

225-10464-91 FEEDTHROUGH ASSY, CDD

225-09148-92 FEEDTHROUGH

036-11218 O-RING, 4D P18

MS FILTER 225-01132 PIN/QP-5000

225-10407-91 CABLE ASSY, MS FILTER

225-10408-91 SHORT CABLE1, PRE-ROD

225-10408-92 SHORT CABLE2, PRE-ROD

036-11266 O-RING, 4D P90

225-09148-92 FEEDTHROUGH

036-11218 O-RING, 4D P18 For feed-through

225-01373 SHORT SPRING

225-10390-01 TERMINAL PLATE (PRE)

225-11659 PRE ROD

225-10401 INSULATOR For Pre Rod

225-10402 SCREW(PRE) For Pre Rod

225-10403 COLLAR For Pre Rod

CALIBRATION 
GAS SYSTEM

225-10179-91 VALVE ASSY, SI

225-01559-91 CAPILLARY ASSY

035-62971-05 SLEEVE SET, T-100SET

225-04257-91 GLASS BOTTLE, 5 PCS

036-11203 O-RING, 4D P5

Unit Name Part No. Part Name Remarks
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VACUUM 
SYSTEM

225-09490-01 ION GAUGE *1

200-47686-02 PB-1 PIRANI TUBE FILAMENT

225-09509-02 TURBOVAC TW70H TMP MAIN BODY

225-09508-03 TURBO DRIVE 300 TMP CONTROLLER

225-09587-01 TMP, TMH262 TMP MAIN BODY and 
TMP CONTOROLLER *1

225-09587-04 LUBRICANT RESERVER For TMH262 *1

225-09517-01 RP E2M1.5 (100-120) WITHOUT CABLE

225-09517-02 RP E2M1.5 (220-240) WITHOUT CABLE

225-11446-91 CABLE, MS-RP CABLE FOR RP

221-09895-09 LABEL, AC220 240V LABEL FOR CABLE

221-09895-10 LABEL, AC100 115V LABEL FOR CABLE

210-13532-71 LABEL, RP1 LABEL FOR CABLE

204-30020 HOSE NIPPLE, 16KF-18 for RP

035-06004-51 CENTERING RING, KF10/16SNRCR for RP

035-02415-01 CLAMP RING, 10/16KF

016-31697-03 HOSE, PVC CHEMIFLEX 19X26

037-61024 HOSE CRAMP, HB-1-28

017-30290-11 LUBRICATING OIL BARRIERTA IS/V

225-03538-91 ELBOW, KF16-#15 *1

225-03535-91 ELBOW, KF25-#15

225-11676 STRAIGHT JOINT, KF16-#15 *2

035-06004-22 CENTERING RING, KF16SVCR

035-06004-24 CENTERING RING, KF25SVCR

035-02415-02 CLAMP RING, 20/25KF 18342

035-02411-21 CENTERING RING, 32036-PAZV

035-02411-22 CENTERING RING, 32040-PAZV

036-11271 O-RING, 4D P105

225-10125 FEEDTHROUGH 12P

036-11243 O-RING, 4D P40

225-10116-91 LEAK VALVE ASSY

036-11203 O-RING, 4D P5

Unit Name Part No. Part Name Remarks
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*1: For Dual TMP model only
*2: For Single TMP model only
*3: For 225-10000-xx, 225-10001-xx, 225-10002-xx

225-10040-xx, 225-10041-xx, 225-10042-xx
xx=24, 34, 37, 39, 91, 92

*4: For 225-10005-xx, 225-10006-xx, 225-10007-xx
225-10085-xx, 225-10086-xx, 225-10087-xx
xx=24, 34, 37, 39, 91, 92

MAIN 
POWER

225-11260-91 MAIN POWER ASSY TW300/TW70H *3

225-11260-92 MAIN POWER ASSY S *2

225-11260-93 MAIN POWER ASSY TW300/TW70H *4

225-11260-94 MAIN POWER ASSY TMH262/TW70H *1

074-80422-01 POWER SUPPLY, LEA50F-5

074-80422-51 POWER SUPPLY, LEA50F-24

074-80424-01 POWER SUPPLY, LEA150F-24

225-11360-91 PCB ASSY, LED-A

225-11350-91 PCB ASSY, PUMP CTRL-A

225-10333-91 FAN ASSY POWER

HV PCB 225-11195-91 HV PCB ASSY

RF PS 225-11075-92 RF PS ASSY

225-11060-91 PCB ASSY, RF DIFF-A

225-10296-91 FAN ASSY

MAIN CTRL 225-11130-91 PCB ASSY, MAIN CTRL-A

CPU PCB 225-11000-91 PCB ASSY, CPU-A

IS CTRL 225-11225-92 IS CTRL-A ASSY

DC POWER 225-11250-91 DC POWER-A

IG CTRL 225-11280-91 PCB ASSY, IG CTRL-A *1

PRE AMP 225-11030-91 PCB ASSY, PRE AMP-A

CABLE 071-60814-05 CORD, KP-4819D+KS-31A For 220 V – 240 V

071-60816-12 CORDSET, UC-975-N01 For 100 V – 115 V

225-19050 IEEE1394 Cable

088-52848-21 IEEE1394 Cable (4.5 m)

225-19051 RS232C Cable

Unit Name Part No. Part Name Remarks
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E.1 Vacuum Characteristics

The graph below shows the vacuum dependence on carrier gas flow rate. A variation of 
roughly ±20 % in the vacuum may be observed depending on the ionization interval.

Outgassing from vacuum components may affect the vacuum, especially at low flow rates 
or when monitored in a short time after starting evacuation.

The maximum column flow rate at which data acquisition is possible is 15 mL/min for Dual 
TMP model. If the internal diameter of the column is 0.53 mm, use a column length greater 
than 25 m. In case of Single TMP model, it is 2 mL/min.

Carrier Gas Flow Rate and Degree of Vacuum

(Dual TMP model)

(Single TMP model)
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E.2E  E.2 Detector Amplification

The characteristic graph shown in the figure below indicates average values. There will be 
slight variations depending on the detector.

Detector Voltage
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E.3E  E.3 Ionization Voltage/Emission Current and 
Filament Life

Ionization voltage and emission current can be changed; however, parameter setting may 
affect the life of the filament. Refer to the graph below when changing these parameters.

Ionization Voltage/Emission Current and Filament Life

Ionization Voltage (V)

Filament Life Dramatically Decreases

Recommended Setting Range

Filament Life Decreases

Outside the Filament 
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Appendix F  Glossary of GCMS Terms

F.1 Abbreviations

AMU Atomic Mass Unit

AOC Automatic Operation Controller

CPU Central Processing Unit

CRT Cathode-Ray Tube

EI Electron Impact Ionization

eV Electron Volts

GC Gas Chromatograph

GC/MS Gas Chromatograph / Mass Spectrometer

I/F Interface

IS, ISTD Internal Standard

MC Mass Chromatogram, i.e. the plot resulting from MS analysis

MS Mass Spectrometer, i.e. the instrument

m/z Mass-to-charge Ratio

NIST National Institute of Standards and Technology

OS Operating System

PC Personal Computer

PFTBA Perfluorotributylamine

RF Radio Frequency

RP Rotary Pump

SIM Selected Ion Monitoring

S/N Signal-to-Noise ratio

SP/SPL Split / Splitless

TIC Total Ion Chromatogram

TMP Turbomolecular Pump
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F.2F  F.2 Glossary

A
Absolute retention time method

This is a method of identifying peaks. A peak is identified if it falls within an allowable 
retention time band or window defined on the basis of a preset expected retention 
time. This widely used method does not require reference peaks. A peak is identified 
using the absolute retention time method when it fulfills the relationship shown below.

See also: Time Window method, Time Band method

AMU (atomic mass unit) 
This is the unit in which atomic masses are measured, defined as 1/12 the mass of 
Carbon 12. The mass of one Carbon 12 atom is exactly 12 u. The atomic mass of 
hydrogen is 1.007825. 

AOC
Refers to one of the autosamplers that work with the GC system. The AOC injects 
samples sequentially into the GC injection port. Injections are reliable and 
automated.

Area Normalization
See Normalization method.

Autotuning 
The Autotune program optimizes the performance of the ion lenses. PFTBA 
calibration gas is introduced and the ion source lens voltages, RF parameters and 
analyzer voltages are automatically adjusted. The user can edit tuning conditions for 
resolution adjustment, mass calibration, and sensitivity adjustment (target mass or 
mass pattern). The final tuning results are printed and can be saved as a tuning file. 

Average RF method 
This is a calibration curve fit type for quantitation. Up to 64 standards with different 
concentrations are analyzed. First, linear curves are calculated passing through each 
individual point and the origin. Next, the simple average of the slopes of these lines is 
determined. The resulting calibration curve must pass through the origin. If there is 
only a single calibration level, a simple curve that passes through that point and the 
origin is drawn. Each point can represent the average of up to 10 individual analyses.

Expected retention
time of target peak 
  Actual retention

time of target peak 
 – Allowable retention time

window/band of target peak 
 <
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B
Background subtraction 

Acquired data contain some degree of background noise. The background 
subtraction process subtracts the background spectrum (normally, the spectrum at 
the chromatogram baseline) from the specified measured spectrum (normally, the 
spectrum in the vicinity of the peak apex), resulting in a single spectrum. This is 
performed prior to qualitative analysis.

Band identification method
See Time Band method.

Base peak 
In a mass spectrum, the relative intensity of each ion is normally found using the 
peak with the highest intensity as the "standard" or "base" peak. 

Batch processing
(1)Each line in the batch table contains injection and analytical parameters for that 

sample. After performing sequential analysis of the samples, data processing and 
report printing are automatically performed.

(2)Re-processing of previously acquired data can also be performed with the 
instrument off-line.

Blank nut
This is a GC accessory used to seal a flow line, such as the carrier gas or split/purge 
lines. It is also referred to as a blind nut.

C
Calibration curve

This is a curve showing the relationship between the compound concentration and 
the actual area or height obtained for that compound during analysis. In the 
GCMSsolution software, the horizontal axis represents the concentration of the 
compound and the vertical axis represents the area or height obtained by analyzing 
the sample. The resulting curve is used to quantitate unknown samples.

Capillary column
A capillary column is made of quartz glass capillary tubing; the inner surface is 
coated with a chemically bonded stationary liquid phase, and the outer surface is 
coated with a polyamide resin to prevent breakage. The column separates the 
components of a sample injected into the GC injection port. Except for samples 
injected with a DI (optional), the column separates all samples.

In its standard configuration, the GCMS-QP2010 accepts columns with an inner 
diameter of less than 0.32 mm. The maximum carrier gas flow rate in the GCMS-
QP2010 is 15 mL/min, enabling direct connection of a 0.53 mm column to the MS. 
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CI (Chemical Ionization)
This is an ionization method where reagent gas reacts with the sample molecule to 
produce ions. Fewer peaks are produced compared to EI, but since it is a "soft" 
ionization method (with a complex ionization mechanism), it has the advantage of 
being able to obtain molecular weight information for compounds that cannot be 
analyzed by EI. 

When detecting negative ions, this method is called negative ion chemical ionization 
(NCI).

Channel
See group.

Chromatogram
This is the graphic output (plot) obtained by detecting compounds as they elute from 
a chromatograph.

Condensation
Water droplets can form and adhere to the surface and interior of the instrument. 
Since condensation is damaging to the instrument, exercise caution during 
installation.

Compound Finder
Checks to see if the target compound is in the sample matrix. Because it uses 
spectrum similarity, it is necessary that the target compound standard spectrum be 
recorded in the compound table.

 Consumable parts
These are parts that wear out during use of the GCMS-QP2010, e.g., the GC 
injection port septum or ion source filament. Maintain adequate supplies of these 
parts. 

Conversion Dynode
The conversion dynode is located at the entrance to the detector. A high voltage 
electrode, it efficiently converts positive ions into electrons or negative ions into 
positive ions, according to polarity. It increases sensitivity, particularly in the high 
mass range, and facilitates the detection of negative ions. It is used as the detector in 
the GCMS-QP2010.

Corrected area normalization method 
This method quantitates each peak according to an external standard calibration 
curve, then adds the quantitation values and determines the percentage of the 
quantitation values for each component with respect to this total. See Appendix A 
"Peak Processing and Mass Spectrum Operations" on page 273 for more 
information.

Corrected area normalization with scale factor method
This method calculates peak concentrations using the total area (height) as a scale 
factor (dilution factor), rather than letting that total be 100 (concentrations expressed 
as a percent of total.) See Appendix A "Peak Processing and Mass Spectrum 
Operations" on page 273 for more information.
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D 
Database

See library.

Deflector
See off-axis deflector.

Detector
This component converts measured sample characteristics into an electrical signal. 
The sample is ionized and passes through the ion source box. The ions are mass-
separated by the quadrupole rods and then converted into an electrical signal by the 
detector. The GCMS-QP2010 uses an electron multiplier equipped with a conversion 
dynode.

DI (Direct Sample Introduction)
The sample is inserted directly into the MS with a DI probe. The probe is heated to 
vaporize the sample, which is not separated by the GC column.

E 
EI (Electron Impact Ionization) 

This common method obtains ions from sample molecules. Electrons from a filament 
are accelerated to 70eV and directed into an ionization chamber, where they impact 
with the sample molecules present. Because this is a "hard" ionization method, the 
molecules are cleaved and fragments are produced. Structural information can be 
obtained from the fragments, and a database of spectra makes library searches 
possible. This is a highly reproducible and reliable method for qualitative and 
quantitative analysis.

Electron Volts (eV)
This is the energy applied to the electrons for ionizing a molecule or atom. 

Emission current
The filament is heated by passing a relatively large current through it. Current in 
excess of the heating current causes the release of electrons by thermal emission. 
This emission current is very small in comparison to the heating current (approx. 
75 mA), and is controlled electronically so that its amperage is constant. The majority 
of the electrons move towards a trap or collector electrode from the ion source box. 
The collector current is always less than the emission current.

Evacuation rate
This expresses the evacuation capability of a vacuum pump.

Event
The acquisition mode is set for the Event.
Up to two events can be set for each group. Set the Acquisition mode for Event 1 to 
Scan, and SIM for Event 2.
If two events have been set, the start and end time in successive two rows for the 
SIM table (MS parameter) should be set to the same values respectively.
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Event Time
This is the acquisition interval for each event.  If only one event is set for a group, the 
Event Time is the same as the acquisition interval. If two events have been set for a 
group, the sum of the Event Time for Scan mode and SIM mode becomes the 
acquisition interval for the group.

External standard method (absolute calibration curve method)
This quantitative method calculates the concentration of a target compound by 
creating a calibration curve showing the relationship between the absolute mass or 
concentration of a compound in a standard and the area or height of its peak. An 
unknown sample is analyzed under identical conditions, and the calibration curve is 
applied to the area or height of the peak in the unknown sample. For this method, the 
analytical conditions of the unknown sample must be exactly the same as those of 
the standard. Injection volumes must be constant, since the method accuracy is 
dependent on the volume of the sample injected. See Appendix A "Peak Processing 
and Mass Spectrum Operations" on page 273 for more information.

F 
Feed-through

Terminal where electrical signals enter without compromising the vacuum in the MS.

Filament 
The filament is made of rhenium. Connected to the ion source box, it generates the 
electron beam necessary for ionizing the samples. Two filaments are present so that 
if there is a problem with one of the filaments, the operator can switch to the other 
one.

File
In computer terminology, a compilation of data into a single unit is referred to as a 
file. In the GCMSsolution software, the data, tuning conditions, methods, batch 
schedule, report format, and libraries are each compiled into files, and are saved with 
the extensions shown below.
Data file (*.QGD)

Tuning file (*.QGT)

Method file (*.QGM)

Batch schedule file (*.QGB)

Report format file (*.QGR)

Library file (*.LIB)

Format (report format) 

In the GCMSsolution software, various types of reports can be printed, including the 
method, data processing results or library search results. Format refers to the 
customizable layout of these items. 

G 
GC pressure parameters

The pressure parameters precisely control the pressure of carrier gas flowing 
through the GC column at each stage of an analysis.
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GC temperature parameters 
The temperature parameters precisely control the temperature of the column oven at 
each stage of an analysis. Injection port and interface temperatures can also be 
specified.

Ground 
For safety, ensure that the GCMS-QP2010 is properly grounded to an earth ground 
during operation. 

Group (channel)
This consists of the mass of ions to be measured during a time interval of a SIM 
analysis. A different group is normally used for each compound present.

A single analysis can be grouped into periods of time. The time bands are referred to 
as groups or channels. There can be up to 128 groups; up to 64 masses (ions) can 
be set for each group. Therefore, up to 128 × 64 or 8,192 masses (ions) can be 
monitored.

I 
Index search 

This search method extracts information from a specified library file on the basis of a 
specified search index, or list of criteria for filtering searched information. 

Interface
See Transfer line interface.

Internal standard method 
An internal standard compound is added to each standard and sample. First, a 
calibration curve is created, expressing the relative sensitivity and mass ratio of a 
standard target peak relative to the internal standard peak. The concentration of the 
target compounds is then calculated by applying this calibration curve to the area 
ratio or height ratio of the peak of the unknown sample. This method compensates 
for variations in analytical conditions. 

Ionization
This is the process of removing one or more electrons from a molecule or atom and 
converting it to a positive ion. In the GCMS-QP2010, the column separates the 
injected sample, after which it is ionized by the ion source. Although EI is used as the 
standard ionization method, CI and NCI ionization are other ionization options. 

Ion source
This component ionizes the eluted compound from the column. It consists of the ion 
source and Lens 1.

Ion source box
The Ion source box consists of the ion source and lens stack. It is used to ionize the 
sample molecules and direct those ions to the quadrupoles.
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L 
Lens stack

Lens 2, Lens 3 and Lens 4 make up the lens stack, which efficiently extracts and 
accelerates the ions produced by the ion source, directing them to the quadrupole 
rods. 

Level 
Up to 64 calibration points can be specified for a calibration curve in the 
GCMSsolution software. Level 1 through 64 is assigned to each of these calibration 
points. Each level can be determined by calculating the average of up to 10 repeat 
injections.

Figure F.1  Calibration Levels

Library (library file) 
This is a compilation of mass spectral data used for similarity searches. Library files 
include public library files, such as the NIST database, and private library files that 
can be created by individual users. When a similarity search is executed, similar 
mass spectra are sought from the specified library files. 

Library search (similarity search)
The mass spectrum of an unknown compound is compared to the spectra in a library 
file (database); the most similar spectra from the library file are listed. In addition, 
mass spectra can be selected from library files using specific search indexes (index 
search). 

Linear
This is a calibration curve fit type for quantitation. Up to 64 different standard 
concentrations are analyzed, and a linear calibration curve is calculated by the least 
squares method. If there is only a single calibration level, a simple straight line 
passes through the single point and the origin. If there are two or more calibration 
levels, and the curve does not pass through the origin, a linear calibration curve is 
drawn through those two points. In other cases, a linear curve is drawn using the 
least squares method. Each point can represent the average of up to 10 individual 
analyses.

Area 
(Height)

Average of data 
point number

Average is taken 
between analysis 
repetitions, determining 
the calibration curve

Enlargement near Level 1
Concentration

Calibration curve

Level 1

Level 3

Level 2
Level 4

Level 63

Level 64
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M 
Main rod

See quadrupole rods.

Maintenance parts
These are parts that are necessary for the safe and optimal operation of the GCMS-
QP2010. These parts are not changed frequently, but should be changed as they 
deteriorate.

Mass number
This refers to the integer value in atomic mass units of an ion within a mass 
spectrum. The mass analyzer measures the exact mass of an ion, but the mass 
number represents the closest integer to that the exact mass.

Mass calibration
Using a calibration standard, such as PFTBA, a spectrum is acquired. During the 
scan of the PFTBA spectrum, the exact time of detection of a known mass peak is 
matched with the mass peak's exact mass. Approximately 20 exact mass values of 
PFTBA are matched with the exact time of detection during a single spectrum scan. 
Since the mass analyzer can only measure the time during a spectrum scan, it uses 
mass calibration to identify the mass using the times at which mass peaks are 
detected.

Mass pattern adjustment
In the GCMS-QP2010, the mass pattern can be adjusted to any pattern (intensity 
ratio) using the Tuning application.

The mass pattern adjustment refers to the process of adjusting a mass spectrum 
(raw data) acquired by a quadrupole mass spectrometer using the mass patterns 
from a magnetic field mass spectrometer as a standard. Otherwise, the patterns 
acquired with a quadrupole mass spectrometer would differ from those acquired with 
a magnetic field mass spectrometer, even though the mass spectra (raw data) are 
identical. The mass pattern from a magnetic field mass spectrometer is used as the 
standard because of the vast amount of data accumulated and used over its long 
history.

Mass spectrum
This refers to the bar graph display of the intensities of ions in their m/z order.

Megabore column
Name used for a capillary column of diameter 0.5 - 0.53 mm.

Method
This refers to a compilation of the parameters controlling the MS and GC units for 
data acquisition and data processing. Methods are saved as method files. The 
advantages of using methods are listed below. 
(1)When analyzing samples similar to those analyzed in the past, analyses can be 

performed with a previously developed method, without having to reset the 
various parameters.

(2)By using a Batch Table, automated analyses can be performed using a different 
method for each sample in the autosampler. 

(3)Since analysis parameters and data processing parameters can be saved as a 
single file, data management is simplified. 
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Method file
This is a file used to save a method that has been developed in the "Analysis" 
window or in Method Development mode. It is saved with the extension .qgm. 

Molecular formula
This is a chemical formula that shows the actual numbers and types of atoms in a 
molecule, but not the chemical structure.

Molecular ion
A molecular ion is formed from the loss of one electron from a molecule, without 
breaking any intramolecular bonds. Since many compounds have isotopic atoms, the 
molecular weight of a pure compound and the m/z value of the molecular ion peak 
are defined as the most abundant isotope peak found at the highest value of m/z in 
the spectrum. For benzene, which has substantial m/z 79 and m/z 80 peaks, the 
molecular ion is considered to be at mass 78.

Multiple reference relative retention time method
When large retention time shifts occur, retention time correction can be improved by 
selecting multiple reference peaks. In this method, the peaks are classified into 
multiple zones. A reference peak is specified for each zone, and the peaks within the 
zone are identified based on each zone's reference peak. 

See also Relative retention time method.

m/z (mass-to-charge ratio) 
This is a value that divides the mass of an ion by its electrical charge number.

N 
Narrow bore capillary column

This is the general term for capillary columns with an inside diameter of 
0.2 - 0.25 mm. This is the standard column used in the GCMS-QP2010. 

NCI (Negative ion Chemical Ionization)
See CI (Chemical Ionization)

Needle valve
This is a valve that makes minute flow regulation possible. 

NIST
This is the acronym for the National Institute of Standards and Technology (US). 

Normalization method (Area normalization)
The detected peak areas or heights are added, and the percentage of each peak 
area or height with respect to the total value is determined. See also Corrected Area 
Normalization method.
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O 
Off-axis deflector

The deflector electrode produces a negative charge, which helps to direct ions to the 
detector. It is off-center with respect to the central axis of the quadrupoles. 

O-ring
This is a rubber ring that is installed at the interface between certain types of 
connections, for example, at the contact surfaces between the door and the analyzer 
housing. The O-ring seals the two surfaces and prevents vacuum leaks. 

OS (Operating System) 
This underlying software program efficiently manages the overall computer operation 
and resources. All of the software for the GCMS-QP2010 operates under MS-
Windows 2000, which is one type of OS. 

P 
Peak profile

This refers to the raw peak of a mass spectrum, displayed in the "Peak Monitor" 
window. In scan analysis, a mass spectrum is obtained by processing this raw peak.

Peak report
In the GCMSsolution software, the peak processing results and quantitation results 
for analyzed data can be compiled and displayed and/or printed out. This compiled 
table is called the peak report. 

PFTBA
This is the acronym for perfluorotributylamine. PFTBA is one of the tuning standards 
normally used for mass analysis when ions with a mass of up to 700 are analyzed. It 
is used when performing resolution adjustment, sensitivity adjustment (mass pattern 
or target mass), and mass calibration. 

Molecular formula: (C4F9)3N

Point-to-point calibration curve
This is a calibration curve fit type for quantitation. Up to 64 different standard 
concentrations are analyzed, and a point-to-point calibration curve is created. No 
curve fit constant is displayed in the quantitation table when a point-to-point curve fit 
is specified, and none can be entered. If there is only a single calibration level, a 
simple line that passes through that point and the origin is drawn. If there are two or 
more calibration levels, a point-to-point curve is drawn; the initial line must pass 
through the origin. Each point can represent the average of up to 10 individual 
analyses.

Pre-amp
The pre-amp amplifies the output current from the secondary electron multiplier. 

Pre-rod
See quadrupole rods. 

Private library
See library. 
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Pt sensor
Platinum is used as a temperature sensor because its resistance is dependent on the 
temperature. For example, a Pt sensor is used to control the transfer line interface 
temperature.

Purge vent 
This is the carrier gas outlet of the GC-2010 purge line. Connect a bubble flow meter 
to this outlet to check the purge flow rate. 

Q 
Quadratic/cubic

This is a calibration curve fit type for quantitation. Up to 64 different standard 
concentrations are analyzed, and a second order (quadratic) or third order (cubic) 
curve is drawn by the least squares method. For quadratic curves, three or more 
calibration curves are required. For cubic curve fits, four or more calibration points 
are required. The curve will be calculated as a quadratic equation if there are three 
points and as linear if there are two or fewer points. Each point can represent the 
average of up to 10 individual analyses.

Quadrupole mass filter
An electromagnetic field is obtained by applying RF amplitude and DC voltage to the 
quadrupole rods, creating a mass filter that allows passage of only the ions with a 
specified mass.

Quadrupole mass spectrometer
This consists of an ion source, four quadrupole rods, and a detector, as shown in the 
figure below. As the ions pass through the quadrupoles, they are separated by mass.

Figure F.2  Quadrupole Mass Spectrometer Diagram

Quadrupole rods
The four quadrupole rods operate in rod pairs to form a hyperbolic electrical field. 
The main rods have both RF and DC voltage applied.

The GCMS-QP2010 also uses pre-rods, where only RF voltage is applied. This 
keeps the main quadrupoles clean and improves ion transmission. 

Quantitation
This refers to the process of determining the concentration of a compound or the 
concentration ratio of the compound in a sample. Quantitation in the GCMSsolution 
software can be performed by several calculation methods. 

Ion source Quadrupoles Ion detector
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R 
Reference

See Type (Type selected in Method). 

Reference ion
Reference ion intensity ratios can be used along with retention time for compound 
identification. Up to 5 reference ions can be specified for comparison to the base 
peak in the compound spectra. For a compound to be identified, each reference ion 
must be within an specified range of relative intensity compared to the target ion.

Relative retention time method 
In this method, identification is performed after correcting for the retention time drift 
for each peak. First, a specified reference peak is identified by the absolute retention 
time method; then the target peaks are identified by the relative retention time. 
Specifically, the actual retention time of the target peak is corrected by calculating a 
ratio based on the shift in retention time of the reference peak.

See also Multiple reference relative retention time method.

Repeller Electrode
Electrode that forces ions out of the ion source box.

Resolution
Resolution expresses the degree to which two adjacent peaks are separated. 
Resolution adjustment refers to adjusting the peak width of mass peaks. The 
resolution when analysis is performed by a quadrupole MS is shown by the following 
formula. 

R: Resolution

M: Mass of measured peak

∆M: Mass difference between measured peak and adjacent peak

W: Interval between measured peak and adjacent peak

∆W: Measured peak width

For a quadrupole MS, the following expression is used.

R W
∆W
--------- M

∆M
---------×=
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In cases where the above expression is equal to 2, subsequent multiples of the peak 
height can be expressed as:

RF power supply
This is the power supply that generates the high frequency voltage and direct current 
voltage applied to the quadrupoles.

Rotary pump 
Also referred to as a rotary vane vacuum pump. It produces a vacuum of 10-3 Torr 
and is used as the backing pump to the turbomolecular pump. In the GCMS-QP2010, 
the standard configuration uses one rotary pump, but if a DI or CI unit is added as an 
option, an additional rotary pump is required.

See also Evacuation rate.

S 
Sample type 

(Set in Batch Table and Sample Log-in)

The samples are categorized by type according to the analysis objectives, as follows:

Unknown: Sample of unknown content and concentration. Concentration 
calculations are performed using a previously acquired calibration curve.

Standard: An injection of a standard solution of known concentration; used to create 
a calibration curve. The manner in which points are added to the calibration curve is 
also selected.

Initialize calibration curve:
All of the previous calibration curve information in a method is cleared. Ordinarily, this 
is selected for the first standard in a batch table.

Add calibration level: 
A calibration point is generated at the level indicated by the level number column. If 
there is already a point at this level, then the value is averaged with the previous 
results.

W
∆W
--------- 1

∆M
---------× M×

W
∆W
--------- 1

∆M
---------× 2M=
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Replace calibration level:
A calibration point is generated at the level indicated by the level number column. If 
there is already a point at this level, then the previous results are deleted and a new 
point is generated.

Control: Standard solution or QA/QC sample designated as control in the properties 
section of the data file. Processing is the same as with an unknown sample.

Unspiked: Unspiked unknown sample in an unspiked/spiked pair.

Spiked: An unknown sample is spiked with a known amount of standard. The percent 
recovery of the spike is calculated using the unspiked sample, which is analyzed 
immediately prior to the spiked sample.

Standard (ISTD Recovery): Used when the QA/QC function requires the ISTD % 
recovery to be calculated.

Savitzky-Golay method
Digital filter for smoothing that uses the least squares method. In comparison to the 
moving average method, it allows high-frequency signal components to be more 
easily transmitted, but has inferior noise performance.

Scan
This is the process of analyzing mass spectra by continuously changing the RF 
voltage or DC voltage in one direction as applied to the quadrupoles.

The interval of the change is called the Event Time and the rate of the change is 
called the scan speed. If the range of masses 10 to 610 were scanned at an Event 
Time of 0.1 second, the scan speed would be 6,000 AMU/second. 

Scan speed
See scan.

Search index
This refers to one more criteria used for performing an index search. In the 
GCMSsolution software, the molecular weight, molecular formula, class, retention 
index, base peak and compound name can be used as a search index. 

Sensitivity adjustment 
This consists of adjusting the ion source lens voltages, RF parameters and detector 
voltage to obtain the best intensity and peak shape for a specific PFTBA mass peak 
chosen in "Edit Tuning Condition" dialog box in Auto Tuning.

Septum purge
This is a flow path, located just under the septum in the injection port, that uses 
carrier gas to sweep any contaminants from the injection port and reduces or 
eliminates large tailing solvent peaks.

Silica capillary
This is a capillary column in which the fused silica base is coated with polyamide 
resin as the stationary phase. See also Capillary Column. It is used as resistance 
tubing to control the amount of PFTBA tuning standard introduced. 
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SIM (Selected Ion Monitoring)
This method detects only specific masses. As with MC, chromatograms are obtained 
for each mass. The ions to be detected are specified prior to analysis. Since the 
number of ions detected is limited, detection sensitivity is extremely high, making it 
possible to measure picogram quantities of compounds. 

Similarity search 
See Library Search. 

Solvent flush method 
In this injection method, sample, air and then solvent are injected in that order, by 
drawing them into the syringe in the opposite order, as shown in the figure below. 
Solvent flush injection of samples can be performed reliably by a variety of methods 
with the AOC autosampler.

Figure F.3  Solvent Flush Method

Split injection
This is a sample introduction technique used primarily in capillary chromatography 
when sample concentrations are high. The sample is introduced into the injection 
port, where it is divided into two flow paths. One flow path enters the analytical 
column, while the other is vented.

Splitless injection
This is a sample introduction technique used primarily in capillary chromatography 
when sample concentrations are low. Sample is introduced into a hot split/splitless 
injection port, where the solvent is vaporized, but not the analytes. A small amount of 
solvent flows into the relatively cool column and recondenses. The analyte 
compounds collect in the recondensed solvent located at the head of the column. 
After a period of time has elapsed (the sampling time), the split vent opens and 
sweeps the excess solvent vapor out of the injection port. A temperature program 
then begins in the column oven.

Split vent
This is the carrier gas outlet of the split line flow path. Connect a bubble flow meter to 
this outlet to check the split flow rate. 

Standard Addition
Coexisting compounds in the sample sometimes can skew the concentration results 
of a target compound. This is referred to as the matrix effect. This calibration curve 
method compensates for this adding various levels of a known standard to identical 
quantities of sample and calculating the concentrations of the samples. In other 
words, a sample with no spiked standard, and the same sample with various levels of 
standard added are analyzed. A calibration curve is created with the quantity of 
standard added on the horizontal axis, and the peak area or height on the vertical 
axis, and quantitation is performed.

Sample Air Solvent
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T 
Target 

See Type (Type selected for Method).

Temperature control zones (heated zones)
These are components of the system with temperature control. 

TIC (Total Ion Chromatogram) 
The TIC represents the sum of the ion intensities at a particular time. The TIC is 
similar to chromatograms detected by gas chromatography using a FID (Flame 
Ionization Detector) detector.

TIME BAND method 
This method uses a specific retention time span to identify each compound. 

Allowable retention time band = +/-TIME BAND (minutes) 

If the expected retention time is 5.0 minutes and the retention time band is 
0.5 minutes, the allowable retention time band is 5.0 minutes +/-0.5 minutes, or from 
4.5 minutes to 5.5 minutes. The advantage of this method is that an optimal retention 
time band can be specified for each peak. This method can be time-consuming to set 
up, as it is necessary to make the setting for each peak. 

The Band method is useful when peak widths do not change over time, as in a GC 
temperature-programmed analysis. 

TIME WINDOW method 
This is a method specifies a certain retention time span for all peaks that is a 
percentage of the retention time. This window increases with retention time.

Allowable time window = +/-(Expected retention time (min) x TIME WINDOW (%))

If the expected retention time is 5.0 minutes and the time window is 10 %, the 
allowable time window is 5.0 minutes +/-10 % of 5.0 minutes, or from 4.5 minutes to 
5.5 minutes. This method is simple to set up, but has the disadvantage that the 
window allowed for each component can overlap with the windows of other 
components.

This method is used for analyses where the peak widths increase with time, as in 
isothermal analysis. 

Transfer line interface
This component connects the capillary column to the MS ion source. 
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Triazine
Abbreviation for tris(perfluoroheptyl)-S-triazine. Used when mass calibration or 
sensitivity adjustment is to be performed for ions of mass 1000 or less. Triazine is 
commercially available.

Figure F.4  Triazine Structural Formula

Type (Type selected in Method)
When performing identification and quantitation, the standard compounds are 
categorized into the following types according to the way they are used.

Target: This is a compound that is the object of quantitation. 

Internal Standard: This is a compound of known concentration added to all standards 
and samples for the purpose of quantitating other components in the sample. Also 
referred to as IS. 

Reference: This is a known compound added to all standards and samples for the 
purpose of identifying other components in the sample. The expected retention time 
and actual retention time of the reference peak is used to relatively correct for any 
retention time shifts. Up to 8 reference compounds can be designated. 

Internal Standard & Reference: An internal standard compound can also be used as 
a reference for retention time correction. 

Discovery: Select this when using the Compound Finder.

Tuning 
Tuning is the process of optimizing the MS. Tuning of the MS is performed in order 
to:

(1)Verify that there are no abnormalities in the status of the instrument, and trace the 
cause of any problems. 

(2)Determine the optimum operation parameters. 

The types of adjustments include mass calibration, resolution (peak width) 
adjustment and intensity adjustment. Intensity adjustment can be performed by 
sensitivity adjustment, either by specifying a target mass, or by relative intensity 
adjustment (mass pattern adjustment).
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Turbomolecular pump
This vacuum pump maintains a high vacuum in the ion source and analyzer within 
the vacuum housing. Gas molecules collide with the moving rotor blades, directing 
the gas molecules in a certain direction. If the gas molecules collide with other gas 
molecules more often than the rotor, then the pump stops. Therefore, the turbo pump 
must be backed up by another type of pump, usually a rotary pump.

See also Evacuation rate.

V 
Version upgrade

This refers to a software improvement. Normally, when a version is upgraded, a new 
version number is assigned. 

The current version number of the software can be checked by selecting the About 
GCMSsolution command in the Help menu of the GCMSsolution software. 

Vespel ferrule 
This is a ferrule made from polyamide resin that seals the capillary column interface. 

W
Wide bore capillary column

Designation for capillary columns of inner diameter 0.32 mm. Can be used in the 
standard GCMS-QP2010 configuration.

Window identification method
See Time Window method.
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